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Chapter 1. Introduction to IBM Unica Campaign

Campaign is a Web-based Enterprise Marketing Management (EMM) solution that
consists of a back-end server, a web server, an ActiveX client, and Marketing
Platform security. Campaign enables users to design, execute, and analyze direct
marketing campaigns.

Campaign provides an easy-to-use graphical user interface that supports the direct
marketing processes of selecting, suppressing, segmenting, sampling, and creating
output lists of customer IDs. Campaign’s Universal Dynamic Interconnect (UDI)
data communication layer allows you to seamlessly access and manipulate data
from all of your data sources, including relational databases (regardless of database
type) or flat files.

Campaign processes populate contact history and response history, and support
response attribution and reporting.

Although the application supports raw SQL, macros, and functions, users do not
need to know SQL to design campaigns. Once mapped, database tables can easily
be selected, merged, sampled, and segmented and the resulting customers can be
associated with a variety of offers. Also, the results of a campaign can be recorded,
responses tracked, and the return on investment (ROI) calculated. Campaigns can
be scheduled to run at a particular time or triggered by a particular event, all
without knowledge of SQL.

Campaign treats a marketing campaign as a discrete entity that is made up of one
or more flowcharts, which are in turn comprised of one or more processes. A
campaign can be associated with one or more strategic segments, offers, and
reports, and can consist of multiple flowcharts.

The processes, which are the building blocks for campaign flowcharts, are the heart
of Campaign, as they perform the actual data manipulation, scheduling, offer
matching, list generation, and optimization; in effect, you use the processes to
define and implement a campaign.

Who uses Campaign?
Campaign is designed to be used by marketing experts, as well as by experts in
data-mining, On-Line Analytical Processing (OLAP), and SQL.

Campaign users design, execute, and analyze direct marketing campaigns.
Campaign administrators lay the groundwork for their colleagues by performing
initial and ongoing tasks such as mapping database tables, adjusting configuration
settings, and defining custom attributes and offer templates for users.

For more information about tasks performed by Campaign administrators, see the
Campaign Administrator’s Guide.

Integration with other IBM Unica products
Campaign optionally integrates with the following IBM® Unica® products:
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v Distributed Marketing to support distributed, custom execution of centrally
managed campaigns.

v eMessage for constructing targeted, measurable email marketing campaigns.
v Interact to retrieve personalized offers and customer profile information in

real-time to enrich the interactive experience. For information on using Interact
features in Campaign, including the use of interactive flowcharts and Interact
processes on batch flowcharts, see the IBM Unica Interact documentation.

v Marketing Operations to integrate the marketing resource management features
of Marketing Operations with the campaign development features of Campaign.
For more information, see “About integration with IBM Unica Marketing
Operations.”

v CustomerInsight to provide access to CustomerInsight group selections when
designing direct marketing campaigns.

v NetInsight to provide access to NetInsight visitor segments when designing
direct marketing campaigns.

v Optimize to optimize contacts from a customer-centric perspective while
considering business rules and constraints.

v PredictiveInsight to leverage scoring of predictive models for response
modeling, cross-selling, customer valuation, and segmentation.

For more information on the use of other IBM Unica products integrated with
Campaign, see the documentation included with those products.

About integration with IBM Unica Marketing Operations
Campaign can be integrated with Marketing Operations to use its marketing
resource management features to create, plan, and approve campaigns.

When Campaign is integrated with Marketing Operations, many of the tasks
previously performed in a stand-alone Campaign environment are performed in
Marketing Operations. These tasks include:
v Working with campaigns:

– Creating campaigns
– Viewing, moving, and deleting campaigns
– Working with campaign summary details

v Working with Target Cell Spreadsheets
v Assigning offers to cells
v Specifying control cells
v Creating and populating custom campaign attributes
v Creating and populating custom cell attributes

These tasks are explained in the Marketing Operations and Campaign Integration
Guide.

The following tasks are performed in Campaign in both stand-alone and integrated
environments:
v Creating flowcharts
v Running flowcharts
v Detailed analysis of campaigns/offers/cells
v Reporting on Campaign performance (depending on the reporting pack

installed)
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If offer integration is also enabled, you perform the following tasks in Marketing
Operations:
v Designing offers

– Defining offer attributes
– Creating offer templates

v Creating, approving, publishing, editing, and retiring offers
v Organizing offers using offer lists and offer folders

About legacy campaigns
Legacy campaigns refer to pre-existing campaigns created in Campaign (or
Affinium Campaign 7.x) prior to enabling integration. In a Marketing
Operations–Campaign integrated environment, Campaign can be configured to
access the following types of legacy campaigns:
v Campaigns created in stand-alone Campaign (whether in the current or a

previous version of Campaign) before version 8.0 integration was enabled. These
campaigns cannot be linked to Marketing Operations projects.

v Campaigns created in Affinium Campaign 7.x and linked to Affinium Plan 7.x
projects. Functionality of these campaigns remains unchanged from version 7.x
of these products, based upon the data mapping between attributes in both
products.

You can access and work with both types of legacy campaigns using Campaign,
even after enabling version 8.0 integration, which applies to all newly created
campaigns.

Campaign concepts
The basic concepts that you should understand before using Campaign include:
v “Campaigns”
v “Flowcharts” on page 4
v “Sessions” on page 4
v “Processes” on page 4
v “Offers” on page 4
v “Cells” on page 5

Campaigns
You create campaigns in Campaign to manage and reflect a direct marketing
campaign. Each campaign is defined by the following elements:
v name
v security policy
v description
v objective
v campaign code
v effective and expiration dates
v initiatives
v owner
v any customized attributes

Chapter 1. Introduction to IBM Unica Campaign 3



Campaigns include one or more flowcharts that you design to perform a sequence
of actions on your data for executing your campaigns.

Flowcharts
In Campaign, flowcharts represent a sequence of actions that you perform on your
data. Every action is defined by a building block, called a process. By configuring
and joining processes, you can manipulate the underlying data to achieve your
goals. Flowcharts can be run manually, by a scheduler, or in response to some
defined trigger.

You use flowcharts to accomplish particular marketing goals, such as determining
qualified recipients for a direct mail campaign, generating a mailing list for this
group of recipients, and associating each recipient with a particular offer. You can
also use flowcharts to track and process respondents to your campaign, and to
calculate your return on investment for the campaign.

For each campaign, you design one or more flowcharts to implement the
campaign, configuring the processes that make up the flowchart(s) to perform the
required data manipulation or action.

Each flowchart has the following elements:
v name
v description
v processes that are configured and connected
v one or more data sources

Licensed users of Interact can also use Campaign to run real-time interactive
flowcharts that depend on the occurrence of an event. For more information on
interactive flowcharts, see the Interact User’s Guide.

Sessions
A session is a special place in the application where fundamental, persistent, global
data constructs (such as strategic segments and cubes) are created by Campaign
administrators and then made available to all campaigns. Like campaigns, sessions
are also comprised of individual flowcharts.

Processes
Flowcharts are comprised of individual processes that are configured to perform a
particular task in a campaign or session, such as selecting data, merging two
distinct audience groups, or writing out the results of the campaign.

Offers
An offer represents a single marketing message, which can be delivered in a
variety of ways.

In Campaign, you create offers that can be used in one or more campaigns.

Offers are re-usable:
v in different campaigns;
v at different points in time;
v for different groups of people (cells);
v as different "versions" by varying the offer's parameterized fields.
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You assign offers to target cells in flowcharts using one of the contact processes,
and track your campaign results by capturing data about customers who received
the offer, and customers who responded.

Cells
A cell is simply a list of identifiers (such as customer or prospect IDs) from your
database. In Campaign, you create cells by configuring and running data
manipulation processes in flowcharts. These output cells can also be used as input
for other processes in the same flowchart (downstream from the process which
created them). There is no limit to the number of cells you can create.

Cells to which you assign one or more offers in Campaign are called target cells. A
target cell is a distinct group of homogeneous individuals (or whatever the entity
is for which the audience level is defined, such as individual customers, or
household accounts). For example, cells can be created for high-value customers,
customers who prefer to shop on the web, accounts with on-time payments,
customers who have opted to receive email communications, or loyal repeat
buyers. Each cell or segment you create can be treated differently, receiving
different offers or communications via different channels.

Cells containing IDs qualified to receive an offer but that are excluded from
receiving the offer for analysis purposes are called control cells. In Campaign,
controls are always hold-out controls.

The term "cell" is sometimes used interchangeably with "segment." Strategic
segments are cells that are created in a session rather than in a campaign
flowchart. A strategic segment is no different from other cells (such as those
created by a Segment process in a flowchart) except that it is available globally, for
use in any campaign. A strategic segment is a static list of IDs until the flowchart
that created it originally is re-run.
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Chapter 2. Getting started with Campaign

Before meaningful work can be done in Campaign, database tables must be
mapped, data objects such as segments, dimensions, or cubes might need to be
created, and individual campaigns must be planned and designed. These tasks are
initially performed with the help of a IBM Unica consultant with the expectation
that the initial campaign and this guide allow you to design and run additional
campaigns yourself – or refine, expand, and build upon an initial campaign with
varying degrees of assistance.

For more information about configuration and other administrative tasks, see the
Campaign Installation Guide and the Campaign Administrator’s Guide.

Your username and password
To access Campaign, you must have a username and password combination that
has been created for you in Marketing Platform, and also be authorized to access
Campaign.

If you do not have a valid username and password, contact your system
administrator.

To log in to IBM Unica Marketing

Before you begin working with IBM Unica Marketing, you need the following.
v An intranet (network) connection to access your IBM Unica Marketing server.
v Microsoft Internet Explorer installed on your computer.
v User name and password to sign in to IBM Unica Marketing.
v The URL to access IBM Unica Marketing on your network. If you are uncertain

of the correct URL or need a user name or password, contact your IBM Unica
Marketing administrator.

1. Launch the Microsoft Internet Explorer browser.
2. Enter the IBM Unica Marketing URL in the browser's address field.

If IBM Unica Marketing is integrated with Windows Active Directory or with a
web access control platform, and you are logged on to that system, IBM Unica
Marketing displays the dashboard or the default start page configured by the
IBM Unica Marketing administrator. Your login is complete. Otherwise, a login
page appears.
If your version of IBM Unica Marketing uses SSL, you may be prompted to
accept a digital security certificate the first time you sign in. Click Yes to accept
the certificate.

3. Enter your user name and password, then click Sign In.
A Change Password page may display, depending on how IBM Unica
Marketing password rules are configured. Enter a new password, confirm by
entering it again, and click Change Password.

If your login is successful, IBM Unica Marketing displays the dashboard or the
default start page configured by the IBM Unica Marketing administrator.
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Your role and permissions
Your user name in Campaign is associated with one or more roles, such as
Reviewer, Designer, and Manager. Your administrators define roles specific to your
organization. Your roles determine the functions that you can perform in
Campaign. The object-level security implemented by your organization determines
whether you can perform those functions on specific objects. If you need to access
objects or perform tasks that your permissions do not allow, contact your system
administrator.

Security levels in Campaign
Security in Campaign works on two levels:
v Functional - Determines the actions that you can perform on types of objects,

based on the role(s) that you belong to. Your organization defines these roles at
implementation, and each role has a set of permissions associated with it, that
determine what actions a user belonging to a role can perform. For example, if
you are a user assigned a role called "Administrator", you might have
permissions to map and delete system tables, while if you are a user assigned
the role called "Reviewer" you might be denied permissions to map and delete
system tables.

v Object - Defines the of object types on which you can perform your allowed
actions. In other words, even if you belong to a role that has general permissions
granted to edit campaigns, object-level security for Campaign can be set up so
that you cannot access campaigns residing in particular folders. For example, if
you belong to Division A, regardless of your functional roles, you can be
disallowed from accessing the contents of folders belonging to Division B.

Setting your start page
If you do not want a dashboard page to appear when you first log in to IBM Unica
Marketing, you can select a page from one of the installed IBM products as your
start page.

To set a page you are viewing as your start page, select Settings > Set current
page as home. Pages available for selection as a start page are determined by each
IBM Unica Marketing product and by your permissions in IBM Unica Marketing.

On any page you are viewing, if the Set current page as home option is enabled,
you can set the page as your start page.
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Chapter 3. Campaigns

Campaigns are made up of one or more flowcharts that you design to perform a
sequence of actions on your data for executing your campaigns. Flowcharts are
made up of processes, which you configure to perform the actual data
manipulation, contacts, scheduling, and response tracking required for your
campaign. In effect, the processes are how you define and implement a campaign.

For an example of flowcharts designed for a retention campaign using multiple
channels to deliver an offer, see “Example: Multi-Channel Retention Campaign.”

Preparing the data for campaigns
To prepare the data for a campaign, you first need to tell Campaign which tables
or files in your data source contain information about your customers and
products. Mapping your data into Campaign makes this data available to processes
for manipulation. For details, see the sections on database table administration in
the Campaign Administrator’s Guide.

You might also need to create offers, strategic segments, and other data objects for
use in your campaigns. For information on creating objects for use in campaigns,
see Chapter 9, “Stored objects,” on page 171.

Using IBM Coremetrics segments in Campaign
The IBM Coremetrics® Web Analytics products allow users to define segments
based on visit and view level criteria. If these segments are made available to
Campaign, they can be used in flowcharts, so they can be targeted in marketing
campaigns. This "online segmentation" functionality provides an automated way to
incorporate IBM Coremetrics data into your campaigns.
v To configure the integration, see the Campaign Administrator's Guide.
v To use IBM Coremetrics-defined segments in Campaign, see “To use IBM

Coremetrics segments in a Select process” on page 47.

Designing campaigns
Before creating a campaign, you should have already designed it on paper and
determined the goals for the campaign. Once you have designed a campaign on
paper, you will implement it in Campaign by creating a campaign and creating one
or more flowcharts to accomplish the objectives of your campaign.

Campaigns are comprised of one or more flowcharts. Flowcharts are comprised of
interconnected processes. The processes combined in a flowchart are the heart of
Campaign, since they perform the actual data manipulation, contacts, scheduling,
and response tracking; in effect, the processes are how you define and implement a
campaign.

Example: Multi-Channel Retention Campaign
This example shows a retention campaign that uses multiple channels to deliver an
offer to customers that might be lost through attrition.
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Two flowcharts are required: one to generate the lists of customers to which the
offer will be sent (via a different channel for each segment), and a second to track
responses to the offer and write the response data out for reporting and analysis.

Contact flowchart

The contact flowchart aims to select the eligible customers in each value segment,
and output contact lists for a different channel for each segment.

A sample retention campaign flowchart

In the first tier of the flowchart, two Select processes select the customers in the
Gold and Platinum segments, while a third Select process contains the list of
customers who have opted out of marketing communications.

In the second tier, a Merge process combines the Gold and Platinum customers,
and excludes any who have opted out.

The third tier uses a Segment process to segment all eligible customers into value
tiers based on their scores.

Finally, the high-value customers are output to a call list using a Call List process,
to be contacted by phone with the offer. The medium-value customers are output
to a mail list using a Mail List process, and will receive a direct mailing with the
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offer. The lowest value customers will receive the offer via email.

Response flowchart

A second flowchart in this same campaign tracks responses to the phone, direct
mail, and email offers captured by the call center and response capture systems.
Response information is then available through the various performance reports in
Campaign.

Retention campaign’s response tracking flowchart

About accessing campaigns
You access campaigns from the All Campaigns page, available from the Campaign
> Campaigns link in the menu.

The information displayed on the All Campaigns page depends upon how your
Campaign environment is configured.
v Stand-alone Campaign environment—The All Campaigns page displays all

campaigns and campaign folders for which you have at least read access.
v Integrated Marketing Operations–Campaign environment—If access to legacy

campaigns has been enabled, the All Campaigns page displays only legacy
campaigns. Otherwise, no campaigns are listed on this page. Campaigns created
through Marketing Operations are accessed through campaign projects.
For more information about legacy campaigns, see “About legacy campaigns” on
page 3. For information on configuring Campaign to enable access to legacy
campaigns, see the installation documentation.
If you want to access campaign projects created in Marketing Operations from
the All Campaigns page, click the link for the Campaign Projects folder. This
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folder provides access to the projects view in Marketing Operations. The projects
that display depend upon the default project view that you have set in
Marketing Operations. You can configure this to display all campaign projects if
desired.
For more information about campaign projects, see the Marketing Operations and
Campaign Integration Guide. For more information about project views, see the
Marketing Operations User's Guide.

Note: The Campaign Projects folder cannot be deleted, moved, or copied.

Working with campaigns
This section describes the tasks you can perform with campaigns in Campaign.

Note: If your Campaign environment is integrated with Marketing Operations,
you must use the campaign projects in Marketing Operations to work with
campaigns. If your Campaign environment has pre-existing campaigns created
before the integration was enabled and Campaign is configured to access legacy
campaigns, use the instructions in this guide to work with these campaigns. For
more information, see “About integration with IBM Unica Marketing Operations”
on page 2.

Note: Working with campaigns requires the appropriate permissions. For
information on permissions, see the Campaign Administrator's Guide.

To create a campaign
1. Select Campaign > Campaigns.

The All Campaigns page appears, displaying the folders or campaigns in the
current partition.

2. Navigate through the folder structure until you have opened the folder to
which you want to add your campaign.

3. Click the Add a Campaign icon.
The New Campaign page appears.

4. Complete the fields in the Campaign Summary.
5. When you have finished entering your campaign summary details, click Save

and Finish.
The Campaigns page lists the new campaign.

Note: You can also click Save and Add a Flowchart to immediately start
creating your campaign’s flowcharts. However, it may be better to associate the
appropriate segments and offers to your campaign before creating flowcharts,
which makes selecting customers and creating contact lists in your flowcharts
easier.

Associating strategic segments with a campaign
A strategic segment is a list of IDs created by your system administrator (or an
advanced user) in a session and made available to all campaigns. A strategic
segment is no different from other segments (such as those created by the Segment
process) except that it is available globally, for use in any campaign.
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Associating a strategic segment with your campaign makes it easier to select that
segment when you are creating your flowcharts. Associating the relevant strategic
segments with your campaign also provides greater reporting capabilities within
Campaign.

To associate a segment with a campaign
1. On the Campaign Summary tab, click the Add/Remove Segments icon.

The Add/Remove Segments window appears.
2. Select the segment you want to add:

v Click the folders to navigate through them until you locate the segment you
want to add;

v Click Tree View/List View to change the segment list view, then navigating
to the segment you want to add;

v Click Search to access the Search tab, where you can enter a name or
description to find the segment you want to add.

3. Select the segment(s) you want to add, and click >> to move them to the
Included Segments list. You can select multiple segments using Shift+Click or
Ctrl+Click.

4. Click Save Changes when you have finished selecting segments to associate
with this campaign.

The segments you added are listed on the Campaign Summary page under
Relevant Segments.

Note: When you use the Select process to select customers in your campaign
flowcharts, segments associated with your campaign will appear at the top of the
list, making them easy to locate.

Associating offers with a campaign
Associating offers with your campaign when you define the campaign makes it
easier to select that offer when you are assigning offers to cells in contact
processes. Defining the relevant offers for a campaign from the Campaign
Summary tab is referred to as “top down” association; when an offer is simply
used in a flowchart without first associating it with a campaign, it is referred to as
“bottom up” association.

To associate an offer "top down" from the Campaign Summary
tab
1. On the Campaign Summary tab, click the Add/Remove Offers icon.

The Add/Remove Offers window appears.
2. Select the offer you want to add:

v Click the folders to navigate through them until you locate the offer you
want to add;

v Click Search to access the Search tab, where you can enter a name,
description or code to find the offer you want to add.

3. Select the offer(s) you want to add, and click >> to move them to the Included
Offers list. You can select multiple segments using Shift+Click or Ctrl+Click.

4. Click Save Changes when you have finished selecting offers to associate with
this campaign.
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The offers you added are listed on the Campaign Summary tab under Relevant
Offers. They appear grayed out until you use them in a flowchart in this
campaign.

The Campaign Summary tab Relevant Offers section lists all of the offers
associated with a campaign. Offers associated “top down” are visually
distinguished from those associated from “bottom up”: an asterisk next to the
name of an offer indicates that that offer was associated with the campaign using
the “top down” method. Offers that were used directly in a flowchart without first
being defined top down appear without an asterisk. Offers that were defined top
down and are not yet used in a flowchart appear grayed out until they have been
used in a flowchart.

When you use a contact process to create contact lists in your campaign flowcharts,
any offers defined top down will appear at the top of the list, making them easy to
locate and select for assignment to one or more target cells.

To view a campaign
1. Select Campaign > Campaigns.

The All Campaigns page appears, displaying the folders or campaigns in the
current partition.

2. Navigate to the folder containing the campaign you want to view.
3. Click the name of the campaign you want to view to open the campaign to its

Summary tab.
OR

4. Click the View a tab icon next to the name of the campaign you want to view.
Choices for the Summary, Target Cells, and Analysis tabs appear (across the
top of the Campaign display, or on a pop-up menu), and a choice for viewing
each flowchart in the campaign (if any) also appears.

5. Click the campaign tab you want to view.
The campaign opens to the tab you selected.

To navigate from a linked legacy campaign to a Marketing
Operations project

1. Select Campaign > Campaigns.
The All Campaigns page appears, displaying the folders or campaigns in the
current partition. Only legacy campaigns are listed.
To view campaigns created with Marketing Operations–Campaign integration
enabled, click the Campaign projects folder. If there are no legacy campaigns
or legacy campaigns have not been enabled in the configuration, this page will
always be empty.

2. Click the name of the campaign you previously linked to a project in Affinium
Plan.
The campaign opens to its Summary tab.

3. Click the name of the project displayed in the Related Project field.
Marketing Operations opens, displaying the Summary tab of the linked project.

4. To return to Campaign, click the name of the project in the (Related Campaign
(Code)) field in Marketing Operations.
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To edit a campaign's Summary details
1. On the Campaigns page, click the name of the campaign whose summary

details you want to edit.
You can also click the Edit a tab icon and select Summary from the context
menu to access the campaign Summary directly in Edit mode.
The campaign opens to its Summary tab.

2. Click the Edit Summary icon.
3. Make your desired edits on the Summary tab.

Note: Campaign names have specific character restrictions. For details, see
“Special characters in IBM Unica Campaign object names,” on page 219.

4. When you have finished making your changes, click Save and Finish.
Your changes are saved and the campaign closes.

About running campaigns
You run a campaign by running one or more of the flowcharts in the campaign.
Before you can run a flowchart, all of the processes in that flowchart must be
correctly configured. Unconfigured flowchart processes appear in gray; successfully
configured flowchart processes appear in color.

You can test run a flowchart to run it without writing output to system tables.

To print a campaign

You can print any page in a campaign using the Print this Item icon.
1. Select the campaign tab you want to print.

The selected tab opens.
2. Click the Print this Item icon.

A new window opens displaying a printer-friendly version of the current page.
3. Click Print.

The Print window appears, where you can set your printer options.
4. Click Print in the Print window.

The page prints.

To move a campaign

You can organize campaigns by moving them from folder to folder.

Important: If someone is editing a flowchart in the campaign you plan to move,
that entire flowchart might be lost when you move the campaign. Make sure none
of the flowcharts in the campaign are open for editing when you move the
campaign.
1. On the Campaigns page, select the checkbox next to the campaign you want to

move. You can select multiple campaigns to move to the same location at one
time.

2. Click the Move icon.
The Move Items To window appears.

3. Click the folder where you want to move the campaign.
Navigate through the list by clicking the + sign next to a folder to open it.
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4. Click Accept this Location.

Note: You can also double-click a folder to select and accept the location in one
step.

The campaign is moved into the destination folder.

About deleting campaigns
When you delete a campaign, the campaign and all flowchart files are deleted. If
there are portions of your campaign you want to store for reuse, you can save
them as a stored object. For more information, see Chapter 9, “Stored objects,” on
page 171.

Important: If you delete a campaign that has associated contact or response
history records, all corresponding contact and response history records will be
deleted. Do not delete the campaign if you need to retain the associated contact
and response history.

To delete a campaign
1. On the Campaigns page, navigate to the campaign you want to delete.
2. Select the checkbox next to the campaign you want to delete. You can select

multiple campaigns to delete at one time.
3. Click the Delete Selected icon.

Important: If you attempt to delete a campaign that has associated contact or
response history records, a warning message indicates that all corresponding
contact and response history records will be deleted. If you need to retain the
corresponding contact and response history, click Cancel.

4. Click OK on the confirmation window.

The selected campaign is deleted.

Note: You can also delete a campaign while viewing the campaign by clicking the
Delete icon.

Analyzing campaign results
After running your campaign, you can measure the results and use these results to
fine-tune your strategy. Campaign analyzes a variety of information about your
campaigns, including actual response rates, revenue, and profit per responder.
Based on this information, Campaign can calculate your total and incremental
revenue and profit, as well as your overall ROI.

Campaign offers several types of reports to help you gather and analyze
information about your campaigns. For information on working with reports, see
Chapter 11, “Reports,” on page 203.

Organizing campaigns
You can organize your campaigns by creating a folder or series of folders. You can
then move campaigns from one folder to another within the folder structure you
have created. You can add, move, and delete folders to organize your campaigns.
You can also edit a folder’s name and description.
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To add a campaign folder
1. Select Campaign > Campaigns.

The All Campaigns page appears, displaying the folders or campaigns in the
current partition.

2. Navigate to the folder where you want to add a subfolder and click Add a
Subfolder, or simply click Add a Subfolder to add a folder at the top level.
The Add a Subfolder page appears.

3. Enter a name, the security policy, and description for the folder.

Note: Folder names have specific character restrictions. For details, see “Special
characters in IBM Unica Campaign object names,” on page 219

4. Click Save Changes.

You are returned to the All Campaigns page. The new folder or subfolder you
created is displayed.

To edit a campaign folder's name and description
1. Select Campaign > Campaigns.

The All Campaigns page appears, displaying the folders or campaigns in the
current partition.

2. Click the folder you want to rename.
3. Click Rename.

The Rename a Subfolder page appears.
4. Edit the name and description of the folder.

Note: Folder names have specific character restrictions. For details, see “Special
characters in IBM Unica Campaign object names,” on page 219

5. Click Save Changes.

You are returned to the All Campaigns page. The folder or subfolder is renamed.

To move a campaign folder
1. Select Campaign > Campaigns.

The All Campaigns page appears, displaying the folders or campaigns in the
current partition.

2. Navigate to the folder containing the subfolder you want to move.
3. Select the checkbox next to the folder you want to move. You can select

multiple folders to move to the same location at one time.
4. Click the Move icon.

The Move Items To window appears.
5. Click the folder where you want to move the subfolder.

Navigate through the list by clicking the + sign next to a folder to open it.
6. Click Accept this Location.

Note: You can also double-click a folder to select and accept the location in one
step.

The subfolder and all its contents are moved into the destination folder.
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To delete a campaign folder

You must move or delete the contents of a folder before you can delete it.

Note: If you have the permissions required to delete a folder, Campaign also
allows you to delete any of the subfolders in that folder.
1. Select Campaign > Campaigns.

The All Campaigns page appears, displaying the folders or campaigns in the
current partition.

2. Navigate to the folder that contains the subfolder you want to delete.
3. Select the checkbox next to the folder you want to delete. You can select

multiple folders to delete at one time.
4. Click Delete Selected.
5. Click OK on the confirmation window.

The folder and all its empty subfolders are deleted.

Campaigns reference

This section describes the fields and icons in the Campaign interface for working
with campaigns.

All Campaigns page icons

The All Campaigns page uses the following icons.

The icons, left to right, are described in the following table.

Note: Many of the icons in the Campaign interface are associated with features
that require permissions. For more information, see the Marketing Platform
Administrator's Guide.

Table 1. Icons used on the All Campaigns page

Icon Name Description

Add a Campaign Click to add a new campaign.
Note: This icon does not appear if the user does not have
the appropriate permissions, or if Marketing Operations
and Campaign integration is enabled. For information
about creating campaign projects in Marketing Operations,
see the Marketing Operations andCampaign Integration Guide.

Add a Subfolder Click to add a new campaign subfolder.

Print this Item Prints the page.

Move Select one or more campaigns or campaign subfolders by
clicking the checkbox next to each item, then click this icon
to specify a new location to move the selected items.
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Table 1. Icons used on the All Campaigns page (continued)

Icon Name Description

Delete Selected Select one or more campaigns or campaign subfolders by
clicking the checkbox next to each item, then click this icon
to delete the selected items.

Reload campaigns Click this icon to refresh the list of campaigns on the page.

Campaign Summary tab icons

The Campaign Summary tab uses the following icons.

The icons, left to right, are described in the following table.

Note: Many of the icons in the interface are associated with features that require
permissions. For more information, see the Marketing Platform Administrator's Guide.
The following icons do not appear without the appropriate permissions: Edit
Summary, Add/Remove Segments, Add/Remove Offers, Add a Flowchart, Move
this Campaign, and Delete this Campaign.

Table 2. Campaign Summary tab icons

Icon Name Description

Edit Summary Click this icon to edit the campaign summary.

Add/Remove Segments Click this icon to change the strategic segments associated
with this campaign.

Add/Remove Offers Click this icon to change the offers associated with this
campaign.

Run Click this icon to access the Run menu, where you can
select Run All to run all flowcharts in this campaign.

Add a Flowchart Click this icon to add a flowchart to this campaign.

Print this Item Click this icon to print the campaign summary.

Move this Campaign Click this icon to specify a new location to move the
campaign.

Delete this Campaign Click this icon to delete the campaign.

Campaign Summary tab reference

The following table describes the fields on the Campaign Summary tab:

Table 3. Campaign Summary tab fields

Field Description

Security Policy Security policy that applies to the campaign.

Description Description of this campaign, displayed under the
campaign name on the All Campaign pages.

Objective Objective for this campaign.
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Table 3. Campaign Summary tab fields (continued)

Field Description

Campaign Code A unique identifier for the campaign, which follows a
specified format. Campaign automatically generates a
unique campaign code for each new campaign, following
the default format or your organization’s custom format.
You can edit this code or click Regenerate Code to
generate a new code.
Note: If you edit the code, Campaign can no longer ensure
the global uniqueness of campaign codes. If you are
performing response tracking, try to avoid using editable
codes (such as campaign codes) as tracking codes. Instead,
use Campaign-generated treatment codes, which cannot be
manually edited and are guaranteed to be unique.

Effective/Expiration Dates Date range during which the campaign is effective. You can
manually enter the date or click the calendar icon or the
forward and back arrows to choose the date.

Initiative(s) Initiative under which the campaign falls. The list of
available initiatives is created by your system
administrator.

Owner This non-editable field displays the user name of the
person who created this campaign.

Any custom attributes that were created by your system administrator appear at
the bottom of the page.
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Chapter 4. Flowcharts

You use flowcharts to perform a sequence of actions on your data for executing
your campaign logic. Campaigns are made up of one or more flowcharts.
Flowcharts are made up of processes, which you configure to perform the data
manipulation, contact list creation, or contact and response tracking required for
your campaign. In effect, the processes are how you define and implement a
campaign.

Note: Working with flowcharts requires the appropriate permissions. For
information about permissions, see the IBM Unica Campaign Administrator's Guide.

Creating flowcharts
You can add a new flowchart to your campaign either by creating a new one, or
copying an existing one.

Copying an existing flowchart may save time because you can start with a
completed flowchart and modify it to meet your needs.

To facilitate constructing flowcharts, you can use pre-configured flowchart
templates to quickly create common campaign logic or process box sequences. You
can also save and reuse other objects such as queries, table catalogs, triggers,
custom macros, user variables, and definitions of derived fields.

Flowchart design considerations
You should be aware of the following considerations when creating flowcharts.
v Avoid cyclical dependencies. Be careful not to create cyclical dependencies

among your processes. For example, your flowchart has a Select process that
provides input to a Create Seg process. If you choose as input in your Select
process a segment that will be created by the same Create Seg process that the
Select process provides output to, you will have created a cyclical dependency.
This situation will result in an error when you try to run the process.

v Applying global suppressions. If your organization uses the global suppression
feature, be aware that a particular set of IDs might be automatically excluded
from use in target cells and campaigns.

To create a new flowchart

Note: If you are creating an interactive flowchart, see the IBM Unica Interact
documentation for information.
1. In the campaign or session to which you want to add a flowchart, click the

Add a Flowchart icon.
The Flowchart Properties page appears.

2. Enter a name and description for the flowchart.

Note: Flowchart names have specific character restrictions. For details, see
“Special characters in IBM Unica Campaign object names,” on page 219.
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Note: Under Flowchart Type, Standard Batch Flowchart is the only option
unless you are a licensed user of Interact. If you have installed a licensed
version of Interact, you can also select Interactive Flowchart.

3. Click Save and Edit Flowchart.
The Flowchart page displays the process palette and a blank flowchart
workspace.

4. Add processes to your flowchart.
A flowchart typically begins with one or more Select or Audience processes to
define the customers or other marketable entities with which to work.

Important: Be sure to click Save frequently while adding and configuring the
processes in your flowchart.

5. Click Save or Save and Exit when you have finished creating your flowchart.

Copying flowcharts
Copying an existing flowchart to add to a campaign saves time because you can
start with a completed flowchart and modify it to meet your needs.

If the copied flowchart includes contact processes (Mail List or Call List) with
target cells linked to target cells defined in the target cell spreadsheet, new cell
codes will be generated for cells in the new copy of the flowchart so that duplicate
cell codes do not occur. If the target cells were defined in the flowchart, and if the
Auto-generate cell code option in the contact process is off, new cell codes are
NOT generated when you paste the copied flowchart.

Note: When you copy a flowchart, if the flowchart logic uses derived fields that
reference cell codes from the old flowchart, the logic will be broken in the new
flowchart.

Process configuration settings are copied to the new flowchart. However, any temp
files or temp tables that were created as a result of running the original flowchart
are not copied to the new flowchart.

To copy a flowchart
1. View the flowchart you want to copy.

For example, you can click the flowchart's tab while viewing its campaign.
2. Click the Copy icon.

The Duplicate Flowchart window appears.
3. Select the campaign into which you want to copy the flowchart.

Navigate through the list by clicking the + sign next to a folder to expand it.
4. Click Accept this Location.

Note: You can also double-click a folder to select and accept the location in one
step.

The flowchart is moved to the campaign you selected.
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Viewing flowcharts
If you have View permissions for a flowchart, you can open it in Read-Only mode
for viewing, which allows you to view the flowchart structure, but not to open
process configuration dialogs or make any changes. In Read-Only mode, you can
view the processes and connections between processes to quickly see the purpose
of the flowchart.

When the flowchart is open for viewing, you can also zoom out to see more
processes at once or zoom in to magnify a portion of the flowchart more closely.

To see more details of the flowchart, such as how the processes in the flowchart
are configured, you must open the flowchart for reviewing or editing.

To view a flowchart

You can view a flowchart in three ways:
v On the Campaigns page, click the View a tab icon next to the campaign and

select the flowchart you want to view from the menu.
v Open the flowchart tab directly from the campaign.
v Open the campaign’s Analysis tab, then click the flowchart name from the list of

flowcharts.

To zoom in and out

Click the Zoom In and Zoom Out icons.

Reviewing flowcharts
If you have Review permissions (and not Edit permissions) for flowcharts, you can
open them only in Review mode, which allows you to view process configurations
and modify the flowchart, but you cannot save any changes or perform production
runs of flowcharts or any of their processes. This allows you to safely verify a
flowchart’s contents, or copy and reuse processes within a flowchart without fear
of inadvertently changing the flowchart.

Important: Be aware that test runs can write output, and that test runs can execute
triggers. In addition, even in Review mode, if you have the appropriate
permissions, you can edit custom macros and triggers in the flowchart, and thus
might change the flowchart.

Other actions you can perform in Review mode are:
v Test runs if you have the appropriate permissions.
v Save processes or the flowchart you are reviewing as a template.

Important: In Review mode, the flowchart auto-save option is disabled and cannot
be enabled. To save changes to a flowchart, you must have Edit permissions.

To review the processes in a flowchart

Note: You open a flowchart in Review mode in the same way as you open a
flowchart in Edit mode. Your permissions settings automatically ensure that you
can only access flowcharts in Review mode if you do not also have Edit
permissions.
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You can open a flowchart for reviewing in several ways:
v On the Campaigns page, click the Edit a tab icon next to the campaign and

select the flowchart you want to review from the menu.
v Open the campaign, then click the flowchart tab. On the flowchart page, click

the Edit icon.
You can also press Ctrl and click the flowchart tab to open the flowchart directly
in Review mode.

v Open the campaign’s Analysis tab, click the link to the flowchart you want to
review, then click the Edit icon.
On the Analysis tab, you can also press Ctrl and click the flowchart link to open
the flowchart directly in Review mode.

When you enter a flowchart in Review mode, you see a message indicating that
the flowchart is in review mode and that any changes you make cannot be saved.
The page header indicates "Reviewing", and only the Cancel option is visible.

Editing flowcharts
You edit a flowchart to add or remove processes or to configure the processes. You
can also edit the flowchart’s name and description.

Important: If you try to edit a flowchart that is already being edited by someone
else, Campaign warns you that the flowchart is open by another user. If you
continue opening the flowchart, the other user’s changes are immediately and
permanently lost. To prevent the loss of work, do not continue opening the
flowchart without first checking with the other user.

To open a flowchart for editing

You can open a flowchart for editing in several ways:
v On the Campaigns page, click the Edit a tab icon next to the campaign, and

select the flowchart from the menu.
v Open the campaign, then click the flowchart tab. On the flowchart page, click

the Edit icon.
You can also press Ctrl and click the flowchart tab to open the flowchart directly
in Edit mode.

v Open the campaign’s Analysis tab, click the link to the flowchart you want to
edit, then click the Edit icon.
You can also press Ctrl and click the flowchart name to open the flowchart
directly in Edit mode.

To edit a flowchart's properties
1. Open the flowchart for editing.
2. Click the Properties icon in the Flowchart toolbar.

The Edit Flowchart Properties page appears.
3. Modify the flowchart name or description.

Note: Flowchart names have specific character restrictions. See “Special
characters in IBM Unica Campaign object names,” on page 219.

4. Click Save Changes.
The modified flowchart details are saved.
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Validating flowcharts
You can check the validity of a flowchart at any time (except when the flowchart is
running) using the Validate Flowchart feature. You do not need to have saved a
flowchart to run validation on it.

Validation performs the following checks for a flowchart:
v that the processes within the flowchart are configured.
v that cell codes are unique within the flowchart, only if the

AllowDuplicateCellCodes configuration parameter is set to No. If this parameter
is set to Yes, duplicate cell codes within flowcharts are allowed.

v that cell names are unique within the flowchart.
v that offers and offer lists referenced by contact processes are valid (that is, that

they have not been retired or deleted). Offer lists that are referenced but are
empty will not generate an error, only a warning.

v that any cells linked to a top-down entry from the target cell spreadsheet are still
connected.

The validation tool reports the first error found in the flowchart. You might need
to run the validation tool several times in succession (after correcting each
displayed error) to ensure that you have fixed all found errors.

Note: A best practice is to run validation on flowcharts before executing
production runs, particularly if you will be running flowcharts by batch mode or
will not be actively monitoring the run.

To validate a flowchart
1. On a flowchart page in Edit mode, click the Run icon and select Validate

Flowchart.
Campaign checks your flowchart.

2. If errors exist in the flowchart, a message box appears, displaying the first error
found. As you correct each error and rerun the validation.tool, the remaining
errors are displayed successively.

Testing flowcharts
You can conduct a test run on a flowchart or branch if you do not want to output
data or update any tables or files. However, note that triggers execute on
completion of both test and production runs.

When testing processes, branches, or flowcharts, note that global suppression is
applied.

Note: A best practice is to conduct test runs on processes and branches as you are
building flowcharts, so that you can troubleshoot errors as they occur. Also,
remember to save each flowchart before you run or test it.

To test run a flowchart
1. On a flowchart page in Edit mode, click the Run icon and select Test Run

Flowchart.
The flowchart runs in test mode. Data is not written to any tables.
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Each process displays a blue check mark when it has run successfully. If there
are errors, the process displays a red "X".

2. Click Save and Exit to save the flowchart.
You can also click Save to save the flowchart and leave it open for editing.
If you click Save and Exit before the flowchart has finished running, the
flowchart will continue running and save when it finishes. If you or another
user reopen the flowchart while it is still running, any changes made to the
flowchart are lost. For this reason, always save a flowchart before running it.
To pause the run, right click the process box and select Run > Pause. To stop
the run, right click the process box and select Run > Stop.

3. Click the Analysis tab on the Campaign toolbar and view the Campaign
Flowchart Status Summary report to determine if there were any errors in the
flowchart run.

To test run a flowchart branch
1. On a flowchart page in Edit mode, click a process on the branch you want to

test.
2. Click the Run icon and select Test Run Selected Branch.

The flowchart runs in test mode. Data is not written to any tables.

Each process displays a blue check mark when it has run successfully. If there are
errors, the process displays a red "X".

Running flowcharts
You can choose to run an entire flowchart, a branch, or an individual process in
the flowchart. For best results, conduct test runs as you are building flowcharts, so
that you can troubleshoot errors as they occur, and be sure to save each flowchart
before you test or run it.

Important: For flowcharts containing contact processes, note that each production
run of a flowchart can generate contact history only once. To generate multiple
contacts from the same list of IDs, snapshot out the list of IDs and read from the
list for each flowchart run.

Note: Users with Administrative privileges can access the Monitoring page, which
displays all running flowcharts and their statuses, and provides controls to
suspend, resume, or stop flowchart runs.

To run a flowchart
1. If you are viewing a flowchart, you can run it by clicking the Run icon and

selecting Run This.
If you are editing a flowchart, click the Run icon and select Save and Run
Flowchart.

2. If the flowchart has already been run, click OK on the confirmation window.
Data from the run is saved to the appropriate system tables. Each process
displays a blue check mark when it has run successfully. If there are errors, the
process displays a red "X".

3. Click Save and Exit to save the flowchart.
You can also click Save to save the flowchart and leave it open for editing.
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You must save the flowchart once after running to view the results of the run
in any reports. Once you have saved the flowchart, results of repeated runs are
immediately available.

Note: If you click Save and Exit before the flowchart has finished running, the
flowchart will continue running and save when it finishes.

4. Click the Analysis tab on the Campaign toolbar and view the Campaign
Flowchart Status Summary report to determine if there were any errors in the
flowchart run.

To run a flowchart branch
1. On a flowchart page in Edit mode, click a process on the branch you want to

run.
2. Click the Run icon and select Save and Run Selected Branch.

Note: Running only a process or a branch of a flowchart does not increment
the Run ID of a flowchart. When you run only a process or a branch, if contact
history records exist, you are prompted to choose run history options before
you can proceed. For details, see “About run history options” on page 28.
Each process displays a blue check mark when it has run successfully. If there
are errors, the process displays a red X.

To run a process

To make sure that your configuration is successful and that the results are what
you expect, be sure to run each process as soon as you configure and connect.

Note: When you run a process, any results from a previous run are lost.
1. Within a campaign, open a flowchart for editing.
2. Click the process that you want to run.

If the process requires data from a source process, be sure that the source
process has already run successfully so that its data is available.

3. Click the Run icon or right-click a process box, then select one of the following
options:
v Test Run Selected Process: Use this option when building your flowchart, so

you can troubleshoot errors as they occur. Test runs do not output data or
update any tables or files. (However, triggers run on completion of test runs,
and global suppression is applied.)

v Save and Run Selected Process: Do a production run. Processes such as Mail
List and Call List will write entries into Contact History. Each production run
can generate contact history only once. Contact processes that have already
executed for that production run can be re-run only if the contact history
from the current run is first deleted. Triggers run on completion of the
production run.

Note: Running only a process or a branch of a flowchart does not increment
the Run ID of a flowchart. When you run only a process or a branch, if contact
history records exist, you are prompted to choose run history options before
you can proceed. For details, see“About run history options” on page 28.

4. When the process finishes running, click OK on the confirmation window.

The process displays a blue checkmark when it has run successfully. If there are
errors, the process displays a red "X."
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About run history options

Note: You see the Run History Options window only when you run a branch or
process that has already generated contact history for the current Run ID. If a new
run instance does not exist for a particular re-run branch or process, the Run
History Options window does not appear.

Use the Run History Options window to choose how the new contact history you
generate is written to the contact history table.

Run history options scenario
You have a flowchart with two branches and two contact processes, A and B, both
configured to log to contact history.

You run the entire flowchart (from the top, using the Run Flowchart command)
once. This creates a new Run ID (for example, Run ID = 1) and generates contact
history for this Run ID.

After this first successful run of the entire flowchart, you edit contact process A to
give a follow-up offer to the same individuals who received the first offer.
Therefore, you want to rerun contact process A. The current Run ID is "1" and
contact history already exists for process A and Run ID=1.

When you select contact process A and click "Run Process," you see the Run
History Options window. You can choose to leave the Run ID unchanged (Run
ID=1) and replace the existing contact history associated with this Run ID, or you
can create a new run instance (that is, increment the Run ID to 2), leave the contact
history associated with Run ID=1 untouched and append new contact history
associated with Run ID=2.

You are sending a follow-up offer and do not want to lose the contact history
associated with the first offer, so you choose Create a new run instance. This
changes the Run ID to "2" and appends contact history records for the same IDs
who received the first offer to the contact history table.

If you now edit and run contact process B, you will not see a Run History Options
window, because the current Run ID = 2 and contact history associated with Run
ID =2 does not exist for contact process B. Running only contact process B will
simply generate additional contact history records for Run ID = 2.

Run History Options window reference

The Run History Options window contains the following options.

Table 4. Run History Options window options

Option Description

Create a new run instance Rerun a specific branch or process of the flowchart using a
new Run ID. Append the results, associated with the new Run
ID, to the contact history table. Existing contact history
remains intact.

Replace the contact
history of the previous
run

Reuse the previous Run ID and replace the contact history
previously generated for that Run ID (only for the process or
branch that is being run). Contact history records that were
previously generated for other branches or processes of the
flowchart remain intact.

28 IBM Unica Campaign: User's Guide



Table 4. Run History Options window options (continued)

Option Description

Cancel Cancel the branch or process run and do nothing to existing
contact history. The flowchart remains open in Edit mode.

You cannot replace contact history if associated response history exists. Therefore,
if you selected Replace the contact history of the previous run and associated
response history records exist, you can choose one of two options:
v Click OK to clear the associated response history records as well as the contact

history records. This is your only option if response history exists and you want
to replace the contact history from the previous run.

v Click Cancel to cancel clearing the contact history records. You can choose
Create a new run instance instead, to create a new run instance to run the
current contact process.

To pause a flowchart run

When you pause a running flowchart, branch, or process, the server stops running,
but saves all the data already processed. You might want to pause a run to free up
computing resources on the server.

After pausing a run, you can continue the run or stop it.

On a flowchart page, click the Run icon and select Pause This.

Note: If you have the appropriate permissions, you can also control flowcharts
from the Monitoring page.

To continue a paused flowchart run

When you continue running a paused run, the run resumes at the exact point at
which it stopped. For example, if a Select process were paused after processing 10
records, it would resume running by processing the 11th record.

On a flowchart page, click the Run icon and select Continue This.

Note: If you have the appropriate permissions, you can also control flowcharts
from the Monitoring page. For details, see the Campaign Administrator's Guide.

To stop a flowchart run

On a flowchart page, click the Run icon and select Stop This.

The results of any currently running processes are lost and a red X appears on
those processes.

Note: If you have the appropriate permissions, you can also control flowcharts
from the Monitoring page.

Chapter 4. Flowcharts 29



To continue a stopped flowchart run

You can continue running a stopped flowchart by running the flowchart branch
that begins with the process where the flowchart stopped. That process will be
rerun along with all downstream processes.
1. On a flowchart page in Edit mode, click the process that displays a red X.
2. Click the Run icon and select Save and Run Selected Branch.

Note: If you have the appropriate permissions, you can also control flowcharts
from the Monitoring page. For details, see the Campaign Administrator's Guide.

Troubleshooting runtime errors
Correctly configured processes are displayed in color (the specific color reflects the
type of process). A gray process with its name in italics has a configuration error.
To find out more information about the error, hold your mouse over the process to
display a descriptive error message.

If a flowchart stops running due to an error, the processes that were running
display a red X. Hold your mouse over the process to see an error message.

Note: If Campaign is configured so that system tables are stored in a database,
you are not viewing the flowchart, and the run stops due to a database connection
failure, the processes will not display a red X. Instead, the flowchart appears as it
did when it was last saved.

You should also consult the log file for system error information and review the
Analysis and Performance/Profitability reports for the campaign to see that the
results are what you expected.

Deleting flowcharts
Deleting a flowchart permanently removes a flowchart and all of its associated
files, including the log file. If there are portions of your flowchart that you want to
store for reuse, you can save them as a stored object.

Output files (such as those written by a Snapshot, Optimize, or a contact process)
are not deleted, and contact and response history information is retained.

Important: If you try to delete a flowchart that is being edited by someone else,
Campaign warns you that the flowchart is open by another user. If you continue
deleting the flowchart, the other user’s changes will be permanently lost. To
prevent the loss of work, do not continue deleting the flowchart without first
checking with the other user.

To delete a flowchart
1. Open the flowchart you want to delete in View mode.

The flowchart tab appears.
2. Click the Delete Flowchart icon.
3. Click OK on the confirmation window.

The flowchart and all its associated files are removed.
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To print a flowchart

You can print hardcopies of flowcharts from Campaign.

Note: Do not use your Web browser’s File > Print command, as flowcharts might
not print correctly.
1. Open the flowchart that you want to print, in either View or Edit mode.
2. Click the Print icon.

You see the Page Setup window.
3. Click OK.

You see the Print window.
4. Click OK to print the current flowchart.

You see a Campaign window indicating that the flowchart is printing.

Packaging flowchart files for troubleshooting
If you need help from IBM to troubleshoot a flowchart, you can automatically
collect relevant data to send to IBM Technical Support. You can select from a list of
items to include, and specify date ranges by which to limit data. The data is
written to the folder you choose, and the contents can be compressed and sent to
IBM Technical Support.

In addition to the data items you select, Campaign also creates a summary file that
identifies:
v Current date and time
v Version and build numbers of the software
v Your user name
v The selections you included in the package

To package flowchart files for troubleshooting

Only a user with permissions to edit or run a flowchart (either test or production
run) can perform this procedure. If you do not have “View logs” permission, you
cannot select the log-related entries in the selection window.

Use this task to automatically package flowchart data files so you can send them to
IBM Technical Support if you need help troubleshooting a flowchart.
1. From a flowchart page in Edit mode, select Admin > Collect Flowchart Data.

You see the Create Data Package for Troubleshooting window.
2. Type a name for the package, or leave the default name. The package name

will be used to create a subfolder in which the selected data items will be
written.

3. Click Browse and select the folder under which the data package will be saved.
4. Select the check box for each item you want to include in the package. Some

items, when selected, may allow additional information to be entered with
which to filter the extracted data.
Alternatively, you can check the Select default items check box. This check box
automatically selects all data commonly required for troubleshooting
flowcharts; this includes all of the listed items except the log files and the
contents of the user table, contact and response history tables, strategic
segments, and stack trace files.
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5. Click OK to create the package.

Transmitting the flowchart data package to IBM Unica
Technical Support

You can send the data package to IBM Unica Technical Support by email or using
a method recommended by your support representative. IBM Unica Technical
Support will accept uncompressed data (the entire package subdirectory), but you
may optionally compress, encrypt, and package the files into a single file before
sending them to IBM.

Options for packaging flowchart data
Table 5. Options for packaging flowchart data

Item Description of what is included
Additional specifications you may
set

Select Default
Items check box

All data commonly required for
troubleshooting flowcharts. This
includes all of the listed items
except the log files and the
contents of the user table and
contact history table.

Flowchart The flowchart .ses file. Include run results? Optionally
include or exclude the runtime
data files, also called the
“underscore” files.

Flowchart Log The flowchart .log file. Optionally set start and end time
stamps. If you do not set them, the
default is the entire log file.

Listener Log The unica_aclsnr.log file. Optionally set start and end time
stamps. If you do not set them, the
default is the entire log file.

Startup Log The AC_sess.log file. Optionally set start and end time
stamps. If you do not set them, the
default is the entire log file.

Web Message
Log

The AC_web.log file. Optionally set start and end time
stamps. If you do not set them, the
default is the entire log file.

Campaign
Configuration

The .config file, which lists
configuration properties and
settings from your Campaign
environment to assist in
troubleshooting the flowchart.

Campaign
Custom
Attributes

The
customcampaignattributes.dat
file, which lists attribute name and
value pairs for Campaign custom
attributes. Only entries related to
the current campaign are included.

Cell Custom
Attributes

The customcellattributes.dat
file, which lists attribute name and
value pairs for Campaign cell
custom attributes. Only entries
related to the current campaign are
included.
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Table 5. Options for packaging flowchart data (continued)

Item Description of what is included
Additional specifications you may
set

Offer Definitions All rows are included for each of
the following offer-related system
tables:UA_AttributeDef.dat,
UA_Folder.dat, UA_Offer.dat,
UA_OfferAttribute.dat,
UA_OfferList.dat,
UA_OfferListMember.dat,
UA_OfferTemplate.dat,
UA_OfferTemplAttr.dat,
UA_OfferToProduct.dat,
UA_Product.dat,
UA_ProductIndex.dat

Target Cell
Spreadsheet Data

The targetcellspreadsheet.dat
file, which includes data from
UA_TargetCells for the entire
Target Cell Spreadsheet. Includes
data for the current campaign, in
column/row-delimited text format.

Custom Macro
Definitions

The custommacros.dat file, which
includes the following fields from
UA_CustomMacros, in column/row
format: Name, FolderID,
Description, Expression,
ExpressionType, DataScrName,
DataVarType, DataVarNBytes,
CreateDate, CreatedBy, UpdateDate,
UPdateBy, PolicyIS, ACLID

System Table
Mapping

The systablemapping.xml file.
Includes all system table
mappings, including the data
source.

+ Include System
Table Contents

When you select this option, it
expands to list all system tables.

Select each system table to include.
The entire table will be included
(all rows and all columns).

If you do not select any
sub-options, the package will not
include any system tables.

+ Include
Contact History
Tables

When you select this option, it
expands to show the contact
history and detailed contact
history tables for each audience
level.

For each set you select, the
package will include the contact
history and detailed contact
history records for that audience
level.

You can optionally set start and
end time stamps. If you do not set
them, the default is all records.

If you do not select a suboption,
the package will not contain any
contact history table information.
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Table 5. Options for packaging flowchart data (continued)

Item Description of what is included
Additional specifications you may
set

+ Include
Response History
Tables

When you select this option, it
expands to show response history
tables for all audience levels.

For each table you select, the
package will include the response
history records for that audience
level.

For each table you select, you can
optionally set start and end time
stamps. If you do not set them, the
default is all records.

If you do not select a table, the
package will not contain any
response history table information.

+ Include User
Table Contents

When you select this option, it
expands to show the user table
contents that you can select for the
package.

Select the user tables from the flow
chart to include.

If you do not select any, the
package will not include any user
table contents.

For each user table that you select,
you can optionally set maximum
number of rows to include. If you
do not set a maximum number of
rows, the package will include the
entire table.

+ Include
Strategic
Segments

When you select this option, it
expands to show all the strategic
segments that you can select for
the package.

+ Include Stack
Trace Files

Option available for Unix versions
only. When you select this option,
it expands to show the list of stack
trace files (*.stack) in the same
directory as unica_aclsnr.log.

Select the stack trace files that you
want to include in the package. If
you do not select any suboptions,
the package will not include any
stack trace files.

Flowchart reference

This section describes the icons in the Campaign interface for working with
flowcharts.

Flowchart tab icons (View mode)

The flowchart tab uses the following icons in View mode.

The icons, left to right, are described in the following table.
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Note: Many of the icons in the interface are associated with features that require
permissions. For more information, see the Marketing Platform Administrator's Guide.
The Copy and Delete Flowchart icons do not appear without the appropriate
permissions:

Table 6. Flowchart tab icons for View mode

Icon Name Description

Edit Click this icon to edit the flowchart.

Run Click this icon to access the Run menu.

Add a flowchart Click this icon to add another flowchart to the campaign.

Zoom In Click this icon to increase the view size of the flowchart.

Zoom Out Click this icon to decrease the view size of the flowchart.

Print this Item Click this icon to print the flowchart.

Copy Click this icon to create a copy of this flowchart.

Delete Flowchart Click this icon to delete the flowchart.

Flowchart page icons (Edit mode)

The Flowchart page uses the following icons in Edit mode.

The icons, left to right, are described in the following table.

Note: Many of the icons in the interface are associated with features that require
permissions. For more information, see the Marketing Platform Administrator's Guide.

Table 7. Flowchart page icons for Edit mode

Icon Name Description

Run Click this icon to access the Run menu.

Properties Click this icon to view or edit the Flowchart Properties
window.

Options Click this icon to access the Options menu.

Admin Click this icon to access the Admin menu.

Reports Click this icon to access the flowchart cell reports.

Cut Select one or more items in the flowchart and click this
icon to remove them.

Copy Select one or more items in the flowchart and click this
icon to copy them.

Paste Click this icon to paste into the flowchart any items you
have cut or copied.

Zoom In Click this icon to increase the view size of the flowchart.

Zoom Out Click this icon to decrease the view size of the flowchart.

Print Click this icon to print the flowchart.
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Chapter 5. Processes

Processes are the building blocks of flowcharts, which you configure to perform
particular tasks to achieve the outputs you want. For example, you use the Merge
process to merge two distinct audience groups, or use the contact processes (Call
List or Mail List) to write out the results of an entire campaign.

Tasks are usually accomplished using processes that work with cells. Cells are lists
of identifiers of marketing message recipients (such as customer or prospect IDs).
Generally, each process in a flowchart takes one or more cells as input, transforms
the data, and produces one or more cells as output.

The processes available to you in Campaign are visible on the flowchart process
palette—the space that you use for creating a flowchart and working with
processes.

The different types of processes are distinguished by color: data manipulation
processes are shown in blue, run processes in red, and optimization processes in
green.

To create a flowchart, you move processes of the required type from the process
palette to the flowchart workspace, and connect and configure them.

Types of processes
Campaign processes are divided into three types by function, which are
distinguished by color in the flowchart process palette:
v Data manipulation processes - blue.
v Run processes - red.
v Optimization processes - green.

A specialized set of run processes called "contact processes" generates contact lists
(Mail List or Call List).

Note: In addition to the Campaign processes described in this section, Interact,
Optimize, and eMessage provide additional processes for use in campaign
flowcharts. See the documentation for these products for information about the
processes that they provide.

Data manipulation processes
You use data manipulation processes to select customer IDs from your data source
and work with those IDs in various ways to create meaningful groups or target
audiences.

Data manipulation processes allow you to perform tasks such as selecting
customers based on a set of criteria, merging lists of customers together for
inclusion or exclusion, segmenting customers into meaningful groups, sampling for
test or control groups, or specifying target audiences for your campaign.

The data manipulation processes are:
v “Select” on page 46
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v “Merge” on page 49
v “Segment” on page 50
v “Sample” on page 56
v “Audience” on page 59
v “Extract” on page 68

Run processes
Once you have built your campaign to select the audience you want, you need to
output the results in a usable way using the run processes. Run processes control
the running of the flowchart and trigger actual customer contact.

Run processes control the actual execution of completed campaigns, which
includes the management and output of contact lists, the treatment of target
audiences, the tracking of responses and contacts, the logging of data, and the
scheduling of campaign or session runs.

The run processes are:
v “Snapshot” on page 73
v “Schedule” on page 75
v “Cube” on page 79
v “Create Seg” on page 80
v “Mail List” on page 81
v “Call List” on page 85

Note: The Mail List and Call List processes are also referred to as contact
processes.

Optimization processes
Optimization processes let you fine-tune your campaign to maximize effectiveness.
You use optimization processes to generate scores to refine audience selection.
They allow you to track contacts and responses, and use the results of predictive
modeling from Campaign or from data mining products like PredictiveInsight to
refine audience selection and maximize ROI. Optimization processes can also
provide the ability to determine the most effective campaign, offer, and channel
across your entire organization to use for contacting each individual prospect.

The optimization processes are:
v “Track” on page 85
v “Response” on page 87
v “Model” on page 89
v “Score” on page 91

Using processes in flowcharts
Campaign allows you to easily create campaign flowcharts by visually
manipulating processes. You can create, connect, configure, and run your processes,
experimenting with different flowchart designs. The following section describes the
tasks that you can perform with processes.
v “To add a new process to a flowchart” on page 39
v “To copy and paste a process” on page 41
v “To paste processes from the template library” on page 42
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v “To move a process” on page 42
v “To delete a process” on page 43
v “To connect two processes”
v “To delete a connection between two processes” on page 43
v “To access a process configuration window” on page 45
v “To run a process” on page 27

To add a new process to a flowchart

You add a process to a flowchart by clicking a process box in the palette, then
clicking in the flowchart workspace.

You can also copy an existing configured process, or paste a template from the
template library. Templates contain one or more configured processes and
connections.
1. Within a campaign, open a flowchart for editing.
2. In the process palette, click the process that you want to add to your flowchart.
3. Click the location in the workspace where you want to place the box. Note that

you cannot drag the box to a location. You must click.
When you add processes, try to place them in a logical order in the flowchart,
based on the campaign flow. Avoid placing process boxes on top of each other
in the workspace. If this happens, click the top process box and move it so you
can see the next box in the stack.
Newly added processes are gray until they are configured. Configured
processes are displayed in color based on their type (data manipulation
processes are blue, run processes are red, and optimization processes are green).

4. Right-click the process to see a list of actions you can perform on it.

Typically, the next step is to configure the process, by double-clicking it in the
workspace and using the resulting dialogs. You must connect the boxes to
determine the workflow. (Some processes must be connected before they are
configured because they require input from a source process.) For example, you
might configure a Select process to select households in a specific earning bracket,
then connect it to an Audience or Merge process. Finally, you would test run the
process. Save your flowchart frequently as you work.

See the other available topics for information about configuring, connecting, and
running processes.

To connect two processes

You connect the processes in your flowchart to specify the direction of data flow
and the order in which processes are run. If you move processes within the
workspace, existing connections will remain, and will adjust to the moved
process’s new location. Connections can be easily added or deleted.
1. Within a campaign, open a flowchart for editing.

You see the process palette and workspace.
2. Move your cursor over the connection box in the process from which you want

to create a connection.
The cursor changes to three downward arrows.

3. Click and drag a line to the process to which you want to make a connection.
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The source process is highlighted. As you drag your cursor, the connecting line
is drawn from the source process.

4. Release the mouse anywhere over the destination process.

The source and destination process are connected with an arrow showing the
direction of data flow. The source process will run before the destination process,
and data output from the source process can be available as input to the
destination process.

Note: If the destination process receives data from the source process, the
connection is shown as a solid line. If the destination process does not receive data
from the source process but cannot run successfully until the source process has
completed, the connection is shown as a dotted line.

Example: Process Connections

The following flowchart is scheduled to run automatically each night. The dotted
line connections between the Schedule process and three Select processes indicate
that the Select processes will not run until the Schedule process finishes running,
but that no data is passed from the Schedule process to the Select processes.
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To copy and paste a process

Copying a configured process can save time when you build flowcharts. You can
paste the process elsewhere in the workspace or in another flowchart.
1. Within a campaign, open a flowchart for editing.
2. In the workspace, click the process that you want to copy.

Note: To select multiple processes, you can Shift+Click the processes, drag a
selection box around them, or use Ctrl+A to select all the processes in the
flowchart.

3. Click the Copy icon.
You can also select Copy from the menu or press Ctrl+C.

4. Click the Paste icon.
You can also select Paste from the menu or press Ctrl+V.
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A copy of the process appears in the workspace.
5. Click and drag the copied process to the desired location.

To cut a process
1. Within a campaign, open a flowchart for editing.

You see the process palette and workspace.
2. From the processes that are already in the workspace, click the process that you

want to cut.

Note: You can Shift+Click to select multiple processes, drag the mouse to
select a group of processes, or use Ctrl+A to select all the processes in the
flowchart.

3. Click the Cut icon on the Flowchart toolbar.
You can also click Cut from the menu, or press Ctrl+X.

The process is removed from the flowchart and saved on the clipboard. You can
then paste this process back into the current flowchart or into another flowchart.

To paste processes from the template library

Using templates from the template library can save time when you build
flowcharts. Templates contain one or more configured processes and connections.
1. Within a campaign, open a flowchart for editing.

You see the process palette and workspace.
2. Click the Options icon and select Stored Templates.

You see the Stored Templates window, listing the available templates.
3. Select the template you want to paste into your flowchart from the Items List.
4. Click Paste Template.

The process or processes in the template you selected are pasted into the
flowchart.
If one or more process boxes are pasted on top of another process box in the
flowchart workspace, they will appear stacked. Click the top process box and
move it if you want to see the next process box in the stack.

To move a process

You can move any process in a flowchart you are editing by dragging it to a
different location on the workspace.

Campaign allows you to position processes on top of each another; however, if you
have a large flowchart with many processes, it may be easier to use the zoom
functionality so that you can see all processes, instead of overlapping them.
1. Within a campaign, open a flowchart for editing.

You see the process palette and workspace.
2. In the workspace, click and drag the process that you want to move to its new

location.
When you release the mouse, the process is moved to the new position.
Existing connections to and from the process you are moving remain, and are
redrawn for the new location.
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To delete a process

As you design and build flowcharts you might need to remove processes that you
have added.
1. Within a campaign, open a flowchart for editing.

You see the process palette and workspace.
2. In the workspace, right-click the process that you want to delete, and select

Delete from the menu.

Note: You can select more than one process at the same time by holding down
the Shift key as you select using the mouse.
You see a confirmation message asking if you want to remove the selected
items.

3. Click OK.
4. The selected process(es) are removed from the workspace. Any connections to

and from the processes are also deleted from the flowchart.

To delete a connection between two processes
1. Within a campaign, open a flowchart for editing.

You see the process palette and workspace.
2. Click the connection that you want to delete.
3. Do one of the following:

v Right-click the connection, and select Delete from the menu.
v Press the Delete key.
v Click the Cut icon on the Flowchart toolbar.
v Press Ctrl+X.

The connection is deleted.

To run a process

To make sure that your configuration is successful and that the results are what
you expect, be sure to run each process as soon as you configure and connect.

Note: When you run a process, any results from a previous run are lost.
1. Within a campaign, open a flowchart for editing.
2. Click the process that you want to run.

If the process requires data from a source process, be sure that the source
process has already run successfully so that its data is available.

3. Click the Run icon or right-click a process box, then select one of the following
options:
v Test Run Selected Process: Use this option when building your flowchart, so

you can troubleshoot errors as they occur. Test runs do not output data or
update any tables or files. (However, triggers run on completion of test runs,
and global suppression is applied.)

v Save and Run Selected Process: Do a production run. Processes such as Mail
List and Call List will write entries into Contact History. Each production run
can generate contact history only once. Contact processes that have already
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executed for that production run can be re-run only if the contact history
from the current run is first deleted. Triggers run on completion of the
production run.

Note: Running only a process or a branch of a flowchart does not increment
the Run ID of a flowchart. When you run only a process or a branch, if contact
history records exist, you are prompted to choose run history options before
you can proceed. For details, see“About run history options” on page 28.

4. When the process finishes running, click OK on the confirmation window.

The process displays a blue checkmark when it has run successfully. If there are
errors, the process displays a red "X."

About run history options

Note: You see the Run History Options window only when you run a branch or
process that has already generated contact history for the current Run ID. If a new
run instance does not exist for a particular re-run branch or process, the Run
History Options window does not appear.

Use the Run History Options window to choose how the new contact history you
generate is written to the contact history table.

Run history options scenario: You have a flowchart with two branches and two
contact processes, A and B, both configured to log to contact history.

You run the entire flowchart (from the top, using the Run Flowchart command)
once. This creates a new Run ID (for example, Run ID = 1) and generates contact
history for this Run ID.

After this first successful run of the entire flowchart, you edit contact process A to
give a follow-up offer to the same individuals who received the first offer.
Therefore, you want to rerun contact process A. The current Run ID is "1" and
contact history already exists for process A and Run ID=1.

When you select contact process A and click "Run Process," you see the Run
History Options window. You can choose to leave the Run ID unchanged (Run
ID=1) and replace the existing contact history associated with this Run ID, or you
can create a new run instance (that is, increment the Run ID to 2), leave the contact
history associated with Run ID=1 untouched and append new contact history
associated with Run ID=2.

You are sending a follow-up offer and do not want to lose the contact history
associated with the first offer, so you choose Create a new run instance. This
changes the Run ID to "2" and appends contact history records for the same IDs
who received the first offer to the contact history table.

If you now edit and run contact process B, you will not see a Run History Options
window, because the current Run ID = 2 and contact history associated with Run
ID =2 does not exist for contact process B. Running only contact process B will
simply generate additional contact history records for Run ID = 2.

Run History Options window reference:

The Run History Options window contains the following options.
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Table 8. Run History Options window options

Option Description

Create a new run instance Rerun a specific branch or process of the flowchart using a
new Run ID. Append the results, associated with the new Run
ID, to the contact history table. Existing contact history
remains intact.

Replace the contact
history of the previous
run

Reuse the previous Run ID and replace the contact history
previously generated for that Run ID (only for the process or
branch that is being run). Contact history records that were
previously generated for other branches or processes of the
flowchart remain intact.

Cancel Cancel the branch or process run and do nothing to existing
contact history. The flowchart remains open in Edit mode.

You cannot replace contact history if associated response history exists. Therefore,
if you selected Replace the contact history of the previous run and associated
response history records exist, you can choose one of two options:
v Click OK to clear the associated response history records as well as the contact

history records. This is your only option if response history exists and you want
to replace the contact history from the previous run.

v Click Cancel to cancel clearing the contact history records. You can choose
Create a new run instance instead, to create a new run instance to run the
current contact process.

Configuring processes
You must configure a process after adding it to your flowchart. By configuring a
process, you provide Campaign with important information, such as the source of
the data the process will use, which IDs to work with, and what to do with the
output. For example, you could configure a Select box to select all customers who
made a purchase in the last six months.

A best practice is to place the processes in your flowchart in the order in which
they will be used when the campaign is run. Some processes must be connected
before they are configured because they require input from a source process.

To access a process configuration window
1. Within a campaign or session, open a flowchart for editing.

You see the process palette and workspace.
2. Double-click the process that you want to configure. You can also right-click the

process and select Process Configuration from the menu.
You see the process configuration window for the process.

3. Enter information into the fields on each tab of the process configuration
window. For assistance, click Help.

4. When you have finished entering the configuration details, click OK.
Correctly configured processes are displayed in color (the specific color reflects
the type of process). A gray process with its name in italics has a configuration
error. To find out more information about the error, hold your mouse over the
process to display a descriptive error message.
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Select
Use the Select process to define the criteria to build lists of contacts, such as
customers, accounts, or households, from your marketing data. Select is the most
frequently used process in Campaign. Most flowcharts begin with one or more
Select processes. The Select process outputs a cell containing a list of IDs, such as
customer IDs, which can be modified and refined by other processes.

To configure a Select process

Define a Select process to build a list of contacts from your marketing data. You
can specify all IDs in a segment or table, or you can use a query to select specific
IDs. One or more Select processes can then be used as input into another process.
For example, you could select all Loyal Customers, then create another selection of
all Opt-Outs, and merge them into a single list.
1. Within a campaign, open a flowchart for editing.
2. Click the Select process in the palette, then click the workspace to add the

process to your flowchart.
The Select process box in the work area is gray until it has been configured.

3. Double-click the Select process box in the flowchart workspace.
The process configuration dialog appears.

4. On the Source tab, use the Input drop-down list to select a Segment or Table
that will serve as the data source for the process.

Note: If IBM Coremetrics is integrated with Campaign, you can select IBM
Coremetrics Segments as the input. For instructions, see “To use IBM
Coremetrics segments in a Select process” on page 47. Configuring the
integration is explained in the IBM Unica Campaign Administrator's Guide.

5. Choose one of the Select All options. The option names depend on the
audience level of your input data source. For example, if your audience level
is Customer, you would see Select All Customer IDs and Select Customer
IDs With:
v Choose Select All IDs to include all the rows from the data source selected

in the Input list.
v Choose Select IDs With to select IDs based on a query.

6. If you chose Select IDs With, create a query using one of the following
methods:
v Point & Click: This is the default view. Click in the Field Name, Oper.,

Value, and And/Or column cells to select values from the list at the right
side of the dialog, to build your query. This method is the easiest way to
create a query, and it helps avoid syntax errors.

v Text Builder: Click this button to write raw SQL or use the Query Helper
to select from a wide variety of supplied macros, such as logical operators
and string functions.

7. If you are constructing a query, select the fields you want to include in your
query from the Available Fields list, including IBM Unica Campaign
Generated Fields and Derived Fields. For more information, see“Creating
queries in processes” on page 95. Use Check Syntax and Test Query to ensure
that your query does not have errors.
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Note: If your query includes a table field that has the same name as a
Campaign Generated Field, you must qualify the field name using the
following syntax: <table_name>.<field_name>

8. Click the Cell Size Limit tab if you want to limit the number of IDs generated
by the process.

9. Click the General tab to specify the Process Name (for example, call it Loyal
Customers), the Output Cell name (by default, this matches the Process
Name), and the Cell Code (generally, just accept the default). Enter a Note to
describe what this Select process is intended to achieve.

10. Click OK.
The process is now configured. You can test run the process to verify that it
returns the results you expect.

To use IBM Coremetrics segments in a Select process

When you configure a Select process, you can choose IBM Coremetrics Segments
as the data source, to use segments exported from IBM Coremetrics products in
your campaign.

Note: The IBM Coremetrics Segments option is available only if IBM Coremetrics
and Campaign are integrated. Configuring the integration is explained in the IBM
Unica Campaign Administrator's Guide.
1. Double-click a Select box in a Campaign flowchart, to open the Select Process

Configuration dialog.
If you are modifying a Select box that contains a previously defined IBM
Coremetrics Segment, the Input box on the Source tab shows the existing
segment name.

2. Open the Input list and click IBM Coremetrics Segments.

The IBM Coremetrics Segment Selection dialog opens.
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3. In the IBM Coremetrics Segment Selection dialog:
v Select a Client ID from the drop-down list to display a list of all published

segments associated with that particular IBM Coremetrics client.
v The Select segment list shows the segments defined in IBM Coremetrics,

including the Application where the segment was created, its Type, and its
Start and End Dates.

v The Description should help you determine the purpose of the segment. If
you need more information about a segment, double-click it to see the
segment expression and other information defined in IBM Coremetrics.

v The Start Date and End Date next to each segment indicate the IBM
Coremetrics-defined date range for finding visitors who match the segment
criteria. For example, one segment might find everyone who visited a
particular site at least 3 times between January 12, 2012 and April 12, 2012,
and another segment might find visitors from a different range of dates. The
IBM Coremetrics-defined date range cannot be changed here. However, you
can use the Segment range date controls at the bottom of the dialog to
define a date range that falls within the range defined in IBM Coremetrics.

4. Select a segment in the list. If you are modifying (as opposed to creating) a
Select process, the existing segment range is displayed.

5. Use the Segment range date and calendar controls at the bottom of the dialog
to specify the date range from which you want to obtain data for the selected
segment.
v The range that you specify must fall within the Start Date and End Date

defined for the segment in IBM Coremetrics (shown next to each segment in
the list).

v In addition to taking the Start and End Date into account, Campaign also
considers the date constraint (if any). The date constraint is defined in IBM
Coremetrics but does not appear in the Segment Selection dialog. The date
constraint limits the number of days' worth of data to pull for a segment, to
ensure that IBM Coremetrics is not overloaded with exporting a large data
set.
For example, say there is a segment defined in IBM Coremetrics with a
3-month span (Start and End Date) and a date constraint of 7 days. The date
range that you define in Campaign takes both constraints into account. If
you specify a date range outside of the 3-month span, your segment
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definition cannot be saved. Likewise, if you specify a date range that exceeds
7 days, your segment definition cannot be saved.

v You can specify absolute or relative dates, as long as they fall within the IBM
Coremetrics-defined range and date constraint.

v If you specify an absolute Start Date, you must also supply an End Date. For
example, if the IBM Coremetrics-defined segment defines a 3-month span,
your campaign can target visitors whose information was gathered on a
single day, month, or week within that span.

v Examples of relative dates:
– If the IBM Coremetrics-defined segment is for a 3-month span, you can

specify a relative date, such as Yesterday or Last 7 Days, to continually
find recent visitors. The campaign will run successfully until the IBM
Coremetrics-defined End Date occurs.

– If you specify THIS MONTH, the full month of data must be available up
until the day before this relative date is used. For example, if today is
March 28, data from March 1 - March 27 must be available for the selected
segment.

– If you specify LAST MONTH; the full previous month of data must be
available. Example #1: If the IBM Coremetrics-defined segment has a start
date of March 1 and an end date of March 31, LAST MONTH can be used
starting on April 1, up to and including April 30 (to get data for the
month of March). Example #2: If the IBM Coremetrics-defined segment
has a start date of March 1 and an end date of March 30, LAST MONTH
cannot be used, because there is not a full month of data. Example #3: If
the IBM Coremetrics-defined segment has a start date of March 2 and an
end date of March 31, LAST MONTH cannot be used, because there is not
a full month of data. In these cases, a message indicates that LAST
MONTH does not fall within the segment dates. Instead, you must use
absolute dates.

6. Click OK to return to the Select Process Configuration dialog.
When the Select process runs, it pulls data from IBM Coremetrics for the
segments within the specified date range and date constraint. The mapping
table used for the flowchart tells Campaign how to convert IBM Coremetrics
IDs to Campaign Audience IDs. The Audience IDs are then available for use in
downstream processes. For technical information about how this works, see the
Campaign Administrator's Guide.

In rare situations, when you run a flowchart, the number of IBM Coremetrics
IDs for a selected segment might not match the number of Audience IDs found
in Campaign. For example, there might be 100 IBM Coremetrics keys but only
95 matching IDs in Campaign. Campaign warns about this situation but
continues running the flowchart. A message is written to the log file for that
flowchart, asking you to verify that your mapped translation table contains
updated records. An administrator can resolve this situation by (re)matching
the online and offline keys according to your corporate policy and repopulating
the translation table with up-to-date data. You must re-run the flowchart after
the mapped translation table is updated.

Merge
Use the Merge process to specify which input cells are included and combined,
and which are excluded (suppressed). This allows you to include or exclude cells
from subsequent processes in your flowchart. For example, use the Merge process
to suppress "opt-out" customers who have requested that they not receive any
marketing materials.
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To configure a Merge process

The Merge process accepts one or more input cells and produces one output cell.
You specify which input cells are included and combined or excluded from the
output.
1. Within a campaign, open a flowchart for editing.
2. Click the Merge process in the palette, then click the workspace to add the

process to your flowchart.
3. Ensure that the Merge process is connected to one or more configured

processes whose output cells will be used as input by the Merge process.

Note: All input cells should have the same audience level.
4. Double-click the Merge process in the flowchart workspace.

The process configuration dialog appears. Cells from processes connected to the
Merge process are automatically displayed in the Input list.

5. On the Method tab, specify the input cells that you want to include or exclude.
Click each cell in the Input list, and use the appropriate Add>> button to add
it to the Records to Include list or the Records to Exclude list.
The IDs in the cells in the Records to Include list will be combined into one list
of unique IDs. IDs in the Records to Exclude list will not appear in the merged
output.

6. Specify how you want to handle duplicate IDs in the input cells (specified in
the Records to Include list) by selecting one of the following:
v Merge/Purge on Include: Remove duplicate IDs to produce a list of unique

IDs that appear in at least one input cell. This is a logical "OR" or "ANY."
v Match (AND) on Include: Include only those IDs that appear across all input

cells. This is a logical "AND" or "ALL."
The first option will include customer A if that customer is in either the
Gold.out cell OR the Platinum.out cell (but the record will only be included
once, so you will not have duplicates). The second option will include customer
A only if that customer appears in both the Gold.out cell AND the
Platinum.out cell,. The second option is useful when you want to include
customers only if they meet multiple criteria.

7. Click the Cell Size Limit tab if you want to limit the number of IDs generated
by the process.

8. Click the General tab to assign a Process Name, Output Cell name, and Cell
Code, and enter a Note that describes the process.

9. Click OK.

The process is configured and enabled in the flowchart. You can test run the
process to verify that it returns the results you expect.

Segment
Use the Segment process to divide data into distinct groups (segments) to receive
different treatments or offers. After the segments have been created, you connect
the Segment process to a contact process (such as CallList or MailList) to assign
treatments or offers to the segments. There is no limit to the number of segments
you can create.
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For example, you might want to divide your customers into high-value,
medium-value, and low-value segments based on their prior purchase history. Each
of these segments can then receive a different offer when connected to a contact
process.

You can segment data in two ways: by using the distinct values in a field, or by
filtering the data in a field using a query. In addition to database table fields, you
can use derived fields to segment data. This allows you to perform custom
binning.

Important: The segments created by the Segment process are not the same as the
globally persistent strategic segments created by the Create Seg process, which can
be used in any session or campaign.

Segmenting by field
When you segment data by a field in a database table, each distinct value in the
field creates a separate segment. This option is most useful when the values in the
field correspond to the segments you want to create.

For example, assume that you want to assign a different offer to customers in each
of 10 regions. Your customer database contains a field called regionID, which
indicates the region to which each customer belongs. Segment by the regionID
field to create the 10 regional segments.

Segmenting by query
The segment by query option segments your data based on the results of a query
that you create. This option is most useful when it is necessary to filter the data in
a field to create the required segments.

For example, assume that you want to divide your customers into high-value
(more than $500), medium-value ($250-$500), and low-value (under $250) segments
based on their purchase history over the last year. The PurchaseHistory field in
your customer database stores the total dollar amount of each customer's
purchases. Use a separate query to create each segment, selecting records with
values in the PurchaseHistory field that meet the criteria of the segment.

Note: You can also segment data using raw SQL.

Using segments as input to another Segment process
Segments can also be used as input cells to another Segment process. For example,
assume that you want to segment your customers into six age ranges. Your
database contains a field called AgeRange that assigns one of six age ranges to each
customer. Segment by the AgeRange field to create the six segments.

You could then use these six segments as input to another Segment process that
further divides customers by another field or query. For example, assume that your
database contains a field called PreferredChannel, which specifies each customer's
preferred contact channel — direct mail, telemarketing, fax, or email. Using the six
age range segments as input, you could then create a second Segment process to
segment by the PreferredChannel field. Each of the six age range segments is
further segmented into four preferred channel segments, to produce a total of 24
output segments.
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Segmenting considerations
Consider the following options and guidelines when segmenting data:
v “Choosing a segmenting method”
v “Making segments mutually exclusive”
v “Restricting segment size”
v “Selecting source cells”

Choosing a segmenting method
In some cases, the same results can be achieved when segmenting either by field or
by query. For example, assume that the AcctType field in your database divides
your customer accounts into Standard, Preferred and Premier levels. Segmenting
by the AcctType field will create three segments for these account types. You could
achieve the same results using queries, but creating the segments would require
writing three separate queries. Determine the most efficient method based upon
the data you are segmenting.

Making segments mutually exclusive
You can specify segments to be mutually exclusive, meaning that each qualifying
record is guaranteed to be placed into no more than one segment. When the
segments are assigned to offers, this will ensure that each customer receives only
one offer.

Records are placed in the first segment whose criteria they satisfy, based on a
priority order that you define. For example, if a customer qualifies for segments 1
and 3, and segment 1 is before segment 3 in the priority order, that customer will
appear only in segment 1.

Restricting segment size
The default size for the number of records per segment is Unlimited. You may
want to restrict the size of the created segment if, for example, you are performing
test runs of the flowchart or process.

You can limit the segment size to any positive integer. If the segment size you
specify is less than the total number of records generated, the segment will consist
of randomly selected qualifying records.

Selecting source cells
All selected cells must be defined at the same audience level. If more than one
source cell is selected, the same segmentation is performed on each source cell.

To configure a Segment process by field
1. On the Segment tab of the Segment Process Configuration window, specify

the input to the process, using the Input drop-down list. To use more than one
source cell, click the Multiple Cells button and select the cells from the dialog
box.

2. Select Segment by Field and use the drop-down list to select the field you
want to use to create the segments.
The Profile Selected Field window opens, and profiling of the selected field
automatically starts.

3. Wait for profiling to finish before clicking OK, to ensure that all segments are
properly created.
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The list of segments and the # of Segments field are updated based on the
profiling results of the selected field. To reprofile the field at any time after
initially selecting it, click Profile.

4. Set the remaining configuration options, if desired.
5. Click OK.

The process is configured and appears enabled in the flowchart.You can test the
process to verify that it returns the results you expect.

To configure a Segment process by query
1. On the Segment tab of the Segment Process Configuration window, specify

the input to the process, using the Input drop-down list. To use more than one
source cell, click the Multiple Cells button and select the cells from the dialog
box.

2. Select Segment by Query.
3. Determine the number of segments that you want to create, and enter that

number in the # of Segments field.
4. To construct a query for each segment, select the segment and click Edit to

access the Edit Segment window. For details, see “New Segment and Edit
Segment dialogs” on page 55.

5. Set the remaining configuration options, if desired.
6. Click OK.

The process is configured and appears enabled in the flowchart. You can test
the process to verify that it returns the results you expect.

Segment Process Configuration: Segment tab

The following table describes the fields, buttons, and controls on the Segment tab
of the Segment Process Configuration window.

Table 9. Segment tab

Field/control Description

Input Specifies the input to the Segment process. The drop-down
list contains all output cells from any process connected to
the Segment process.

Multiple Cells button Allows you to choose more than one source cell as input to
the Segment process.

Segment by field Specifies a field to use for segmenting data. The data is
segmented using the distinct values that exist for the
selected field. Each distinct value in the field will create a
separate segment.

Profile button Opens the Profile Selected Field window, which calculates
the values and distributions of records in the selected field.
Active only when segmenting by field.

Derived Fields button Opens the Create Derived Field window. Active only
when segmenting by field.

Segment by query Segments data based on a query that you create.
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Table 9. Segment tab (continued)

Field/control Description

# of Segments Specifies the number of segments to create. Active only
when segmenting by query. By default, three segments are
created, with default names "Segment1," "Segment2," and
"Segment3."

When segmenting by field: The # of Segments field is
updated based on the profiling results of the selected field.

Mututally Exclusive Segments Specifies whether the segment is to be mutually exclusive
(that is, each qualifying record is guaranteed to fall into no
more than one segment).

Create Extract tables Indicates whether the segment should create Extract tables
for each output cell. Selecting this option ensures that
Campaign can provide a later process with the information
necessary to keep track of duplicate target audiences across
segments.

Selecting this check box enables the options on the Extract
tab.

This check box is disabled if Mutually Exclusive Segments
is selected.

Segment Name Lists all segments by name. By default, three segments are
created, with default names "Segment1," "Segment2," and
"Segment3."

When segmenting by field: Segment names are updated
based on the profiling results of the selected field. For
example, if you are segmenting on a field called
"Acct_Status" which has two distinct values "A" and "B",
two segments are created, named "Acct_Status_A" and
"Acct_Status_B."

Max. Size Maximum number of records allowed in each segment.

Size Number of records that meet the criteria for the segment.
Before the process is run, this number defaults to the total
number of records in the output cell.

Query Query that defines the criteria for this segment. Appears
only when segmenting by query.

Up 1 Move the selected segment one position higher in the
processing order. Segments are processed in the order listed
in the table.

Down 1 Move the selected segment one position lower in the
processing order. Segments are processed in the order listed
in the table.

New Segment button Opens the New Segment window. Active only when
segmenting by query.

Edit button Opens the Edit Segment window for editing the selected
segment.

Remove Removes the selected segment. When a segment is
removed, the # of Segments field updates automatically.

Do Not Run Subsequent
Processes For Empty
Segments

Prevents processes downstream from this process from
running for empty segments.
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Segment Process Configuration: Extract tab

Use the Extract tab of the Segment Process Configuration window to allow the
output you specify from the Segment process to be accessible as input to Mail List
or Call List processes in the flowchart. The following table describes the fields,
buttons, and controls on the Extract tab.

Table 10. Extract tab

Field Description

Target Data Source Location to which the output from this process will be
written. The Campaign Server and any other data sources
to which you are connected are available from the Target
Data Source drop-down list.

Candidate Fields List of fields available to extract, including field name and
data type, based on your input data source.

If your input source is a landing page in eMessage, each
field name is an attribute of the landing page. If the
attribute contains special characters or spaces, it is
converted to a valid field name. Data types of all landing
page attributes are listed as text.
Note: Schema object names are limited to 30 characters.
Restrict your attribute names to 30 characters or less to
produce valid column names for extracted output.

Fields to Extract Fields you selected to extract from the Candidate Fields
list. The Output Name defaults to the field name in the
Fields to Extract column.

Profile button Opens the Profile Selected Field window, which calculates
the values and distributions of records in the selected field.
Active only when a field name is selected in the Candidate
Fields list.

Derived Fields button Opens the Create Derived Field window.

More button Opens the Advanced Settings window, which includes the
option to skip duplicate records and to specify
howCampaign identifies duplicates.

Segment Process Configuration: General tab

The Segment Process Configuration General tab allows you to modify the Process
Name, Output Cell names, or Cell Codes, or enter a Note about the process. For
details about these options, see these topics:
v “Changing the cell name” on page 139
v “Resetting the cell name” on page 140
v “To copy and paste all cells in the grid” on page 140
v “Changing the cell code” on page 141

New Segment and Edit Segment dialogs

The following table describes the fields, buttons, and controls on the New Segment
and Edit Segment dialogs.
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Note: The New Segment dialog can be accessed only when you are segmenting by
query. When you segment by field, only the Name and Max. Size fields can be
accessed on the Edit Segment dialog.

Table 11. New Segment and Edit Segment dialog controls

Field/control Description

Name Name of the segment.

Max. Size Maximum number of records allowed in the segment.

Select Based On Specifies a data source on which to base your query.

Select All <audience_level>
IDs

Includes all the IDs from the data source in the Input
drop-down list. The <audience_level> is the name of the
audience level of the source cell.

Select <audience_level> IDs
With

Provides access to the functions for creating a query to
select only certain IDs based on criteria you define. The
<audience_level> is the name of the audience level of the
source cell.

Advanced button Opens the Advanced tab, which provides the following
options:

v Use Raw SQL: Use a raw SQL query to segment data.

v Use Query Scope from Input Cell: Available only if a
source cell to this Segment process uses a query. Select
the check box to have the source cell’s query combined
(using “AND”) with the current selection criteria.

Derived Fields button Opens the Create Derived Field window.

Query text box and buttons For information about using the query text box and related
fields and buttons, see “Creating queries in processes” on
page 95.

Sample
Use the Sample process to create one or more cells for different treatments, control
groups, or a subset of data for modeling. A wide variety of configurations is
available for sampling.

To configure a Sample process
1. In a flowchart in Edit mode, ensure that one or more configured processes

(such as a Select process) are connected as input to the Sample process box.
2. Double-click the Sample process in the flowchart workspace.

The process configuration dialog appears.
3. Use the Input drop-down list to select the cells that you want to sample. The

list includes all output cells from any process connected to the Sample
process. To use more than one source cell, select the Multiple Cells option. If
more than one source cell is selected, the same sampling is performed on each
source cell.

Note: All selected cells must be defined at the same audience level.
4. Use the # of Samples/Output Cells field to specify how many samples to

create for each input cell. By default, three samples are created for each input
cell, with default names "Sample1", "Sample2" and "Sample3."
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5. To change the default sample names, select a sample in the Output Name
column, then type a new name in the Cell Name box in the Edit Output Cell
section. You can use any combination of letters, numbers, and spaces. Do not
use periods (.) or slashes (/ or \).

Important: If you change the name of a sample, you must update all
subsequent processes that use this sample as an input cell. Changing a sample
name might unconfigure subsequent connected processes. In general, you
should edit the names of samples before connecting subsequent processes.

6. Specify the size of your samples using one of the following methods:
v Specify Size by %: After selecting this option, use the % (percentage) field

in the Edit Output Cell section to specify the percentage of records to use
for the sample selected in the Output Name column. Use the Max #
Records field if you want to limit the size of the sample. The default is
Unlimited. After changing any values, click in any other field to see the
change in the list of Output Names. Select another sample in the Output
Name column and adjust the percentage for it, or use the All Remaining
check box to assign all remaining records to that sample. You can only
select All Remaining for one output cell.

v Specify Size By # Records: After selecting this option, use the Max #
Records field to specify the maximum number of records to be allocated to
the sample group selected in the Output Name column. Select the next
sample in the Output Name column and specify a maximum number of
records for that group, or use the All Remaining check box to assign all
remaining records to that sample. You can only select All Remaining for
one output cell.

7. Ensure that each sample in the Output Name list has a Size defined or has
All Remaining checked.

8. (Optional) Click Sample Size Calculator to use the calculator to help you
understand the statistical significance of sample sizes in evaluating campaign
results. You can specify the level of accuracy you want by entering an error
bound and computing the sample size needed, or you can enter a sample size
and compute the error bound that will result. Results are reported at the 95%
confidence level.

9. In the Sampling Method section, specify how to build the samples:
v Random Sample: Use this option to create statistically valid control groups

or test sets. This option randomly assigns records to sample groups using a
random number generator based on the specified seed. Seeds are explained
later in these steps.

v Every Other X: This option puts the first record into the first sample, the
second record into the second sample, up to the number of samples
specified. This process repeats, until all records have been allocated to a
sample group. To use this option, you must specify the Ordered By options
to determine how records are sorted into groups. The Ordered By options
are explained later in these steps.

v Sequential Portions: This option allocates the first N records into the first
sample, the next set of records in the second sample, and so on. This option
is useful for creating groups based on the top decile (or some other size)
based on some sorted field (for example, cumulative purchases or model
scores). To use this option, you must specify the Ordered By options to
determine how records are sorted into groups. The Ordered By options are
explained later in these steps.
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10. If you selected Random Sample, in most cases you can simply accept the
default seed.
In rare cases, you may want to click Pick to randomly generate a new seed
value, or enter a numeric value in the Seed field. Examples of when you
might need to use a new seed value are:
v You have exactly the same number of records in the same sequence and if

you use the same seed value, records are created into the same samples
each time.

v You find that the random sample produces undesired results (for example,
if all males are being allocated to one group and all females to another).

11. If you selected Every Other X or Sequential Portions, you must specify how
records will be sorted. The sort order determines how records will be allocated
to sample groups:
a. Select an Ordered By field from the drop-down list or use a derived field

by clicking Derived Fields.
b. Select Ascending to sort numeric fields in increasing order (low to high)

and sort alphabetic fields in alphabetical order. If you choose Descending,
the sort order is reversed.

12. Click the General tab if you want to modify the default Process Name and
Output Cell Names. By default, output cell names consist of the process name
followed by the sample name and a digit. You can accept the defaultCell
Codes or uncheck the Auto Generate Cell Code box and assign codes
manually. Enter a Note to clearly describe the purpose of the Sample process.

13. Click OK.

The process is configured and enabled in the flowchart. You can test run the
process to verify that it returns the results you expect.

About the sample size calculator
Campaign provides a sample size calculator to help you understand the statistical
significance of sample sizes in evaluating campaign results. You can specify the
level of accuracy you want by entering an error bound and computing the sample
size needed, or you can enter a sample size and compute the error bound that will
result. Results are reported at the 95% confidence level.

To use the sample size calculator
1. On the Sample tab of the Sample process configuration dialog, click Sample

Size Calculator.
The Sample Size Calculator window appears.

2. Under Response Rate Estimate, enter your estimates of the minimum and
maximum response rates expected from your marketing campaign.
These two values must be percentages between 0–100. The lower the expected
response rate, the larger the sample size must be to achieve the same level of
accuracy.

3. Under Modeling Estimate, provide modeling estimate information.
v If you are not using a model, select No Model.
v If you are using a model, select Model Performance, then enter the

appropriate model performance percentage. This represents the area under
the lift curve and is reported in the Model Performance report.

4. To compute the required sample size for a specific error bound:
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a. In the Error Bound (+ or -) field, enter a value 0 - 100 for the acceptable
error bound.

b. Click Compute Sample Size. The minimum sample size required to achieve
the specified error bound is displayed in the Min. Sample Size text box.

5. To compute the error bound expected with a particular sample size:
a. Enter the sample size in the Min. Sample Size text box.
b. Click Compute Error Bound.

The error bound is displayed in the Error Bound (+ or -) text box.
6. When you are finished, click Done.

The Sample Size Calculator window closes.

Note: You can copy and paste the calculated sample size to use in the Sample
process configuration dialog.

Audience
Audience levels define the target entity with which you want to work, such as
account, customer, household, product, or business division, and are defined
during the table mapping process by your system administrators.

Use the Audience process in a flowchart to switch between audience levels, or to
filter out IDs by audience level. Using this process, you can select all, some, or a
single entity at one level in relation to another level.

For example, you can use the Audience process to:
v Select one customer per household based on some business rule (for example,

oldest male or the person with the highest account balance);
v Select all accounts belonging to a particular set of customers;
v Select all accounts with a negative balance belonging to a particular set of

customers;
v Select all households with individuals holding checking accounts;
v Select customers with three or more purchases within a specified time-frame.

Note: The Audience process can select from any defined table(s), so you can also
use it as a top-level process in your flowchart to initially select data.

Audience levels
Audience levels are defined by Campaign administrators to represent different
potential targets of campaigns, such as account, customer, household, product, or
business division. Audience levels are often, but not always, organized
hierarchically. Here are some examples of hierarchical audience levels that are
commonly found in customer marketing databases:
v Household > Customer > Account
v Company > Division > Customer > Product

Your organization can define and use an unlimited number of audience levels. If
you are using multiple audience levels (for example, customer and household), it is
important to understand how to use the Audience process to best accomplish your
business objectives.

Audience levels are created and maintained by a Campaign administrator. Moving
from one audience level to another requires that all of the audience levels that you
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use have keys defined within the same table. This provides a “look up”
mechanism to switch from one level to another.

Audience levels are global, and are attached to each mapped base table. Thus,
when a flowchart is loaded, the audience levels are loaded along with the table
mappings within that flowchart.

If you have permissions to map tables in Campaign, you can map a new table to
one or more existing audience levels, but you cannot create new audience levels.
Only users with the appropriate permissions, usually system administrators, can
create audience levels.

In the Audience process, you specify an input audience level and an output
audience level. The input and output audience levels can be the same (for example,
Customer) or different (for example, Customer and Household). Use the Audience
process to stay within the same audience level, or to switch audience levels.

Householding
"Householding” is as a general term to describe reducing the number of members
in the current audience level by scoping using another audience level. One of the
most common examples of householding is to identify a single individual to target
within each household. You might select one individual per household according
to a marketing business rule such as:
v The individual with the greatest dollar value across all accounts;
v The individual with the most purchases in a particular product category;
v The individual with the greatest tenure; or
v The youngest male over 18 within the household.

You can use the Audience process to change audience levels and filter IDs
according to user-specified criteria.

Switching levels
Some complex campaigns require processing at different audience levels to arrive
at the list of final target entities. This can involve starting at one audience level,
performing some computations and taking this output, then moving to another
audience level, and performing other computations.

For example, you might want to support complex suppressions at different levels.
As a result, in a data model where there is a one-to-many or many-to-many
relationship between customers and accounts, a marketing analyst might want to
build a campaign that does the following:
v Eliminates all accounts of customers that satisfy certain criteria (for example,

eliminate any account that is in default);
v Eliminates particular accounts that satisfy certain criteria (for example, eliminate

all the low-profitability accounts).

In this example, the campaign might start at the customer level, perform
customer-level suppressions (suppress accounts in default), switch to the account
level, apply account-level suppressions (suppress low-profitability accounts), and
then switch back to the customer level to obtain the final contact information.

60 IBM Unica Campaign: User's Guide



Configuring the audience process
To use the Audience process, you must work with tables for which multiple
audience levels are defined. These levels, defined within a single table, provide a
relationship to “translate” from one level to another.
v One key is defined as the “primary” or “default” key for the table. (This default

key represents the audience used most frequently for this data source.)
v The other keys are “alternate” keys that are available for switching audience

levels.

Once you switch audience levels, Campaign displays only those tables whose
default key is defined at the same audience level. If you work at different audience
levels on a regular basis, you might need to map the same table more than once
within Campaign, each time with a different primary/default key. The default level
associated with a table is specified during the table mapping process. For more
information about mapping tables, see the Campaign Administrator’s Guide .

The options available in the Audience process configuration dialog depend on
various choices that you can make:
v Whether the input and output audience levels are the same or different;
v Whether the audience level values are normalized in these tables;
v Whether there are multiple audience levels defined for the selected tables.

For this reason, not all of the options described in the following sections are
available for all pairs of input and output table selections.

To configure an Audience process
1. Within a campaign, open a flowchart for editing.
2. Click the Audience process in the palette, then click the workspace to add the

process to your flowchart.
3. Ensure that your Audience process is connected to one or more configured

processes (such as a Select or Merge process) whose output cells will be used
as input by the Audience process.

4. Double-click the Audience process in the flowchart workspace.
The process configuration dialog appears.

5. On the Source tab, choose the input data source from the Input drop-down
list. If one or more processes are connected to the Audience process, their
output cells will also appear in the list.
The audience level corresponding to this input is now displayed next to the
Input field. If there is no input into the Audience process, the audience level
is shown as “not selected.”
The Select options also reflect your input audience level. For example, if you
chose an input with an audience level of Customer, the Select options change
to All Entries, Some Entries, and One Entry per Customer.

6. Select the output audience from the Choose Audience drop-down list. The list
displays only audience levels defined for tables containing keys defined at the
same audience level as the input data source. If a table has more than one
level defined, each level is available as an entry in the Choose Audience list.

Note: If you do not see a desired audience level, you might need to remap a
table.
The Select options now reflect both your input and your output audience
levels.
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For example, if your input has an audience level of Household and you
choose an output audience level of Individual, the Select options are labeled:
All Individual ID Entries , Some Individual ID Entries , One Individual ID
Entry per Household ID, so you can specify how IDs are selected while you
switch from one audience level to another.

7. Use the Select and Filter options to specify how you want the records to be
selected. These options vary depending on whether you are selecting All IDs
(in which case there are no filtering options), switching levels, or staying at
the same level. For details on how to select and filter based on whether you
are switching audience levels, see:
v Using the same input and output audience levels
v Using different input and output audience levels

8. Click the Cell Size Limit tab if you want to limit the number of IDs generated
by the process.

9. Click the General tab to supply a Process Name and a Note that indicates the
purpose of the process (for example, "This box contacts one individual per
household"). You can also modify the Output Cell names or Cell Codes.

10. Click OK. The process is configured and is enabled in the flowchart. You can
test run the process to verify that it returns the results you expect.

Example: Audience process
The following figure shows a configured Audience process.

v The selected input audience level is Customer; it is the default audience level of
the DEMO_ACCOUNT table (this audience level is displayed to the right of the Input
field).
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v The output audience level is the same: Customer as defined in the DEMO_ACCOUNT
table. The DEMO_ACCOUNT table has two other audience levels defined: Branch and
HouseHold .

v The process is configured to choose one Customer Entry per HouseHold based
on the maximum of the field HIGHEST_ACC_IND.

Example: Filtering records
When you configure an Audience process to select IDs based on a count, or a
statistical function ( MaxOf , MedianOf , MinOf ) or Any One , the Filter button
becomes available. When you click Filter , the Specify Selection Criteria window
appears, which allows you to enter a query expression to specify which records
will be used in the Based On calculation.

Note: The filtering criteria is applied before the Based On calculation is
performed, allowing you to remove records from consideration.

For example, you might want to constrain the date range over which an operation
is performed. To use only purchase transactions over the last year, you can enter a
filter query expression such as:
CURRENT_JULIAN() - DATE(PURCH_DATE) <= 365

Then, if you are computing a Based On calculation that chooses the sum of the
Amount field, only the amounts from transactions within the last year are summed
together.

Using the same input and output audience levels
When the same audience level is selected in the Choose Audience list and the
Input list, you can use the Select options to perform the following operations:
v “To select one <Input/Output Audience> entry per <Different Audience>” on

page 64
v “To select some <Audience> records per <Different Audience>” on page 65
v “To select entries for each entry at that audience level” on page 65

The Select options vary depending on the relationship of the selected input and
output audience levels. Options that are not meaningful are disabled.

Note: Campaign includes the name of the selected audience level in the Select
option labels. For example, if the input audience level is Customer, the One Entry
per option appears as One Customer Entry per. In the following sections, this
dynamically changing portion of the option text is indicated with <Input/Output
Audience> where appropriate.

The Select options include:

Table 12. The Select options for Audience process configuration

Method Description Example

One Per One member of the input/output
audience level, scoped by another
audience level

One customer per household

Some Per Some members of the input/output
audience level, scoped by another
audience level

All customers with above
average purchases within the
household
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Table 12. The Select options for Audience process configuration (continued)

Method Description Example

For Each Select members if the number of
members at the selected audience level
satisfies some condition

Number of accounts > 1, or
number of purchases > 3

To select one <Input/Output Audience> entry per <Different
Audience>

Choose this option if the input and output audience levels are the same, but a
different audience level is used to scope the output. For example, you can select
the one customer within each household who has the oldest account. (Input
audience level is customer, output audience level is customer, scoping by
Household level, using MinOf(BaseInfo.AcctStartDt) to select.)

Specify a business rule to indicate how the single entity is selected (for example,
the minimum, maximum, or median of some field), or else choose Any One (in
this case, no field choices are available).
1. Select an input source for Input and the same audience level for the output

audience in the Audience process.
The relevant Select options become available.

2. Select the One Entry per option.
A drop-down list appears next to the selected option.

3. Select an audience level from the drop-down list.
All alternate defined audience levels (other than the input audience) appear in
the list.

4. Choose a value to use from the Based On drop-down list:
v Any One eliminates the need to pick a Based On value
v MaxOf returns the maximum value of the selected field
v MedianOf returns the median value of the selected field
v MinOf returns the minimum value of the selected field
Each of these functions will return exactly one member from the input audience
level. If more than one entry is tied at the maximum, minimum, or median
value, the first encountered entry is returned.

5. If you selected a Based On criterion other than Any One, select a field on
which the function operates. This drop-down list includes all the fields from
the table selected in the Choose Audience field, and any mapped dimension
tables. Expand a table by clicking the “ + ” sign. Created derived fields are
listed at the bottom.
For example, to select the account holder from each household with the highest
account balance, you would select “MaxOf” for the Based On criteria and
Acct_Balance from the list of table fields.
You can also create or select derived fields by clicking Derived Fields.

6. (Optional) If you selected a count to be based on, the Filter button becomes
available.
Use the Filter function to reduce the number the IDs that will be available to
the Based On calculation. For example, you might want to select customers
based on their average account balance in the last 6 months, but prior to doing
that, you would want to filter out all customers whose accounts are inactive.
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To filter records before performing the Based On computation, click Filter . The
Specify Selection Criteria window appears. You can enter a query expression to
specify which records will be used in the Based On calculation. The filtering
criteria is applied before performing the Based On calculation, thereby
allowing you to remove records from consideration.

7. Click OK to save your query and close the Specify Selection Criteria window.
8. Continue configuring the process by completing the fields on the remaining

tabs.

To select some <Audience> records per <Different Audience>

This selection indicates that there are multiple entries per audience. In this
situation, the input and output audience levels are the same, but a different
audience level is used to scope the output. You might select this option, for
example, to select all customers within each household who have made purchases
over $100 (Input audience level is customer, output audience level is customer,
scoping by Household level, using Maximum Purchase Value>$100.

In addition to creating a query, the Based On criterion also supports keywords
allowing the functional equivalent of a GROUPBY macro function to be performed.
1. Select an input source for Input and the same audience level for the output

audience in the Audience process. The relevant Select options become available.
2. Select the Some Entries per... option. A drop-down list appears next to the

selected option.
3. Select an audience level from the drop-down list. All alternate defined audience

levels (other than the input audience) appear in the list.
4. Click in the Based On field to enter a query. The Specify Selection Criteria

window opens.
5. Enter or build a valid query expression, then click OK to save it and close the

Specify Selection Criteria window.
6. Continue configuring the process by completing the fields on the remaining

tabs.

To select entries for each entry at that audience level

This selection indicates that there are multiple selections from multiple audience
levels. Select this option if the number of members at the selected audience levels
satisfies some condition (for example, Number of Accounts > 1 or Number of
Purchases > 3 ).

Note: This option is available only if the input audience level is not normalized
(that is, the record ID is not unique in the selected Choose Level table), and the
input and output levels are the same. It is the only option available if no alternate
keys have been defined for your output audience table.
1. Select an input source for Inputand the same audience level for the output

audience in the Audience process.
The relevant Select options become available.

2. Select the For Each option.

Note: This option is available only if the input audience level is not
normalized (that is, the record ID is not unique in the selected Choose Level
table).
A drop-down list appears next to the selected option.
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3. Choose a Based On selection.
If the table you select under Choose Audience (that is, the output audience) is
not normalized, there might be duplication in your results. You can use a Based
On method for Campaign to use when selecting records, to avoid duplication.
(For example, if your results might include more than one individual in the
same household, you can use Based On to select only one individual from that
household, based on the criterion you configure in this feature.)
You must select one of the Based On methods, either Count or Condition:
v Specify a Count to use in Based On:
This option lets you select the <Input Audience Level> ID, where the number
of occurrences of the <Input Audience Level> ID satisfies the specified
condition.
To toggle between different relationships (<,<=,>,>=,=), click the operator
button repeatedly until the desired relation is displayed.
-- OR --
v Specify a Condition to use in Based On:
Click in the text box to the right of Condition.
The Specify Selection Criteria window appears.
Enter or build a valid query expression, then click OK to save your entry and
close the Specify Selection Criteria window.

4. (Optional) If you selected a count to be based on, Filter becomes available.
Use the Filter function to reduce the number the IDs that will be available to
the Based On calculation. For example, you might want to select customer IDs
based on their average account balance in the last six months, but before doing
that, you would want to filter out all customers whose accounts are inactive.
To filter records before performing the Based On computation, click Filter. The
Specify Selection Criteria window appears. You can enter a query expression to
specify which records will be used in the Based On calculation. The filtering
criteria is applied before performing the Based On calculation, allowing you to
remove records from consideration.

5. Click OK to save your query and close the Specify Selection Criteria window.
6. Continue configuring the process by completing the fields on the remaining

tabs.

Using different input and output audience levels
If you selected different input and output audiences for the Choose Audience list
and the Input list, you can use the Select options to perform the following
operations:
v “To select all <Output Audience Level> entries” on page 67
v “To select some <Different Output Audience Level> entries” on page 67
v “To select one <Output Audience> per <Different Input Audience>” on page 67

Note: Campaign includes the name of the selected audience level in the Select
option labels. For example, if the input audience level is Customer, the One Entry
per option appears as One Customer Entry per. In the following sections, this
dynamically changing portion of the option text is indicated with <Input/Output
Audience> where appropriate.

The Select options include:
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Table 13. The Select options for Audience process configuration (different input and output)

Method Description Example

All Select all members of the input audience
level, scoped by another audience level

All customers per
household

Some Select some members of the output
audience level, keeping only those IDs that
satisfy a specified condition

All customers aged 18 or
over within a household

One Per Select exactly one output audience record
for each input audience record

One customer per
household

To select all <Output Audience Level> entries

Select this option to switch to the output audience level without performing any
filtering (for example, to select all customers in a household or all accounts
belonging to a customer). This creates an output cell with all output audience level
entries associated with the input IDs. It switches audience levels without applying
any selection or filtering criteria.

If you change from a primary audience level to another audience level, you will no
longer be able to use derived fields in the following processes.
1. Select an input source for Input and a different output audience for Choose

Audience.
The Select options become available.

2. Select All <Output Audience Level> Entries.
3. Click OK to close the Audience process configuration dialog and save the

configuration.

To select some <Different Output Audience Level> entries

Select this option to switch from the input audience level to a different output
audience level, keeping only those IDs that satisfy a specified condition. For
example, you could select all customers aged 18 or over within a household, or
select all accounts of a customer with positive balances.

The Based On criteria allows you to enter a query expression to limit the output
audience level entries selected.
1. Select an input source for Input and a different output audience for Choose

Audience.
The Select options become available.

2. Click to select Some <Output Audience Level> Entries.
The Based On field becomes available.

3. Click in the Based On field to enter a query.
The Specify Selection Criteria window appears.

4. Enter or build a valid query expression, then click OK to save the query and
close the Specify Selection Criteria window.

5. Click OK to close the Audience process configuration dialog, saving your
entries.

To select one <Output Audience> per <Different Input Audience>

Select this option to choose exactly one output audience record for each input
audience record (for example, to choose one email address per customer). You
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must specify a business rule to indicate how the single entity should be selected
(min/max/median of some field) or choose Any One (in this case, no field choices
are available).

This option is available only if the input audience level is not normalized (that is,
the record ID is not unique in the selected Choose Level table).

In addition to creating a query, the Based Oncriterion also supports keywords
allowing the functional equivalent of a GROUPBY macro function to be performed.
1. Select an input source for Input and an output audience for the Audience

process.
The Select options become available.

2. Select One <Output Audience Level> per <Input Audience Level>.
3. Select a value from the Based On drop-down list.

(Field selection, using the drop-down list to the right, becomes inactive when
you select Any One. If this is your selection, skip to step 5.)

4. Select a field in the next drop-down list to which the Based On function
relates:
a. Click in the Based On text box.

The Select Field window appears. All fields from the table selected in the
Choose Audience drop-down list appear, including any mapped dimension
tables.
You can expand a table by clicking the “+” sign. Created derived fields are
listed at the bottom.

b. Select a field and click OK.
c. (Optional) Create derived fields by clicking Derived Fields.

5. (Optional) To filter records before performing the Based On computation, use
Filter.

6. Click OK to close the Audience process configuration dialog, saving your
entries.

Extract
The Extract process allows you to select fields from one table and write them out
to another table for subsequent processing. It is designed to pare down a large
amount of data to a manageable size for subsequent operations, resulting in vast
improvements in performance.

The Extract process can take input from a cell (if it is connected to a Select process,
for example), single table, strategic segment, optimized list (Optimize only), or
eMessage landing page (eMessage only). If you select a strategic segment as input,
you must join it to a table before you can extract fields.

If you use several Extract processes in a series, only the fields in the final Extract
process are written out.

If you use several Extract processes in parallel (that is, in different branches in the
same flowchart), they behave in the same way as persistent derived fields:
v The extracted fields attach to the inbound cell
v The extracted fields are calculated before query execution in that process
v Multiple extracted fields are available in subsequent processes
v When extracted fields are sent to a contact process:
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– If an extracted field is not defined for a cell, its value = NULL
– If a single ID is in more than one cell, one row is output for each cell

v When extracted fields are sent to a Segment or Decision process, an extracted
field must exist in all selected input cells for it to be used in segmenting by
query.

Extracted tables

Data is extracted as either a binary file on the Campaign server or as a table in a
data mart with a UAC_EX prefix.

Unlike a temp table, an extracted table is not deleted at the end of a flowchart run.
It needs to persist so that users can continue to access it in order to perform
operations on it, like profiling its fields, for example.

An extracted table is only deleted when you delete its associated Extract process,
flowchart, campaign, or session.

Note: In order to conserve space in the data mart, your system administrator can
periodically delete tables with a UAC_EX prefix. Note, however, that if these tables
are removed, before rerunning their flowcharts or attempting to profile fields in the
now-missing tables, users must first rerun their affected Extract processes.
Otherwise, Campaign generates "Table Not Found" errors.

Example: Extracting transaction data
Assume that you have designed a campaign to perform selections or calculations
based on the last three months of purchase transactions for all non-delinquent
customers (approximately 90% of your customer base), resulting in 4 Gb of data.

Even if Campaign created a temporary table for these customers, joining it back to
the purchase transaction table would entail pulling over approximately 90% of the
4 Gb rows (and discarding all transactions except for the last three months) to
execute a GROUPBY macro, for example.

Instead, you can configure an Extract process (placed at the purchase transaction
level) to pull out all transactions within the last three months, put them into a
table in the database, and then subsequently run multiple GROUPBY macros and
other calculations against it (for example, min/max and average).

Prerequisites for extracting data from eMessage landing
pages

The following prerequisites must be met before you can configure an Extract
process to accept input from eMessage landing pages:
v eMessage must be installed, running, and enabled.
v eMessage landing pages must be appropriately configured.
v The mailing must be executed and responses from mailing recipients must be

received.

For more information about eMessage landing pages, see the eMessage User's Guide.

Configuring an Extract process
The procedure for configuring the Extract process differs depending upon which of
the following input sources you choose:
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v “To extract data from a cell, single table, or strategic segment”
v “To extract data from an eMessage landing page” on page 71
v Optimized list (see the Optimize User's Guide)

To extract data from a cell, single table, or strategic segment
1. Within a campaign, open a flowchart for editing.
2. Double-click the Extract process in the flowchart workspace.
3. Click the Extract process in the palette, then click the workspace to add the

process to your flowchart.
The process configuration dialog appears.

4. On the Source tab, select an input cell, a single table, or a strategic segment
from the Input list. If you select a strategic segment, associate it with a table
by selecting a table from the Select Based On list.

5. Specify the records to use as input:
v Select All Records to include all records in your input data source.
v Select Records With to select records based on criteria you define using

queries.
6. If you chose Select Records With, create a query using one of the following

methods:
v Point & Click: Click in the Field Name, Oper., Value, and And/Or column

cells to select values to build your query. This method provides the easiest
way to create a query and helps to avoid syntax errors.

v Text Builder: Use this tool to write raw SQL or use the provided macros.
You can use the Query Helper within Text Builder to select IBM Unica
macros, including logical operators and string functions.

You can select fields from the Available Fields list, including IBM Unica
Campaign Generated Fields and Derived Fields. For more information,
see“Creating queries in processes” on page 95.

Note: If your query includes a table field that has the same name as a
Campaign Generated Field, you must qualify the field name using the
following syntax: <table_name>.<field_name>.

7. On the Extract tab, use the Target Data Source field to select an output
location:
v To store the data in binary format, select IBM Unica Campaign Server.
v To store the data in a uniquely named table with a UAC_EX prefix, select an

available database.
8. Select fields from the list of Candidate Fields, and add them to the Fields to

Extract list. Use the controls to remove or reorder fields. For information
about the fields on the Extract tab, see “Extract tab reference” on page 72.

9. Perform any of the following optional tasks:
v Click Profile to preview a list of values for the selected field. See“Profiling

fields” on page 102.
v Click Derived Fields to create a variable in the list of candidate fields.

See“About derived fields” on page 171
v Click More to exclude duplicate IDs from the output. See“Skipping

duplicate IDs in process output” on page 110.
10. Optionally, use the Cell Size Limit tab to limit the number of IDs generated

by the process. See “Limiting the size of output cells” on page 135.
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11. Optionally, use the Dimension tab to add existing dimension tables to the
extract table and specify the key fields to join on. The extract table becomes a
base table for the selected dimension tables and can be used in downstream
processes.

12. Click the General tab to modify the Process Name, Output Cell names, or
Cell Codes, link to a target cell, or enter a Note about the process.
For information about linking to target cells, see “To link flowchart cells to
target cells using the process configuration dialog” on page 143.

13. Click OK.

You can test run the process to verify that it returns the results you expect.

To extract data from an eMessage landing page

Ensure that your IBM Unica environment meets the requirements before
attempting to extract eMessage landing page data. For more information, see
“Prerequisites for extracting data from eMessage landing pages” on page 69.
1. In a flowchart in Edit mode, double-click the Extract process in the flowchart

workspace.
The process configuration dialog appears.

2. On the Source tab, select eMessage Landing Pages.
3. In the popup window, select an eMessage landing page as input.

Note: You can select only one eMessage landing page as input to an Extract
process. To extract data from more than one landing page, configure multiple
Extract processes.

4. If there is more than one audience level available for the landing page, select
the appropriate audience level from the drop-down list. If there is only one
audience level available, it is automatically selected.

5. Click OK.
6. On the Extract tab, select an output location.

v To store the data in binary format, select IBM Unica Campaign Server.
v To store the data in a uniquely named table with a UAC_EX prefix, select an

available database.
7. Select fields to extract from the list of Candidate Fields.

v Click Add to add selected fields to the list of Fields to Extract.
v To remove fields from the list of Fields to Extract, select them and click

Remove.
v Use the Up 1 and Down 1 buttons to change the order of fields in the Fields

to Extract list.
v To change the default output name of a field to extract, select the field in the

Fields to Extract list, click the name in the Output Name column, then enter
the new name.

For information about the fields on the Extract tab, see “Extract tab reference”
on page 72.

8. Perform any of the following optional tasks:
v Add a derived field to the list of candidate fields. See “About derived fields”

on page 171
v Specify that duplicate IDs are excluded from the output. See “Skipping

duplicate IDs in process output” on page 110.
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v Limit the size of the output cell (that is, limit the number of IDs generated
by the process). See “Limiting the size of output cells” on page 135.

v Click the General tab to modify the Process Name, Output Cell names, or
Cell Codes, link to a target cell, or enter a Note about the process.
For information about linking to target cells, see “To link flowchart cells to
target cells using the process configuration dialog” on page 143.

Note: Profiling is not available for eMessage landing page attributes.
9. Click OK.

The process is configured. You can test the process to verify that it returns the
results you expect.

Note: During the extraction process, Campaign creates an intermediate view in the
system tables database with a UCC_LPV prefix. This internal view remains in the
database until the process box is deleted. If you remove the view, you must
reconfigure its corresponding Extract process before rerunning the process or
flowchart; otherwise, Campaign generates a missing table error.

Extract tab reference

The following table describes the fields on the Extract tab:

Table 14. Fields on the Extract tab

Field Description

Target Data Source Location to which the output from this process will be
written. The Campaign Server and any other data sources
to which you are connected are available from the Target
Data Source drop-down list.

Candidate Fields List of fields available to extract, including field name and
data type, based on your input data source.

If your input source is a landing page in eMessage, each
field name is an attribute of the landing page. If the
attribute contains special characters or spaces, it is
converted to a valid field name. Data types of all landing
page attributes are listed as text.
Note: Schema object names are limited to 30 characters.
Restrict your attribute names to 30 characters or less to
produce valid column names for extracted output.

Fields to Extract Fields you chose to extract from the Candidate Fields list.
The Output Name defaults to the field name in the Fields
to Extract column.

Profile button Opens the Profile Selected Field window, which calculates
the values and distributions of records in the selected field.
Active only when a field name is selected in the Candidate
Fields list.

Derived Fields button Opens the Create Derived Field window.

More button Opens the Advanced Settings window, which includes the
option to skip duplicate records and to specify how
Campaign identifies duplicates.
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Snapshot
Use the Snapshot process to capture a list of IDs and associated data, and export
them to a table or a file.

To associate or track offers with the list, use a Mail List or Call List process. To
make sure that duplicate rows are not exported, use an Extract process, then
snapshot the results.

To configure a Snapshot process
1. In a flowchart in Edit mode, ensure that your Snapshot process is connected to

one or more configured processes whose output cells will be used as input by
the Snapshot process.

Note: All the cells that you select as input cells must have the same audience
level.

2. Double-click the Snapshot process in the flowchart workspace.
The process configuration dialog appears.

3. Click the Snapshot tab.
a. From the Input drop-down list, specify the input cells to use as the data

source for the snapshot.

Note: If the Snapshot process is not connected to a process that provides
output cells, there will be no cells to select from in the Input drop-down
list. The Multiple Cells option in the drop-down list is only available if the
input process generates multiple cells.

b. From the Export To drop-down list, specify a table or file to which the
Snapshot output will be written.

Note: You can test the Snapshot process by running the process with output
exported to a temporary file that you can review.
v If the table that you want to use does not appear in the list, or if you

want to output to an unmapped table, select Database Table. You see the
Specify Database table window, where you specify the table and database
names. User variables are supported in the table name you specify here.

v If you select File from the Export To drop-down list, you see the Specify
Output File window, where you specify the type of file you want to write
the output to, its file name, and corresponding data dictionary.

v If you want to create a new user table, select New Mapped Table from
the Export To drop-down list. For instructions, see the Campaign
Administrator's Guide.

c. Select an option to specify how updates to the output file or table are
handled:
v Append to Existing Data. Append the new information to the end of the

table or file. If you select this option for a delimited file, labels will not be
exported as the first row. This is a best practice for database tables.

v Replace All Records. Remove any existing data from the table or file, and
replace it with the new information.

v Update Records. Available only if you are exporting to a table. All fields
specified for snapshot are updated with the values from the current run
of the process.
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v Create New File. Available only if you are exporting to a file. This option
is selected by default if you are exporting to a file. Each time you run the
process, a new file is created with "_1," "_2" and so on, appended to the
file name.

4. Specify the fields that are written out by the Snapshot process.
a. Select the fields that you want to include in your output from the

Candidate Fields list.
You can use Campaign Generated Fields by expanding the list of Campaign
Generated Fields, or use derived fields by clicking the Derived Fields
button. Select multiple fields at one time using Ctrl+Click or a contiguous
range of fields using Shift+Click.

b. Move selected fields to the Fields to Snapshot list by clicking Add>>.
c. Remove fields from the Fields to Snapshot list by selecting them and

clicking <<Remove.
d. If you selected a table as the snapshot destination, the fields in that table

appear in the Export Fields list under the Table Field column. You can
automatically find matching fields by clicking Match>>. Fields with exact
matches for the table field names are automatically added to the Export
Fields list. If there are multiple matching fields, the first match is taken. You
can manually modify the pairings by clicking <<Remove or Add>>.

e. If desired, reorder the fields in the Fields to Snapshot list by selecting a
field and clicking Up1 or Down1 to move it up or down in the list.

Note: To view the values in a field, select the field and click Profile.
5. To specify that records with duplicate IDs are skipped, or specify the order in

which records are output, click More.
You see the Advanced Settings window.
a. To specify that any records with duplicate IDs are skipped, select the Skip

Records with Duplicate IDs check box, and choose the criteria that
Campaign will use to decide which record to retain if duplicate IDs are
returned. For example, you can select MaxOf and Household_Income to
specify that when duplicate IDs are returned, Campaign exports only the ID
with the highest household income.

Note: This option only removes duplicates within the same input cell. Your
snapshot data can still contain duplicate IDs if the same ID appears in
multiple input cells. If you want to remove all duplicate IDs, you must use
a Merge or Segment process upstream of the Snapshot process to purge
duplicate IDs or create mutually exclusive segments.

b. To specify that the snapshot output is ordered in some way, select the Order
By check box, the field to sort by, and the sort order. For example, you can
select Last_Name and Ascending to specify that the list of IDs is sorted by
family name in ascending order.

6. Click OK to close the Advanced Settings window.
The duplicate ID skipping and sort order that you have specified is displayed
below the Fields to Snapshot list on the Snapshot tab.

7. (Optional) Click the General tab to assign a name and/or notes to the process.
The name appears on the process in the flowchart. The notes appear when you
point to the process in the flowchart.

8. Click OK.
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The process is configured and appears enabled in the flowchart. You can test the
process to verify that it returns the results you expect.

Schedule

Note: The Schedule process is not related to the Unica Scheduler. The Scheduler
starts a flowchart even if it is not running, while the Schedule process in a
flowchart works only if the flowchart is running. You should not use the Scheduler
to schedule a flowchart that uses the Schedule process.

Use the Schedule process to initiate a process, series of processes, or an entire
flowchart. A Schedule process is active for a defined period of time. During that
time, specified events might occur that cause subsequent connected processes to
begin execution. The most common use of the Schedule process is to control timing
of the entire flowchart.

You can configure a Schedule process to define the total scheduling period by
setting up a time limit in days, hours, and minutes starting from when the process
begins executing.

Scheduling options are both fine-grained and flexible:
v You can schedule a process to run in a wide variety of ways, including

repetitively, by trigger, by calendar, and so on.
v You can combine multiple scheduling options, such as scheduling the process to

run every Monday at 9:00 a.m., but also to run whenever it is triggered by a
specific event (such as a hit on the website).

v You can schedule a batch process, for example, to run late at night when it will
not cause interfere with daytime jobs.

There are no predetermined limits on the number of options you can use
simultaneously in scheduling a flowchart, providing that the selections do not
actively conflict. (For example, you cannot schedule a flowchart to run both "Once
Only" and "Every Monday.")

In general, a process runs only when all of its inputs have run successfully (that is,
when all processes connected to the current process have run, even if the
dependency is only temporal). However, when multiple schedule inputs exist
within a branch, the process will run whenever any one of its inputs completes (an
"or" rather than an "and" of its inputs).

A contact process with tracking enabled contains an inherent schedule. Using a
Schedule process in the middle of a flowchart is an advanced feature. Make sure
you are getting the desired behavior and correct results.

Note: If the Schedule process in your flowchart tells the flowchart to run before a
previous run is complete, Campaign holds the request until the previous run is
finished. Only one run can be held in this manner. In certain cases, this might
mean that the flowchart does not run as many times as you expect.

For example, if your flowchart takes two hours to run, and you have a Schedule
process that tries to trigger three runs that are only 10 minutes apart, Campaign
will start the first run. When the Schedule process attempts to start the second run,
Campaign will queue it. When the Schedule process attempts to start the third run,
Campaign will ignore it. When the first run is finished, Campaign will start the
second run. The third run will never start.
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To configure a Schedule process
1. In a flowchart in Edit mode, double-click the Schedule process in the flowchart

workspace.
The process configuration dialog appears.

2. On the Schedule tab, specify the scheduling conditions:
a. Specify a value for Total Schedule Period by entering the appropriate

values in the Days, Hours, and Minutes fields. The total schedule period is
the total time over which the Schedule process is to be active. By default,
the total schedule period is set to 30 days.

b. Select a run frequency from the Schedule to Run drop-down list, to specify
exactly when the Schedule process will activate subsequent connected
processes.
v If you select the Once Only option, the flowchart will run exactly once,

regardless of what other schedule options have been added. If any other
value is selected, then the scheduling options are connected as OR
statements and the Schedule process kicks off any process to which it is
connected when any option is satisfied.

v The first option that is satisfied will begin the Schedule run. If Schedule
To Run is the only option enabled and the setting is Once Only, the
process runs immediately (unless a delay or user authorization has been
enabled).

v The Hours and Minutes fields enable you to specify the time at which
you want the schedule to run. The time entry form is based on a 24 hour
clock (also referred to as "military time"). In other words, 9 hours 30
minutes is 9:30 a.m., and 22 hours 45 minutes is 10:45 p.m. Because the
time base is 24 hours, there is no need to designate a.m. or p.m.

3. If you select Custom Run from the Schedule to Run drop-down list, the
Custom Run options become enabled. Specify whether the schedule runs at a
particular time or times, or based on inbound triggers, by selecting the Run On
Time check box and/or the Run On Trigger(s) check box. For more details
about triggers, see the Campaign Administrator's Guide.

Note: These choices are not mutually exclusive: you can choose to use triggers
in conjunction with scheduled times.
v If you choose Run On Time, you must specify one or more dates and times.

Multiple entries must be separated by commas. Click Calendar to access the
Calendar feature for choosing dates and times.

v If you choose Run On Trigger(s) you must specify one or more triggers.
The named trigger(s) must be defined using Tools > Stored Triggers for the
Schedule process to be fully configured. Enter the name of each trigger that
can activate this Schedule process. Separate multiple triggers with commas.
The trigger name can contain any characters except commas. A trigger name
does not have to be unique. You can use the same trigger in multiple
campaigns or flowcharts and activate them all at the same time.

4. Specify any Delay and Authorization settings by selecting the Wait for User
Authorization Before Each Run check box and/or the Delay Period Before
Each Run check box.

Note: These choices are not mutually exclusive: you can choose either or both.
v If you choose Wait for User Authorization Before Each Run, a prompt for

user authorization will appear each time any other schedule conditions are
satisfied, and the Schedule process will not activate unless specific
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authorization is provided. If you specify this option, it takes precedence over
any other schedule indicators; the process will not start unless authorization
is given.

Note: When a flowchart is running with a client attached, user authorization
can only occur through the client. If no client is attached, any user with
read/write privileges for the campaign can authorize it to continue.

v If you choose Delay Period Before Each Run, you must specify the amount
of time to wait after a schedule condition has been satisfied before the
process runs, using the Days, Hours, and Minutes fields. This delay applies
to all other specified schedule options. For example, if a Schedule process is
configured to run at 9:00 a.m. on Monday morning with a delay of one hour,
subsequent processes will begin to run at 10:00 a.m.

5. (Optional) Specify triggers to send after the Schedule run is completed by
selecting the Send Trigger(s) After Each Run check box and specifying one or
more triggers.
If you select the Send Trigger(s) After Each Run check box, Campaign runs
one or more triggers each time the Schedule process is activated. An outbound
trigger executes a command line, which can be a batch file or a script file. The
named trigger(s) must be defined using Tools > Stored Triggers. If you specify
multiple trigger names, they must be separated by commas.

6. (Optional) Click the General tab to assign a name and/or notes to the process.
The name appears on the process in the flowchart. The notes appear when you
point to the process in the flowchart.

7. Click OK.

The process is configured and appears enabled in the flowchart. You can test the
process to verify that it returns the results you expect.

To use the Calendar tool in the Schedule process

The Calendar tool is available from the Schedule process configuration dialog if
you select Custom Run from the Schedule to Run drop-down list.

It is the same as the Calendar tool elsewhere in Campaign except that it allows
you to select the time as well as the date.
1. On the Schedule tab of the Schedule process configuration dialog, click

Calendar. This button is only enabled if you have selected Custom Run from
the Schedule to Run drop-down list.
The Calendar tool appears. The current date and time are already selected by
default.

2. Specify the date you want the flowchart to run or start:
v Click the date on the displayed month, or
v Change the month, year, and time using the Month drop-down list
v Change the year using the up and down arrows.

3. Specify the time by entering the desired time in the Run Time field, using the
format hh:mm, followed by an a.m. or p.m. designation.

4. Click Apply to enter the specified date and time, leaving the Calendar window
open, or click OK to enter the specified date and time and close the Calendar
window.
Leaving the Calendar window open allows you to easily enter multiple date
and time selections.
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Scheduling based on triggers
The Schedule process can work with triggers in the following ways:
v “Running on triggers”
v “Sending triggers after each run”
v “Using triggers with other scheduling options” on page 79

To configure a Schedule process to run on a trigger
1. On the Schedule tab of the Schedule process configuration dialog, select

Custom Run from the Schedule to Run drop-down list.
The Custom Run features become enabled.

2. In the Run On Trigger(s) field, enter the name of each trigger that can activate
this Schedule process. Separate multiple triggers with commas.
v The trigger name can contain any characters except commas.
v A trigger name does not have to be unique. You can use the same trigger in

multiple campaigns or flowcharts and activate them all at the same time.

Running on triggers
When you select Custom Run from the Schedule to Run drop-down list, the Run
On Trigger(s) option is available. Enable this option to specify one or more
inbound triggers that activate the Schedule process.

If you enable Run on Trigger(s), you must specify one or more triggers. The
named trigger(s) must be defined using Tools > Stored Triggers for the Schedule
process to be fully configured.

An inbound trigger is an external event that will automatically set a flowchart or a
campaign in motion. A trigger can be anything that you define; for example,
clicking a website link, receiving an email message, a telemarketer’s response
indicator, completion of a database upload, or any other defined event.

The Run On Trigger(s) option uses the IBM Unica application
unica_actrg(included with your Campaign installation) to run. To understand how
Run On Trigger works behind the scenes, it is helpful to look at an example.

Example: Run on Trigger
An online retailer has a cross-sell campaign that runs on a trigger, so that when a
customer makes a purchase, it triggers cross-sell offers.

Specifically, when the customer makes a purchase:
v The website runs the unica_actrg executable, passing the campaign code and the

trigger name (web_purchase).
v The Campaign listener checks that the campaign is active and the trigger name

exists, then runs the Schedule process, and the campaign flowchart is triggered.
For more details about triggers, see the Campaign Administrator's Guide.

Sending triggers after each run
An outbound trigger executes a command line, which can be a batch file or a
script file. You can have Campaign run one or more triggers each time the
Schedule process activates the trigger names in the Send Trigger(s) After Each
Run field. If you specify multiple trigger names, they must be separated by
commas.
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This function allows you to send an outbound trigger to an executable file. The full
path and the name of the file must be defined in the Stored Trigger Definitions
window. Each time the Schedule process is activated, Campaign runs the specified
executable file.

Using triggers with other scheduling options
Triggers can be used with any other scheduling options or alone. Used in
combination, you can, for example, set up a flowchart to run every Monday at 9:00
a.m. as well as every time someone clicks on an internet banner advertisement.

If, for example, you have scheduled the flowchart to Run On Trigger(s) based on
hits on a website, and you also specify a Delay Period Before Each Run, the
flowchart will not begin until both the event (the Web "hit") occurs and the delay
period has expired.

Cube
The Cube process supports the creation of data cubes from dimensions based on
strategic segments that have been created from customer database tables.

Note: The Cube process is intended to be used by technical users or IBM Unica
consultants. A best practice is to create all global constructs (cubes and strategic
segments, for example) in the Sessions area of the application.

Users can select one or more defined segments, create a cube, and then drill into
the data to select a target audience which can then be converted into the
appropriate processes (the Select process, for example) for inclusion in a flowchart.

To configure a Cube process

Any cubes created in the Sessions area will be available globally.
1. Before you can create a cube using a Cube process, you must create a strategic

segment or dimension hierarchy.
2. In a session flowchart, select a Cube process and drag it onto the workspace.
3. Double-click the Cube process in the flowchart workspace.

You see the process configuration dialog.
4. On the Source tab, use the Input Segments drop-down list to select one or

more segments as input for the cube.

Important: If you are selecting more than one source segment, ensure that they
all have the same audience level.

5. Click the Cube Definitions tab to define your cube. The Cube Definitions
window appears.
From the Cube Definitions window you can:
v Click Add to add a new cube
v Select an existing cube and click Edit to modify it
v Select an existing cube and click Remove to delete it

6. To add a cube:
a. Click Add. The Edit Cube window appears.
b. Enter a name and a description of the cube in the appropriate areas.
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c. Select up to three dimensions from the corresponding drop-down lists. The
dimensions must be related to the strategic segments that the cube source is
based on.

d. Click OK when you have finished entering information for the cube. The
Edit Cube window closes and the new cube definition is displayed in the
list of cubes on the Cube Definitions tab.

7. Click the Select Additional Fields to Track tab to specify additional fields for
tracking.
The Select Additional Fields window appears.
From the Select Additional Fields window you can:
v Select and move the fields you want to track from the Available Fields list to

the Selected Fields list, using the Add>> button
v Click Derived Fields to select or create derived fields to track.
v Click Profile to profile a selected field.

8. (Optional) Click the General tab to assign a name and/or notes to the process.
The name appears on the process in the flowchart. The notes appear when you
mouse over the process in the flowchart.

9. Click OK.
The process is configured and appears enabled in the flowchart. You can test
the process to verify that it returns the results you expect.

Create Seg
Use the Create Seg process to create lists of audience IDs from customer database
tables. The segments can then be used as input for Select processes and to create
dimensions and cubes, or as the global suppression segment for an audience level.

The Create Seg process is designed to be used by Campaign administrators. The
Create Seg process should be created in the Sessions area of Campaign so that the
segments are strategic and are available globally for use in all campaigns.

Note: A best practice is to create all global constructs in the Sessions area of
Campaign, for use in multiple campaigns. However, it is possible to use Create Seg
within a campaign rather than in a session flowchart.

To work with strategic segments, you do the following:
v Create a segment in the Sessions area.
v Manage segments from the Segments area.
v Use these segments in campaigns from the Campaign section.

To configure a Create Seg process

Note: The Create Seg process is designed to be used by Campaign administrators,
and should be created and defined in the Sessions area of the application, so that
the segments are strategic and are available globally for use in all campaigns.
1. In a session flowchart in Edit mode, add a Create Seg process to the flowchart

workspace.
2. Provide input to the Create Seg process by connecting it to one or more data

manipulation processes (for example, a Select process).
3. Double-click the Create Seg process.

The process configuration dialog appears.
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4. On the Define Segments tab, do the following:
a. Select one or more source cells from the Input drop-down list. These source

cells will be turned into segments.
b. Select Create Mutually Exclusive Segments if you want the created

segments to be mutually exclusive.
c. In the Result Segments area, highlight an input cell and click Edit to

configure the segment.
The Edit Segment window appears.

5. From the Edit Segment window, do the following:
a. Give the segment a name that describes its purpose, and a brief description

of what the segment is designed to do.
b. From the Under Folders drop-down list, select a folder where the segment

will be stored.
c. From the Temp Table Data Source drop-down list, select a data source in

which to cache the strategic segment.

Note: Selecting a data source is required only if the
doNotCreateServerBinFile property on the Campaign|Server|Optimization
Configuration page is set to TRUE. If this property is not set to True, at least
one data source must be selected.

d. From the Security Policy drop-down list, select a security policy, if
applicable, to which the created segment will belong.

e. When you have finished, click OK to return to the Define Segments tab.
6. (Optional) Click the General tab to assign a name and/or notes to the process.

The name appears on the process in the flowchart. The notes appear when you
mouse over the process in the flowchart.

7. Click OK.

The process is configured and appears enabled in the flowchart.

Note: Strategic segments are created and made available for selection only when
the Create Seg process has run successfully in production mode. Running the
Create Seg process in test mode does not create or update strategic segments.

You can test the Create Seg process, but test runs do not create strategic segments
or update existing ones.

Mail List
The Mail List process is one of the contact processes. It uses output cells from
other processes in your flowchart to generate a contact list for a direct mail
campaign, assign specific offers to that contact list, and log the contact history.

To configure a contact process (Mail List or Call List)
1. In a flowchart in Edit mode, ensure that your contact process is connected to

one or more configured processes whose output cells will be used as input by
the contact process.

Important: All the cells that you select as input cells must have the same
audience level.

2. Double-click the contact process in the flowchart workspace.
The process configuration dialog appears.
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3. On the Fulfillment tab, specify the fulfillment details of your list output.
a. From the Input drop-down list, specify the input cells to use as the data

source for the contact list.

Note: If the contact process is not connected to a process that provides
output cells, there will be no cells to select from in the Input drop-down
list. The Multiple Cells option in the drop-down list is only available if
the input process generates multiple cells.

b. (Optional) To specify where to write the contact list output, be sure that
the Enable Export To check box is selected and use the drop-down list to
specify one of the following options:
v If you want to write the process output to a database table, select its

name from the Enable Export To drop-down list.
v If the database table that you want to use does not appear in the list, or

if you want the process output to be written to an unmapped table,
select Database Table from the drop-down list to open the Specify
Database table window. Use this window to specify the table and
database names. User variables are supported in the table name you
specify here.

v If you want to write the process output to a file, select File from the
Enable Export To drop-down list to open the Specify Output File
window. Use this window to specify the type of file you want to write
the output to, its file name, and corresponding data dictionary.

v If you want to create a new user table, select New Mapped Table from
the Enable Export To drop-down list. For instructions, see the Campaign
Administrator's Guide.

Note: You can test the contact process by running the process with output
exported to a temporary file that you can review.
The Enable Export To check box is selected by default. If you clear it, you
can run the process without any output to a file or database table.

c. (Optional) Create a Summary File (.sum) for this process by entering a
path and file name in the Summary File field, or navigate to a location by
clicking the ellipsis button. A summary file contains information about the
export that might be required by a mailing house to facilitate mailings.

d. (Optional) Send a trigger when the process finishes running by selecting
the Send Trigger(s) check box, and choosing the trigger you want to send
from the drop-down list. To send multiple triggers, use Ctrl+Click to select
each trigger you want to add. The selected triggers will appear in the
Send Trigger(s) field, separated by commas.

4. Click the Treatment tab to assign one or more offers or offer lists to each
target cell defined in this process. Click the Parameters tab to specify offer
parameters for each cell.

5. Click the Personalization tab to specify the fields that are written out to your
contact list.
a. Select the fields that you want to include in your output from the

Candidate Fields list.
You can use IBM Unica Campaign Generated Fields by expanding the IBM
Unica Campaign Generated Fields list, or use derived fields by clicking
the Derived Fields button. Select multiple fields at one time using
Ctrl+Click or a contiguous range of fields using Shift+Click.

b. Move selected fields to the Export Fields list by clicking Add>>.
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c. Remove fields from the Export Fields list by selecting them and clicking
<<Remove.

d. If you selected a table as the export destination, the fields in that table
appear in the Export Fields list under the Table Field column. You can
automatically find matching fields by clicking Match>>. Fields with exact
matches for the table field names are automatically added to the Export
Fields list. If there are multiple matching fields, the first match is taken.
You can manually modify the pairings by clicking <<Remove or Add>>.

e. If desired, reorder the fields in the Export Fields list by selecting a field
and clicking Up1 or Down1 to move it up or down in the list.

Note: To view the values in a field, select the field and click Profile.
6. To specify that records with duplicate IDs are skipped, or specify the order in

which records are output, click More.
You see the Advanced Settings window.
a. To specify that any records with duplicate IDs are skipped, select the Skip

Records with Duplicate IDs check box, and choose the criteria that
Campaign will use to decide which record to retain if duplicate IDs are
returned. For example, you can select MaxOf and Household_Income to
specify that when duplicate IDs are returned, Campaign exports only the
ID with the highest household income.

Note: This option only removes duplicates within the same input cell.
Your contact list can still contain duplicate IDs if the same ID appears in
multiple input cells. If you want to remove all duplicate IDs from the
contact list, you must use a Merge or Segment process upstream of the
contact process to purge duplicate IDs or create mutually exclusive
segments.

b. To specify that the output contact list is ordered in some way, select the
Order By check box, the field to sort by, and the sort order. For example,
you can select Last_Name and Ascending to specify that the list of IDs is
sorted by family name in ascending order.

7. Click OK to close the Advanced Settings window.
The duplicate ID skipping and sort order that you have specified is displayed
below the Export Fields list on the Personalization tab.

8. Click the Log tab to specify how you want to log contact transactions from
this process.

Note: You must have the appropriate permissions to enable or disable the
contact history logging options.
a. To log contact history to the system tables, check the Log to Contact

History Tables check box.

Note: To make the contact information available for tracking and reporting
throughout Campaign, log to the system tables. If you are configuring a
mailing list, do not log to system tables if you plan to send your mailing
list to a mailing house that performs processing (such as validating
addresses or householding). Instead, use a Track process to log the
information returned from the mailing house instead to capture only the
list of customers who were mailed an offer.

b. To additionally, or instead, log to another destination than the system
tables, check the Log into Other Destination check box.
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Note: You might want to store the contact information in another table or
file if your organization requires further processing of the information in
another format. You might also want to log the information outside the
system tables if you want to test the information output by the contact
process before saving it to the system tables.

c. If you selected Log into Other Destination, use the Log to drop-down list
to specify a table or file.
If you select File, you see the Specify Output File window, where you
specify the type of file you want to write the output to, its file name, and
corresponding data dictionary.

9. Specify the fields that you want to output to contact history by selecting fields
from the Candidate Fields list, and moving them to the Fields to Output list
using the Add>> button. You can also use derived fields for Candidate Fields.
Remove fields from the Fields to Output list by selecting them and clicking
<<Remove.
If desired, reorder the fields in the Fields to Log list by selecting a field and
clicking Up1 or Down1 to move it up or down in the list.
You can automatically find matching fields by clicking Match>>. Fields with
exact matches for the Table Field names are automatically added to the Field
to Log list. If there are multiple matching fields, the first match is taken.

10. Select an option to specify how updates to the output file or table are
handled:
v Append to Existing Data — append the new contact information to the end

of the table or file. If you select this option for a delimited file, labels will
not be exported as the first row. This is the best practice for database tables.

v Replace All Records — remove any existing data from the table or file, and
replace it with the new contact information.

11. To customize the information that will be written to contact history, click More
Options.
The Contact History Logging Options window appears.
a. To avoid updating the contact history when this process runs, select Create

Treatments Only.
This option generates new treatments in the Treatments table without
updating the contact history, essentially allowing for a delayed update to
the history. For example, you might avoid writing contact history because
you plan to remove invalid and duplicate addresses through
post-processing. If you wait for the list of IDs to which offers are sent, the
resulting contact history will be smaller and more accurate.
Be aware that if you select this check box, other options in this window
that no longer apply (because no contact history will be logged) are
disabled.
By default, this check box is not selected, and contact history is updated
when the process is run. For more information about logging contact
history, see Chapter 8, “Contact history and response tracking,” on page
155.

b. To generate new treatments with the same package ID as in the most
recent process run, select Use Last Package ID.
All offers given in the same contact process to an individual are considered
to be a single "package"; by default, Use Last Package ID is not selected,
which specifies that each package is assigned a unique ID for each
production run of the contact process.
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If you selected Create Treatments Only to prevent the customer history
from being updated, you might also select this check box to ensure that the
package ID from the prior run is assigned to each set of offers, which links
the offers to the existing contact history.

c. Select the audience level at which you are tracking contact history from the
Tracking Audience Level drop-down list.

d. Enter the date on which the people in the contact list will be contacted in
the Contact Date field. You can also click to select the date from a
calendar. If you do not enter a date in this field, Campaign uses the
flowchart run date.

e. Enter a status code for tracking, using the Contact Status Code drop-down
list.

f. Select and move fields to and from the Candidate Fields and the Fields to
Log list using the Add>>, <<Remove, Match>>, Up1, and Down1 buttons
in the same way as you did to select fields on the Log tab.

g. Click Close when you have finished specifying additional fields to log.
You are returned to the Log tab of the process configuration dialog.

12. (Optional) To clear some or all existing contact history and associated
response history entries before the next run of the contact process, click Clear
History.

Important: Clear History permanently deletes contact and response history
records from the system tables. This data is not recoverable.

13. (Optional) Click the General tab to assign a name and/or notes to the process.
The name appears on the process in the flowchart. The notes appear when
you point to the process in the flowchart.

14. Click OK.

The process is configured and appears enabled in the flowchart. You can test the
process to verify that it returns the results you expect.

Call List
The Call List process is a contact process. Use it to generate a contact list (for
example, for a telemarketing campaign), assign specific offers to that contact list,
and log the contact history.

You configure a Call List process in the same way as you configure a Mail List
process. See “To configure a contact process (Mail List or Call List)” on page 81.

Track
Use the Track process to update the contact statuses or additionally tracked fields
for existing records in contact history.

Note: The Track process can only update existing rows in contact history; it cannot
create new rows.

For example, if records were initially written to contact history with a contact
status of "Proposed," you can use the Track process to later update records in
contact history that were contacted, with a contact status of "Contacted." Or, for
example, if all contacts who were sent a direct mail were written to contact history
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with a contact status of "Contacted" and you later received a list of undeliverable
mailings, you could update individuals on that list with contact statuses of
"Undeliverable."

To configure a Track process
1. In a flowchart in Edit mode, ensure that your Track process is connected to one

or more configured processes whose output cells will be used as input by the
Track process.

2. Double-click the Track process in the flowchart workspace.
The process configuration dialog appears.

3. Click the Source tab.
a. Select your source cell(s) from the Input drop-down list.
b. Select the contact date that you want to have associated with the records

updated by the Track process, using the Contact Date drop-down list. By
default, a value of "Today" is selected. You can also use derived fields to
populate Contact Date.

c. Select the Contact Status Code that you want to associate with the records
that you are updating in contact history.

4. Click the Mapping to Treatments tab.
The Candidate Action Fields list appears, from which you can choose the
relevant field to match to the Treatment Code. The treatment code uniquely
identifies the row in the contact history to update.
Select the field you want to use for matching from the Candidate Action Fields
list, and move it to the Matched Offer/Treatment Fields list using the Add>>
button, so that it is paired with Treatment Code.

5. Click the Log tab to specify how you want to update contact history from this
process.

Note: You must have the appropriate permissions to enable or disable updates
to contact history tables.
a. To update contact history in the system tables, select the Log to Contact

History Tables check box.
If you select Log to Contact History Tables and you want to write
additional fields to the contact history, click Additional Fields to display
the Contact History Logging Options dialog. Use the Add, Remove, Match,
Up1, and Down1 buttons to select and move the desired fields from the
Candidate Fields list to the Fields to Log list in the same way you did to
select fields on the Log tab. Unmatched fields are not updated.
Click Close when you have finished specifying additional fields to log.

b. To log to a destination other than, or in addition to, the contact history in
the system tables, select the Log into Other Destination check box to enable
writing to an alternate table or file.

c. If you selected Log into Other Destination, use the Log To drop-down list
to specify whether the output should be written to a file, or to a new table
in the database:
If you select File, the Specify Output File window appears. Use this
window to specify the type of file to which you want to write the output,
the file name, and the corresponding data dictionary.
If you select New Table, use the New Table Definition dialog that appears to
specify the information about the new table to which you want Campaign
to write the log output.
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d. If you selected Log into Other Destination, specify the fields that you want
to output by selecting fields from the Candidate Fields list, and moving
them to the Fields to Output list using the Add>> button.
You can also used derived fields for Candidate Fields.
Remove fields from the Fields to Output list by selecting them and clicking
<<Remove.
If desired, reorder the fields in the Fields to Log list by selecting a field and
clicking Up1 or Down1 to move it up or down in the list.
You can automatically find matching fields by clicking Match>>. Fields
with exact matches for the Table Field names are automatically added to
the Field to Log list. If there are multiple matching fields, the first match is
taken.

e. Only if you have chosen Log into Other Destination, select an option to
specify how updates to the output file or table are handled:
v Append to Existing Data — append the new contact information to the

end of the table or file. If you select this option for a delimited file, labels
will not be exported as the first row. This is the best practice for database
tables.

v Replace All Records — remove any existing data from the table or file,
and replace it with the new contact information.

6. (Optional) Click the General tab to assign a name and/or notes to the process.
The name appears on the process in the flowchart. The notes appear when you
point to the process in the flowchart.

7. Click OK.

The process is configured and appears enabled in the flowchart. You can test the
process to verify that it returns the results you expect.

Response
The Response process tracks the responses of customers who were contacted in a
contact process, such as Mail List or Call List. Based on rules that you define
during process configuration, the Response process evaluates which responses are
considered valid, and how they are credited back to campaigns or offers. The
output of the Response process is written to several response history system tables,
where the data can be accessed for analysis using Campaign performance and
profitability reports.

In its simplest form, the Response process can appear in its own flowchart
connected to a Select process (and optionally a Segment process). In such a
flowchart, the Select process selects IDs from a mapped table containing data about
responders and their response actions. These IDs are segmented by the Segment
process into meaningful groups, and finally passed to a Response process, where
response tracking rules are applied and output is written to response history
tables.

A Response process is tightly aligned with its corresponding contact process, in
which the responders now being tracked were possibly members of cells targeted
with particular offers. Therefore, before you can configure a Response process, you
must:
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v Know the audience level of your contact list and ensure that contact history and
response history system tables for each audience level that you are contacting
and tracking, have been mapped. This is usually done by your system
administrators.

v Set up a separate Response process for each audience level in which you are
tracking responders.

v Know the codes representing the response types that you want to track.
v Know what Campaign-generated codes (campaign, cell, offer, or treatment

codes) were sent out to your contact list, so you can map them for tracking.
v Enable Campaign to create temp tables in the Campaign system tables database

(i.e., the AllowTempTables property must be set to true).

To configure a Response process
1. In a flowchart in Edit mode, ensure that your Response process is connected to

one or more configured processes whose output cells will be used as input by
the Response process.

2. Double-click the Response process in the flowchart workspace.
The process configuration dialog appears.

3. Click the Source tab.
a. Select your source cell(s) from the Input drop-down list. The source cells

originate from the mapped table in your data mart that holds your
customer response information.

Note: If you are using a delimited flat file as input to the Response process,
you must ensure that all data types in the input files are mapped
appropriately, as this is not enforced by the Response process. Using a
mismatched data type (for example, having a treatment code mapped as
“numeric” when the UA_Treatment.TreatmentCode field is a “string” type)
causes a database error on some databases (for example, system tables on
DB2®).

b. Select the date that you want to have associated with the records output by
the Response process, using the Response Date drop-down list. By default,
a value of "Today" is selected. You can also use derived fields to populate
Response Date.

c. Select the Response Type Code that you want to track. The response type
codes are globally defined and available for all campaigns.

4. Click the Mapping to Treatments tab.
You see the Candidate Action Fields list, from which you choose the relevant
fields to be tracked. In the Matched Offer/Treatment Fields list, the
Offer/Treatment Attribute column lists all offer or treatment attributes in the
system.
a. Select the fields that you want to track from the Candidate Action Fields

list, and move them to the Matched Offer/Treatment Fields list using the
Add>> button, so that the appropriate fields to match are paired.
You can select multiple fields at one time using Ctrl+Click or a contiguous
range of fields using Shift+Click. You can also used derived fields for
Candidate Action Fields.

b. Remove fields from the Matched Offer/Treatment Fields list by selecting
them and clicking <<Remove.
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c. If desired, reorder the fields in the Matched Offer/Treatment Fields list by
selecting a field and clicking Up1 or Down1 to move it up or down in the
list.

Note: Unmapped fields, and fields for which values not available (or
NULL) are not used for response attribution. For a treatment instance to
receive response credit, all populated fields must match, except for controls,
for which all codes are ignored.

5. Click the Log tab to specify the fields you want to log to response history.
Select fields from the Candidate Fields list and move them to the Fields to Log
list using the Add>> button. You can also used derived fields for Candidate
Fields.
Remove fields from the Fields to Log list by selecting them and clicking
<<Remove.
Reorder the fields in the Fields to Log list by selecting a field and clicking Up1
or Down1 to move it up or down in the list.
You can automatically find matching fields by clicking Match>>. Fields with
exact matches for the Table Field names are automatically added to the Fields
to Log list. If there are multiple matching fields, the first match is taken.

6. (Optional) Click the General tab to assign a name and/or notes to the process.
The name appears on the process in the flowchart. The notes appear when you
point to the process in the flowchart.

7. Click OK.

The process is configured and appears enabled in the flowchart. You can test the
process to verify that it returns the results you expect.

Model
Use the Model process to create a runtime model file, which you can use for
real-time or batch scoring. It automates the creation of a response model that can
be used to score customers or prospects to determine the candidates most likely to
respond.

Typically, you set up the Model process in your flowchart to take input from two
cells, one representing the responders (contacts who reacted positively or took
some action upon receiving an offer or communication), and one representing the
non-responders (contacts who took no action).

For example, you could use two Select processes, one selecting the people who
were contacted with an offer, and the other selecting the responders. Then, use a
Merge process to exclude the responders so that you have a list of non-responders.
Connect the Merge output and the "responders" Select output to your Model
process to provide the non-responder and responder cells for the model.

In another scenario, you could use a Select process to select all contacts for an
offer, then use a Segment process to segment that cell into responders and
non-responders.

To configure a Model process
1. In a flowchart in Edit mode, ensure that your Model process is connected to

one or more configured processes whose output cells will be used as input by
the Model process.
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2. Double-click the Model process in the flowchart workspace.
The process configuration dialog appears.

3. On the Source tab, select your responder and non-responder cells from the
Responder and Non-Responder drop-down lists. The drop-down lists are
populated with input cells to the Model process; they are empty if you have
no inputs to the process.

Note: Both input cells must have the same audience level.
4. From the Variables to be Used for Modeling list, select the variables to be

used by the Model process during model generation. You can select all
variables (by clicking Use All) and let the Model process decide which set of
inputs are most effective for modeling. However, by eliminating variables that
do not add value to the model (for example, variables containing the same
value for all records or different values for all records), you can speed up the
automatic variable selection process.

Note: If you are in doubt as to the predictive value of a variable, include it
and let the Model process decide whether it should be used.
You can also use derived fields in the configuration of a model.

5. On the Method tab, used the Best Model options to choose how the data
mining algorithms should arrive at the best model: based on a specified
length of time, or from among a specified number of candidate models.
v Best Model In – (Default) Allows you to specify a time limit for modeling.

The Model process retains the best models built in the time period that you
specify. The default is three hours.

v Best Models Among – Allows you to specify the number of models to
build. The Model process will retain the best of these models. The default is
20.

6. Select the type of modeling that will be done by choosing an algorithm from
the Algorithm to Use drop-down list. You can select one, several, or all.

Note: Selecting All Algorithms (the default) will result in a more accurate
model, but it might take longer.

7. Set the maximum number of models to keep by entering any positive integer
in the Max. # of Models to Keep field. The default is five. Each of the top
models are saved by appending a pound sign (#) to the end of the specified
file name. If more than one model is kept, an index is appended to the base
file name, indicating the rank of the model.

Note: The more models you elect to keep, the more disk space is required to
save the corresponding information.

8. In the Model File Name field, specify the absolute path name for the model
file that is to be created, or click Browse to navigate to a file. Once you run
the process it will generate a NAME.rtm model file, which you can use for
scoring with the Score process.

9. (Optional) Click the General tab to assign a name and/or notes to the process.
The name appears on the process in the flowchart. The notes appear when
you mouse over the process in the flowchart.

10. Click OK.

The process is configured and appears enabled in the flowchart. You can test the
process to verify that it returns the results you expect.
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Score
Use the Score process to rate the likelihood of each customer making a purchase or
responding to an offer and to identify the best customers or prospects for the
campaign that you plan to run. Scoring is based on modeling results imported
from a runtime model file (.rtm file) created by PredictiveInsight or the Model
process in Campaign.

The Score process might be used in a flowchart in the following way: The
flowchart begins with a Schedule process which runs the flowchart every month. It
is connected to a Select process which generates a list of customer IDs from data in
the data mart. The IDs are then sent to a Score process for scoring against a data
model. Finally, the results of the Score process are sent to a Snapshot process to be
written out to a spreadsheet.

To configure a Score process
1. In a flowchart in Edit mode, ensure that your Score process is connected to a

configured process whose output cell(s) will be used as input by the Score
process.

2. Double-click the Score process in the flowchart workspace.
The process configuration dialog appears.
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3. Use the Input drop-down list to select a source cell containing the customer
IDs that you want to score.

Important: You cannot select multiple source cells to score.
4. In the Number of Models field, specify the number of models you want to

create by entering an integer, or by using the up and down arrow buttons to
increase or decrease the count.

Note: The Parameters For drop-down list will contain as many models as you
specified in the Number of Models field, named Model 1, Model 2, Model 3,
and so on. If you change the number of models, the models listed in the
Parameters For drop-down list automatically change.

5. For each model that you are scoring, specify a Score Field Name and a Model
File. Use the Parameters For drop-down list to select each model that you
need to configure.

6. In the Score Field Name field, type the name of the field where you want the
scoring results stored for that model. The default name is scoreN_1.

If you type MYSCORE in the field and there is a single output field defined
in the specified model, the score field name will be MYSCORE. If there are
multiple outputs, the score field names will be MYSCORE_1, MYSCORE_2,
MYSCORE_3, and so on.
When Campaign displays the list of available fields, the score fields will
appear as if they belong to a table.

7. In the Model File field, enter the full path and file name of the model file that
you will be using to score the customer IDs.
Enter the full path and file name of the model you want to use, or click
Browse to evoke a standard Windows file selection window.

8. Click Match Variables Names to match variable names with fields from the
table in the input source. The Match Variable Names window appears.
For customers to be scored properly, you must ensure that you can match the
variables used by the model with corresponding fields in the data set to be
scored. For example, if the model uses an average_balance variable, you must
match that variable with a field containing average balance in the data set to
be scored.
a. Select fields in the Available Fields list that match with fields in the data

set, and move them to the Matched Variables list using the Add>> button.
You can match identical field names automatically by clicking Match. This
will override any manual matching.
You can also create derived fields by clicking Derived Fields.

Important: You must match all the variables in the Matched Variables
List to configure the Score process. Variable names do not need to match
the field names, but the data types (numeric or string) must match.

b. When you have finished matching variable names, click OK.
The Match Variable Names window closes and you are returned to the
Score tab in the process configuration dialog.

9. (Optional) Click the General tab to assign a name and/or notes to the process.
The name appears on the process in the flowchart. The notes appear when
you mouse over the process in the flowchart.

10. Click OK.
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The process is configured and appears enabled in the flowchart. You can test
the process to verify that it returns the results you expect.

Choosing data sources for processes
In many processes, including Audience, Create Seg, Cube, Extract, Model,
Response, Segment, and Select, you must specify a source of the data that the
process will act on. The data source for a process might be an incoming cell,
segment, table, or multiple tables.

In most cases, you specify the data source for a process in the Input field on the
first tab of the configuration window, using the Input drop-down list. For
instructions, see the instructions for configuring each process. For example, see “To
configure a Select process” on page 46.

To select an incoming cell, segment, or table as the input to a
process

On the first tab of the process configuration dialog, select the incoming cell,
segment, or table from the Input drop-down list. The Input drop-down list
displays all the base tables currently mapped in the table catalog, along with their
audience levels. If there is an incoming cell, then only those tables with the same
audience level as the cell are displayed.

To select multiple tables as the input to a process

You can select more than one table as input to a process.
1. In the process configuration dialog, select Tables > Multiple Tables from the

Input drop-down list.

Note: If you select multiple tables, the tables must have the same audience
level.
You can also click the ellipsis button. The Select Tables to Use window displays
all the base tables in the campaign’s table catalog.

2. Check the box next to each table that you want to select.
3. Click OK to return to the process configuration dialog. The Input field displays

"Multiple Tables", which you can view by clicking the ellipsis button.

To map a new table for selecting as a source

In the process configuration dialog, select Tables > New Table from the Input
drop-down list.

The New Table Definition window preselects the Base Record Table type. You map
a new base table in a process configuration dialog in the same way that you map a
table from the Table Mappings dialog.

Note: You must have the appropriate permissions to be able to map tables. For
details about mapping tables, see the Campaign Administrator’s Guide.
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Choosing in-database processing for processes
In-database processing is an option that you can turn on or off for your flowchart
processes both globally, and for each flowchart.

Note: In-database processing is not supported for all databases. Your Campaign
administrator can confirm whether this option is available for your data sources.

The in-database processing option determines:
v what operations are done at the database level or at the local Campaign server

level; and
v what happens to the results of operations.

In general, the in-database processing option improves flowchart performance by
preventing IDs from your database from being unnecessarily copied down to the
Campaign server for processing. With in-database processing turned on, processing
tasks such as sorting, joining, and merging of data are, whenever possible, done on
the database server rather than on the Campaign server, and output cells of
processes are stored in temporary tables on the database server.

Depending on the logic required, some functions will still be performed on the
Campaign server, even with in-database processing turned on. For example, when
Campaign calculates a derived field, it first evaluates the derived field formula to
see if any part of the calculation can be performed using SQL. If simple SQL
statements can be used to perform the calculation, then the calculation can be done
"in-database". If not, then temporary tables are created on the Campaign server to
handle the calculations and persist the results from process to process within a
flowchart.

Important: In-database processing cannot be done if you have specified any
limitations on the output cell size or if temporary tables are disabled for the
process.

Processing of custom macros consisting of raw SQL statements is performed
in-database, with the following limitations:
v All raw SQL custom macros must begin with select and must contain exactly

one from in the rest of the text.
v For databases that support only insert into <TempTable> syntax, you must have

at least one base table mapped to the same data source at the same audience
level as the raw SQL custom macro. If the fields selected by the raw SQL custom
macro are too large for the fields of the temp table, a runtime error will occur.

Important: If you are using raw SQL with in-database processing, you must code
the raw SQL to join with the temp table from the upstream process, otherwise, the
results will not be scoped by the results from the upstream process.

Turning in-database processing on or off
The in-database processing setting can be set:
v for each flowchart
v globally, for the entire system

A best practice for this option is to turn off the global setting, and set the option at
the flowchart level.
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To turn in-database processing on or off for a flowchart

The in-database processing option for an individual flowchart overrides the global
setting.
1. From a flowchart page in Edit mode, click the Admin icon and select

Advanced Settings.
The Advanced Settings window appears.

2. Select the Use In-DB Optimization during Flowchart Run check box.
3. Click OK.

When you save and run the flowchart, in-database processing will be used
wherever possible.

To turn in-database processing on or off globally

To turn on in-database processing or turn off globally, set the Campaign >
partitions > partition[n] > server > optimization > useInDbOptimization
property on the Configuration page to the appropriate value (TRUE or FALSE).

For information about using the Configuration page, see the IBM Unica Marketing
Platform Administrator's Guide.

Creating queries in processes
When you configure particular processes, you can use queries to return specific
data from your data sources. Campaign makes it easy for you to create queries
using any of the following methods:
v “To create a query with Point & Click” on page 96
v “To create a query with Text Builder” on page 97
v “To create a query using Query Helper” on page 97
v “Creating queries using SQL” on page 98

How queries are evaluated in Campaign processes
Queries in Campaign processes are evaluated left to right using mathematical
rules.

For example, the following statement:

[UserVar.1] < PDF < [UserVar.2]

is evaluated as:

([UserVar.1] < PDF) < [UserVar.2]

That is, the first part of the statement ([UserVar.1] < PDF) is evaluated as true or
false (1 or 0), and the result is passed to the second statement:

[1 | 0 ] < [UserVar.2]

For the example to be evaluated as PDF greater than [UserVar.1] and less than
[UserVar.2], you would need to construct the following query:

[UserVar.1] < PDF AND PDF < [UserVar.2]
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This statement is equivalent to the following:

([UserVar.1] < PDF) AND (PDF < [UserVar.2])

To create a query with Point & Click

These instructions explain how to create a query using the Point & Click feature in
a Process Configuration dialog.

To edit a query, double-click any item in the query to select another value.
Selecting a new item from the Select Based On drop-down list will remove the
existing query.
1. In a process that uses queries, such as Segment, Select, or Extract, access the

process configuration dialog where queries can be constructed. For example,
open a Select process box and click Select Customer IDs) with on the Select
tab.
By default, the Point & Click query builder is displayed.

2. To create a query, click in each column cell (Field Name, Oper., Value,
And/Or), then double-click a selection from the list on the right. If the Profile
option appears, you can use it to display the values in the field. By clicking in
each column, then double-clicking a selection, you can build your query:
v Use Field Name to indicate which field to query. You can select from the list

of Available Fields, including IBM Unica Campaign Generated Fields. You
can also create Derived Fields.

v Use Oper. to select a comparison operator (for example, =, <, >, Between).
v Select a Value for the field.
v To add another expression, click the And/Or column, then double-click AND

or OR to indicate how to combine the expressions.
v To add parentheses to control evaluation order, select an expression, then use

Add (...) to add a set of parentheses, Remove (...) to remove a single set of
parentheses, or Clear all (...) to remove all of the parentheses in the selected
expression. Parentheses allow you to group expressions when defining
complex queries. For example, (AcctType = 'Gold' AND Rank = 'A') OR
NewCust = 'Yes' is different from AcctType = 'Gold' AND (Rank = 'A' OR
NewCust = 'Yes').

v Select one or more expressions, then use Move Up or Move Down to reorder
expressions.

v Select an expression then use Insert to add a blank row.
3. Click Check Syntax to confirm whether your query syntax is valid. Checking

the syntax does not put any load on the database server.
Campaign indicates whether the syntax contains any errors.

4. To see the results of the query, click Test Query.

Important: Global suppressions and cell size limits are not applied in Test
Query counts. Queries might also return non-normalized data. To obtain an
accurate result count, test run the process.
A progress bar is displayed while the query is being tested. Click Cancel to
stop the testing.
When testing is complete, Campaign indicates the number of rows the query
returned. (This number might be different when the campaign is run.)

5. Click OK.
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To create a query with Text Builder

These instructions describe how to create a new query using the Text Builder
feature in the process configuration dialog.

To edit an existing query, edit the text of the query directly in the query text box.
1. In a process that requires queries, such as Segment, Select, or Extract, access the

process configuration dialog containing the query text box.
By default, the Point & Click query builder is displayed. Any existing queries
are shown in the query text box.

2. Click Text Builder.
The Point & Click query columns are replaced with a blank text box.

3. Choose an Input data source, and a data source to query from the Select Based
On drop-down list.
The list of Available Fields is displayed based on your Select Based On choice.

4. Create your query by:
v Selecting the field or table name(s) from the Available Fields list and

double-clicking to enter them in the query text box. You can also click once
then click <-Use to move it to the query text box.

v Entering the required operators and values. To see the values of a selected
field, you can click Profile.

Note: Although you can enter field and table names directly in the query text
box, selecting them from the list helps to avoid syntax errors.

5. To check the syntax of the query, click Check Syntax.
Campaign displays a confirmation window that displays any found errors.
Click OK

Checking the syntax of your query does not put any load on the database
server.

6. If you want to see the results of running the query, click Test Query.

Important: Global suppressions and cell size limits are not applied in Test
Query counts. Queries might also return non-normalized data. To obtain an
accurate result count, perform a test run of the process.
A progress bar is displayed while the query is being tested. Click Cancel to
stop the testing.
When testing is complete, Campaign displays a confirmation window that
displays the number of rows the query returned. (This number might be
different when the campaign is run.)

7. When you have finished creating your query, click OK.
The process configuration box closes and you are returned to the flowchart
page in Edit mode.

To create a query using Query Helper

The Query Helper provides selectable operators and functions that you can
combine with available fields to build a query. The Query Helper can help you
construct queries in Campaign’s macro language or with custom macros.
1. In a process that requires queries, such as Segment, Select, or Extract, access the

process configuration dialog containing the query text box.
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By default, the Point & Click query builder is displayed. Any existing queries
are shown in the query text box.

2. Click Text Builder.
The Point & Click query columns are replaced with a blank text box. The
Query Helper button is enabled.

3. Click Query Helper.
The Query Helper appears below the query text box. The Query Helper
contains a set of buttons for inserting commonly used operators, and a
complete list of macros.

4. Create your query by:
a. Selecting the macro you want to use from the list of macros in the Query

Helper and double-clicking to enter it in the query text box. When you
select a macro, the Query Helper displays a brief description and the syntax
of the selected macro.

Note: If you select a custom macro, the description and syntax were created
by the person who wrote the macro.

b. Entering the required operators by typing or using the Query Helper
buttons.

Note: Although you can enter field and table names directly in the query
text box, selecting them from the list helps to avoid syntax errors.

5. Continue creating your query using the Text Builder.
6. When you have finished creating your query, click Close.

The Query Helper closes.
7. Click OK to close the process configuration dialog.

Creating queries using SQL
If you are an experienced SQL user, you can write your own SQL query or use
SQL queries created in other applications by copying and pasting them. Writing
raw SQL is an advanced function of Campaign; users are responsible for correct
syntax and query results.

Important: Getting correct results when using raw SQL in a Select process (that is,
the correct list of audience IDs) requires the use of the <TempTable> token when
in-DB optimization is enabled and there is an input cell to the Select process. In
addition, to significantly improve performance when Campaign processes very
large tables, use the <TempTable> token even when not using in-DB optimization.

A SQL query must return a list of only the unique IDs as defined by the key on a
base table.

Your query should use the following syntax:

SELECT DISTINCT(<key1> [<key2>,...]) FROM <table> WHERE <condition> ORDERBY
<unique_id>

The query requests the database to perform the sorting and data deduplication. If
you omit either the DISTINCT or ORDERBY clause, Campaign will still sort and
deduplicate the data on the application server, so you will still receive the correct
results, but the performance will likely be slower.
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v If you have chosen to Select All Customer IDs, you can write raw SQL
commands to be run against records in a specified database before or after the
Select process is executed.

v If you have chosen to apply select criteria to the customer IDs, in addition to the
above, you can also enable the use of raw SQL in the Query Builder when
creating your select criteria. Otherwise, you can only use Unica Expressions and
Custom Macros.

Building raw SQL statements in Campaign
In processes which require queries, click Advanced on the query editing window
to access the Advanced Settings features. The actual features will vary among
processes.

For example, in the Select process, you can use the Advanced Settings to create a
query using raw SQL or to execute pre- and/or post-processing SQL commands.

The Advanced Settings window includes two panes:
v Pre-processing — enter raw SQL to be processed before the query executes
v Post-processing — enter raw SQL to be processed after the query executes

This feature allows you to incorporate SQL procedures as part of the process run,
and is useful in employing Campaign in efforts including ETL, routine mart
updates, in-line performance tuning, and security functions.

You can use pre- and post-processing SQL statements in Advanced Settings to:
v Run stored procedures in the database
v Create, drop, and recreate tables and indexes
v Grant or change privileges to other users or groups
v Organize multi-step database commands
v Run complex database routines, without having to use external scripts to

connect to the database

The SQL statements are run in the order in which they appear.
v Pre-Processing SQL statements are run before the query executes.
v Post-Processing SQL statements are run after the query executes.

They can be used with either raw SQL or standard processing in the Select process
query.

Raw SQL queries and in-database processing

For details about in-database processing with raw SQL queries, see “Choosing
in-database processing for processes” on page 94.

Using the TempTable and OutputTempTable tokens in raw SQL
queries
When you use a raw SQL query in a Select process with an input cell, behavior in
Campaign is different depending on whether in-DB optimization is enabled or
disabled.

When in-DB optimization is disabled, the list of IDs from the raw SQL query is
automatically matched against the ID list from the incoming cell so that the
resulting list of IDs is a subset of the cell as expected. However, when in-DB
optimization is enabled, Campaign expects the ID list generated from the Select
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process to be the final list, and does not automatically match this list against the ID
list of any incoming cell. Therefore, when in-DB optimization is enabled, it is
critical that the raw SQL query written for an intermediate Select process (in other
words, a Select process with an input cell) uses the <TempTable> token to properly
join against the incoming cell. Not only does this ensure correct results, joining
against the input cell also improves performance by preventing extraneous
processing for audience IDs that are not in the input cell.

Note: For best performance, use the <TempTable> token even when not using
in-DB optimization. Using the <TempTable> token can significantly improve
performance, especially when Campaign processes very large tables.

In addition, using the <OutputTempTable> token maintains in-DB optimization
and prevents the audience IDs from being retrieved from the database back to the
Campaign server.

Example: Using the TempTable and OutputTempTable tokens: Assume that you
have a Select1 process that selects 10,000 customers who are “Gold” customers (for
example, Indiv.AcctType = ‘Gold’). You then connect Select1 to a second Select
process (“Select2”) using a raw SQL query:

Select p.CustID from Indiv p, <TempTable> where p.CustID =
<TempTable>.CustID group by p.CustID having sum(p.PurchAmt) > 500

This example selects customers the sum of whose purchases exceeds $500 and who
are in the input cell (in other words, customers who have a “Gold” account type).

In contrast, a raw SQL query omitting the <TempTable> token and join:

Select p.CustID from Purchases p group by p.CustID having sum(p.PurchAmt) >
500

first calculates the sum of purchases for all customers in the Purchases table (which
could be millions of customers) and then selects all customers the sum of whose
purchases exceed $500, regardless of whether they are “Gold” customers or not.

Therefore, for best performance, even if in-DB optimization is disabled, write your
raw SQL queries using the <TempTable> token when there is an input cell.

For simplicity, this example does not use the <OutputTempTable> token, but to
maintain in-DB optimization and prevent the audience IDs from being retrieved
from the database back to the Campaign server, you must include the
<OutputTempTable> token in your raw SQL query. For example:

Create table <OutputTempTable> as Select p.CustID from Purchases p,
<TempTable> where p.CustID = <TempTable>.CustID group by p.CustID having
sum(p.PurchAmt) > 500

Referencing Extract tables in raw SQL queries
You can reference an Extract table in downstream processes via raw SQL using the
<Extract> token. Use this token to specify subsets of data for subsequent
processing, which can improve performance when working with large tables.

The following example queries an Extract table to select the customer IDs of all
customers whose account balance exceeds $1,000.
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Select p.CUSTOMERID from USER_TABLE p, <Extract> where p.CUSTOMERID =
<Extract>.CUSTOMERID group by p.CUSTOMERID having sum(p.BALANCE) > 1000

For flowcharts containing multiple Extract processes, the <Extract> token always
refers to the latest available Extract table.

Note: After a Merge, the <Extract> token may or may not be valid. Test run the
flowchart to determine if the token works as expected.

To create a raw SQL query in the SQL Text Entry Area
1. Enable the Select records with option in the Source tab of the Select process.
2. Click Advanced.

The Advanced Settings window appears.
3. Enable Use Raw SQL for Record Selection.
4. Select the data source to query from the Database drop-down list.
5. Select the audience to target from the Audience Level drop-down list.
6. Click OK to close the Advanced Settings window.
7. Click inside the SQL text entry area.
8. Build a query by:

v Entering raw SQL in the SQL text entry pane
v Using the Query Helper

v Using Point & Click

Note: If you click Point & Click, you will return to building a non-SQL
query expression.

9. (Optional) Click Test Query.

Important: Global suppressions and cell size limits are not applied in Test
Query counts. Queries might also return non-normalized data. To obtain an
accurate result count, perform a test run of the process.

10. When you have finished building and testing your query, click OK to close
the window and save your configuration.

To pass multiple commands in a raw SQL statement

You can pass multiple commands in a raw SQL statement.

If your database allows multiple commands to be passed, you can enter as many
valid SQL commands as you need, with the following rules:
v Commands are separated with the appropriate delimiter;
v The last command must be a select command;
v This select command must select all the relevant fields required in defining your

audience level in the same order the audience level is defined;
v No other select statements are used.
1. Enable the Select records with option in the Source tab of the Select process.
2. Click Advanced.

The Advanced Settings window appears.
3. Click to enable Use Raw SQL.

This activates raw SQL, a feature that passes your exact query syntax to the
database.
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4. Select the database to use and the desired audience level.
Click OK.

5. Enter your SQL commands in the Select records with text box.
Click OK.

To specify pre- or post-processing SQL statements
1. From the Source tab of a Select process, click Advanced.

The Advanced Settings window appears.
2. To enter a pre-processing raw SQL statement, double-click inside the

Pre-Processing field and enter the SQL statement you want to run before the
process runs.

3. Next, click in the Database field on that line, and select the name of the
database on which you want to run this statement.

Note: The Database drop-down list displays all of the available databases
(those for which a data source category has been configured on the
Configuration page in Marketing Platform). If your database does not appear in
this drop-down list, contact your Campaign system administrator.

4. Click to select the SQL check box if you want to view only SQL functions in
the list pane. Click again to clear and see the full list of available functions and
operators.

Note: If you already enabled the Use Raw SQL option on the Advanced
Settings window, the SQL option in the Query Helper is enabled. This will hide
Campaign macro functions, so that only SQL operators and functions are
displayed.

Profiling fields
The Profile feature lets you preview a list of distinct values and their frequency of
occurrence for a selected field. You can profile any field that is available in any
process where the Profile button appears, such as the Segment by Field
drop-down list in the Segment process, or Available Fields or Candidate Fields
lists in other process configuration dialogs. Only records in the current cell are
included in the count, unless the counts have been pre-computed.

Note: You must have the appropriate permissions to profile fields. Ask your
system administrator if you have questions about your access to this feature.

To profile a field

Campaign profiles a field when you select it in a list then click the Profile button.
You can profile any field in any mapped data source. You can also profile derived
fields.
1. In the configuration window of a process that includes the Profile button,

select the field that you want to profile.
2. Click Profile .

The Profile Selected Field window opens.

Campaign profiles the data in the selected field. The categories and frequency
counts update as profiling progresses.
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Note: Wait until profiling is complete before using the results, to ensure that all
categories are processed and counts are complete.

When profiling is complete, the Profile Selected Field window shows the following
information:
v The list of values in the selected field, shown in the Category column, and the

corresponding Count of IDs with that value.

Note: Campaign organizes values by category, grouping them to create
approximately equal-sized segments. The default maximum number of
categories (distinct bins of values) for display is 25. You can change the
maximum number of categories.

v The Statistics pane on the right shows the total count of IDs and other details
about the data for that field, including:
– The number of NULL values found
– The total number of categories, or values, for that field
– Statistical values for the data including the mean, standard deviation,

minimum, and maximum values.

Note: Mean, Stdev., Min., and Max. are not available for ASCII fields. When
you profile text fields, these values appear as all zeros.

Restricting input for profiling
When Campaign profiles a field, it creates only those segments that are available in
the input to the process in which you are performing profiling.

In other words, if you restrict input to the Segment process, then profile that data
based on that same field on which it was restricted, the Profile results can only
display segments that were available in the restricted input.

For example, in a Segment process, if you use a query to select only those IDs
associated with Credit Score < 5 out of a list of 10 potential credit score levels, then
if you profile the same field (in this example, Behavior.CreditScore), then
Campaign can only display the four segments corresponding to those four
remaining credit score levels.

The following examples compare an unrestricted profile (where Input Cell on the
Profile Selected Field window is set to None), and a restricted profile (where the
Input Cell is set to Select1.out).
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On the Profile Selected Field window, the Input Cell is set to None. When
profiling is performed, all 10 distinct values in the field Behavior.CreditScore are
displayed.
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On the Profile Selected Field window, the Input Cell is set to Select1.out, the
output cell from a select process providing input into the current process which is
restricted to credit scores from 1 to 4.

When profiling is performed, only four categories are displayed, each
corresponding to one of the allowed values in the input cell.

Disallowing profiling
Real-time profiling allows you to view and use characteristics of a selected field. It
can affect performance, however, when working with large databases. For this
reason, Campaign allows this option to be disabled.

When real-time profiling is disabled, and you click Profile, a messageat the bottom
of the Profile Selected Field window indicates that real-time profiling is disallowed.

If profiling is disallowed and the field is not configured to be pre-computed, the
Profile Selected Field window indicates that no data is available, no counts or
categories are displayed, and all Statistics counts are zero.

If pre-computed values are available for a field, the pre-computed values are
displayed instead of live values when profiling is performed. The Profile Selected
Field window indicates that the data source is "Imported," and shows the date and
time that the values were last computed.
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For more information about disallowing real-time profiling, see the IBM Unica
Campaign Administrator's Guide.

Setting profiling options
You can affect how the Profile feature performs by:
v “Restricting input for profiling” on page 103
v “Disallowing profiling” on page 105

In addition, you can set these options in the Profiling Options window:
v “Specifying the maximum number of profile segments”
v “Profiling by meta type”

To access the Profiling Options window
1. From any process configuration dialog in which the Profile option is available,

select a field for profiling, or click Profile.
The Profile Selected Field window appears.

2. From the Profile Selected Field window, click Options.
The Profiling Options window appears.

Specifying the maximum number of profile segments
When you Profile a field, Campaign automatically creates up to the maximum
number of segments set in the Profiling Options window. By default, a maximum
of 25 segments are allowed.

You can change the maximum number of segments to be used for profiling. After
this setting is changed, the new setting is used for all subsequent profiles until it is
reset.

Note: If the number of distinct values in the field you are profiling exceeds the
maximum allowed number of segments, Profile will group values together into
approximately equal sized segments to prevent exceeding the maximum number of
segments.

To set the maximum number of segments for profiling
1. On the Profile Selected Field window, click Options.

The Profiling Options window appears.
2. In the Number of Segments field, enter an integer to indicate the maximum

number of segments into which you want the field values grouped. The default
value is 25.

3. Click OK.

The profile is recomputed using the new maximum number of segments setting.

Profiling by meta type
You can specify whether metadata type information should be used when profiling
by enabling or disabling the Profile By Meta Type check box on the Profiling
Options window.

Profile By Meta Type enabled is usually the desired behavior. Data types
associated with fields containing dates, money, telephone numbers, and other
numeric information are correctly sorted and binned using the metadata
information, rather than sorting purely based on ASCII text.
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For example, the following table shows a date field sorted using meta type
information and without. Profiling done without using meta type produces results
sorted purely numerically, while profiling done using meta type recognizes that the
data are formatted as dates, and sorts them accordingly.

Profiled by Meta Type Profiled Without using Meta Type

25-DEC-2006 20-FEB-2007

20-FEB-2007 20-MAR-2007

20-MAR-2007 25-DEC-2006

Refreshing a profile count
You might want to refresh the profile count when something occurs that might
change the results (for example, when new values are added to a field), or
whenever the database table might have been updated.

To refresh the profile results for a field from the Profile Selected Field window,
click Recompute.

Note: When you first profile a field from a dimension table, Campaign returns
counts that match the field in the dimension table. When you click Recompute to
refresh the profile results, Campaign returns counts from the resulting join with the
base table that is linked to the dimension table. If you want to profile a dimension
table field without joining to a base table, map the dimension table as a base table.

To insert a profile category into a query

While building a query expression in a process configuration dialog, you can insert
a field value into your query expression.
1. Perform profiling on the selected field.
2. When profiling is finished, from the Profile Selected Field window, double-click

a category to insert that value at the current cursor location in the query text
box.

Note: If you do not see the value you want, this might be due to multiple
values being grouped together into a profile segment. If you set the maximum
number of profile segments to a number greater than the number of categories
(reported in the Profile Selected Field window), each field value will be listed
as a separate category. This makes it possible to access all of the existing
categories.

To print the results of a profile
1. Click Print from the Profile Selected Field window.

The Page Setup page appears, from which you can specify the printer and
printing options.

2. Click OK to confirm sending the print job to the printer.

To export profile data

After performing profiling on a field, you can export the profile data to a delimited
text file.
1. In the Profile Selected Field window, click Export.
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Note: The Export button is available only when profiling is finished.
The Export Report Data window appears.

2. (Optional) Select the Include Column Labels check box to include column
heads in your exported data.

3. Click Export.
The File Download window appears.

4. Click Open to open the profile data, or click Save to specify a location for
saving the file.
If you clicked Open, the profile data is displayed in a spreadsheet window.
If you clicked Save, the Save As window appears.

5. If you clicked Save, in the Save As window, navigate to the location where you
want the export file to be saved, and enter the file name that you want to use
for the exported file. By default, the name of the export file is Campaign.xls.

6. Click OK.
The data is exported to the file you specified. The Download Complete window
appears.

Specifying an output file or table for contact logging
Contact processes such as Mail List or Call List can write results to:
v system tables
v a new or existing external file that you specify
v an unmapped database table

To specify an output file for contact logging
1. In a flowchart in Edit mode, from the process configuration dialog, select File

from the Export To or Log To drop-down list. The File option usually appears
at the bottom of the list, following the list of mapped tables.
The Specify Output File window appears.

2. Select the type of file to which you want to write:
v Flat file with data dictionary to create a new fixed-width file and new data

dictionary file.
v Flat file based on existing data dictionary to create a new fixed-width file

and select an existing data dictionary file.
v Delimited file to create a new file in which field values are delimited by a

tab, comma, or other character.
3. If you selected Delimited file:

v Select the Tab, Comma, or Other option. If you selected Other, enter the
character to use as the delimiter in the Other field.

v Check Include Labels in Top Row if you want the first row of the file to
contain labels for each column of data.

4. Enter the complete path and name of the file in the File Name field. You can
also click Browse to navigate to a directory and select an existing file.

Note: You can use user variables in the output file name. For example, if you
specify MyFile<UserVar.a>.txt as the file name, and the value of the user
variable "a" is "ABC" at the time that the process is run, the output is written to
a file named MyFileABC.txt. Be aware that you must set the Initial Value and
the Current Value of the user variable before executing the flowchart.
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5. Campaign automatically fills in the Data Dictionary field with a .dct file with
the same name and in the same location as the file you entered.

6. If you want to use a different data dictionary, or to rename the data dictionary,
enter the complete path and name of the data dictionary file in the Data
Dictionary field.

7. Click OK.
The Specify Output File window closes. You are returned to the process
configuration dialog, and the Export/Log to field displays the path and file
name you entered.

To specify a database table for contact logging
1. In the process configuration dialog, select New Table or Database Table from

the Export To or Log To drop-down list. This option usually appears at the
bottom of the list, following the list of mapped tables.
The Specify Database Table window appears.

2. Specify the table name.

Note: You can use user variables in the table name. For example, if you specify
MyTable<UserVar.a> as the table name, and the value of the user variable "a" is
"ABC" at the time that the process is run, the output is written to a table
named MyTableABC. You must set the Initial Value and the Current Value of
the user variable before executing the flowchart.

3. Select the database name from the drop-down list.
4. Click OK.

The Specify Database Table window closes. You are returned to the process
configuration dialog, and the Export/Log to field displays the name of the
database table you entered.

5. If a table of the name you specified exists, choose an option for writing the
output data:
v Append to Existing Data — if you choose this option, the existing table must

have a schema compatible with the output data. In other words, field names
and field types must match, and field sizes must allow for the output data to
be written.

v Replace All Records — if you choose this option, existing rows in the table
are replaced with the new output rows.

Changing the seed for random selection
The random seed represents the starting point that Campaign uses to select records
randomly. If you are selecting records randomly, you might want to change the
random seed in situations such as the following:
v You have the same number of records in the same sequence, and using the same

seed value each time you run this process results in records being created into
the same samples.

v Your current random sample produces highly skewed results (for example, if all
males in your data fall into one group and all females into another).

To change the random seed for selecting records

On the Cell Size Limit tab of the process configuration dialog, change the starting
point for the random selection in one of these ways:
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v Enter a numeric value in the Random Seed text box; or
v Click Pick to have Campaign randomly select a new seed value for you.

Skipping duplicate IDs in process output

The Extract, Call List, Mail List, and Snapshot processes allow you to specify how
to treat duplicate IDs in the process output. The default is to allow duplicate IDs in
the output. Follow these steps to exclude records with duplicate IDs from the
output.
1. From the configuration window of the process, click More.

You see the Advanced Settings window.
a. Select Skip records with duplicate IDs, and specify the criteria to

determine which record to retain if duplicate IDs are returned. For example,
select MaxOf and Household_Income to export only the ID with the highest
household income.

Note: This option only removes duplicates within the same input field.
Your data can still contain duplicate IDs if the same ID appears in multiple
fields. To remove all duplicate IDs, you must use a Merge or Segment
process upstream of the Extract process to purge duplicate IDs or create
mutually exclusive segments.

2. Click OK to close the Advanced Settings window.
Your duplicate ID settings are displayed on the configuration window.

Note: In the Mail List or Call List process box, the Skip records with duplicate
IDs option on the Log tab pertains only to the fulfillment table created by the
process and not to records that are written to contact history. The contact
history tables only handle unique IDs. The flowchart designer must ensure that
the result set obtains the correct records before reaching the contact history
tables. Use the Extract process to de-dupe the result set before the Mail List or
Call List process box to ensure that the correct records are written to both the
fulfillment table and contact history.

To use the Calendar tool

The Calendar tool is available for fields throughout Campaign where you can enter
a date value into a field.
1. Click the ellipsis button next to the field requiring a date value.

The Calendar tool appears. The current date is selected by default.
2. Click the date on the displayed month to select it, or:

v Change the month using the Month drop-down list
v Change the year using the up and down arrows

3. Click OK to enter the specified date into the field and close the Calendar
window.
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Chapter 6. Offers

Offers are specific marketing communications that you send to particular groups of
people, using one or more channels. They can be simple or complex. For example,
a simple offer from an online retailer could consist of free shipping on all online
purchases made in the month of April. A more complex offer could consist of a
credit card from a financial institution, with a personalized combination of
artwork, introductory rate, and expiration date that varies based on the recipient’s
credit rating and region.

In Campaign, you create offers that can be used in one or more campaigns.

Offers are re-usable:
v in different campaigns;
v at different points in time;
v for different groups of people (cells);
v as different "versions" by varying the offer’s parameterized fields.

Once an offer has been used, it cannot be deleted, but it can be retired.

Retired offers can no longer be assigned, and any assigned offers that have been
retired will no longer be given out. Retired offers are still visible (although greyed
out) in the offer hierarchy, and are still available for reporting and response
tracking.

Note: Offer names have specific character restrictions. For details, see “Special
characters in IBM Unica Campaign object names,” on page 219

Offers are identified with unique system-assigned offer codes based on a format
that your company has specified. You can override or regenerate offer codes
(depending on your security permissions), but if you do so, the uniqueness of the
new offer code is no longer checked by Campaign. If you create a non-unique offer
code and use the offer code for response tracking, this might result in inaccurate
tracking results.

For more details about offer codes, see "Unique Code Administration" in the
Campaign Administrator's Guide.

Offer attributes
Offer attributes are the fields that define an offer. Offer Name, Description, and
Channel are examples of an offer’s attributes. Some attributes are specific to a type
of offer. For example, interest rate might be an attribute of a credit card offer, but
not of a "free shipping" offer.

There are three types of offer attribute:
v Basic — the minimum set of fields required to define an offer: the offer name,

the unique offer code, an offer description, and related products.
v Standard — optional, pre-defined fields for defining an offer, for example,

channel can be an optional attribute of an offer.
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v Custom — additional fields custom-created for your organization’s definitions of
offers, such as department, sponsor, promotional and go-to interest rates,
stock-keeping unit numbers (SKUs), and so on. Custom attributes can be added
to offer templates to further define an offer, or for offer analysis (for example,
you can group offers by custom attribute for roll-up analysis). For more details
about custom attributes, see “Custom Attributes” in the Campaign Administrator’s
Guide.

When you define offer attributes in an offer template, each attribute can be defined
as either static or parameterized. The same offer attribute (for example, channel),
could be static in one offer template, but parameterized in another.
v Static attributes — these are offer attributes whose values do not change when

you create a different version of the offer. For example, the channel, offer code,
offer name, and description are static offer attributes.

v Hidden static attributes — some static attributes, although part of the offer
definition, can be designed to be invisible to users when they use the offer
template to create offers. Hidden attributes therefore cannot be edited, but they
can be tracked and reported on in the same way as other offer attributes. For
example, a hidden static attribute could be the cost of the offer (the cost to your
organization of administering the offer). You cannot change the value of this
attribute, but it can be used in searches (for example, if you want to find all
offers that cost less than $1.00 to administer), or in reporting (for example, in
performance ROI analysis reports).

v Parameterized attributes — these are offer attributes whose values you can fill
in at offer assignment time by entering a value, choosing an option from a
pre-defined drop-down list, specifying the value by using a field in the database,
or by calculating values in derived fields. Any standard or custom offer attribute
can be set up to be a parameter by your administrators when they create offer
templates.

Parameterized attributes in offer templates have default values that you can
override when the offer is created and when it is assigned. For example, the
introductory interest rate for a credit card offer could be parameterized in its offer
template so that users can select 5.99%, 8.99%, or 12.99% as the default interest rate
from a drop-down list when they create an offer using this template. When the
offer is subsequently used in a flowchart and assigned to a cell, users can then
change the interest rate to a different value if necessary.

Offer versions

Note: The term "offer versions" as used starting in Campaign versions 7.x does not
have the same meaning as "offer versions" in earlier Campaign releases (5.1 to 6.x).
Offer versions do not appear in the offer tree hierarchy, and do not have version
names or codes. To uniquely identify specific instances of offer usage, you should
use treatment codes.

An offer version is created each time you vary the parameterized attributes of an
offer to create a unique combination.

For example, you can vary the following attributes in a credit card offer:
v The artwork (lighthouse, kittens, or racing cars);
v The introductory rates (5.99%, 8.99%, or 12.99%);
v The offer valid dates (valid during the month of January, June, or September).
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Thus, a card with the lighthouse image, 5.99% introductory rate and offer valid
from September 1–31, 2006, is a different version of the offer than a card with the
lighthouse image, 5.99% introductory rate and offer valid from January 1–31, 2007.

Offer templates
You create offers using the offer templates available to you in Campaign. These
templates will already have been created by a system or offers administrator. Each
offer template has a security policy that determines who can access and use the
template; you can only see offer templates to which you have access.

Using an appropriate template to create a new offer streamlines your offer creation
process. For example, if you create a credit card offer using a template that has
been designed for credit card offers, you will be completing only fields that are
relevant for credit card offers.

Your administrator can also create drop-down lists of values that you can choose
when you are filling in the offer information, saving time in data lookup and
reducing data entry errors. Offer attributes can be designed by your administrator
to have drop-down lists to which you are allowed to add new items when you use
the attribute in an offer. If new values are allowed, you will see an Add button
beside the offer attribute. When you add new values to such an attribute, you can
also delete the values you have added; you cannot delete values that you did not
add.

Offer templates define:
v the offer code format;
v the treatment code format;
v offer attributes and their display order;
v for each offer attribute where it is static, hidden, or parameterized;
v default values for offer attributes.

New offer templates can be added at any time, and there is no limit to the number
of templates defined in Campaign. The template is an inherent attribute of the
offers created from it, so you can search for offers using the template as a search
criterion.

Note: Offer templates cannot be deleted, but they can be retired by administrators
to prevent further use. Retired offer templates appear greyed out in the list of offer
templates, and they cannot be used for creating new offers.

For details about managing offer templates, see “Offer Template Administration” in
the Campaign Administrator’s Guide.

About offer lists
Offer lists are groupings of offers that you can create in Campaign to facilitate
assigning multiple or a possibly changing set of offers over time.

The same offer can exist in more than one offer list. Offer lists appear in the same
hierarchy as offers, but are identified by icons. Single offers have a single sheet
icon with dollar sign; static offer lists have a multiple sheets icon with a dollar
sign, and smart offer lists have the multiple sheets icon with a dollar sign and
magnifying glass.
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Like an offer, once an offer list has been used, it cannot be deleted, but it can be
retired.

Retired offer lists can no longer be assigned, and any assigned offer lists that have
been retired will no longer be given out.

There are two types of offer lists:
v “Static offer lists”
v “Smart offer lists”

Note: Offer list names have specific character restrictions. For details, see “Special
characters in IBM Unica Campaign object names,” on page 219.

Static offer lists
Static offer lists are pre-defined lists of offers whose contents do not change unless
you explicitly edit the list. A limitation of static offer lists is that default values are
used for any parameterized offer attributes.

Generally you use static offer lists to repeatedly reuse a specific, fixed set of offers.
For example, if you have 5 each of RFM (Recency, Frequency, Monetary) segments,
giving you 125 cells, and you want to assign the same offers to each cell, you can
create a single set of offers in a static offer list, and assign that offer list to all 125
cells. The same type of reusability applies across flowcharts and campaigns.

Smart offer lists
Smart offer lists are dynamic lists of offers which can resolve to different sets of
results each time a smart list is used. A smart offer list is specified by a query
which can be based on offer attributes, offer locations (folders or subfolders), offer
owner, and so on.

Generally you use smart offer lists for periodically recurring campaigns. You can
set up a cell to receive a smart offer list and then change the contents of the smart
offer list without having to modify the flowchart. For example, if you set up a
smart offer list to be the contents of a particular folder, then you can simply add or
remove offers to and from that folder to modify the offers given out each time the
campaign is run.

A further example for using smart offer lists involves setting up the smart offer list
to automatically return the offers you want to give out. If you want to give your
“high-value customer” cell the “best credit card offer” available, you can set up a
smart offer list that includes all credit card offers, sorted by the lowest interest rate
and with maximum size set to 1. The lowest interest rate credit card offer available
at the time(s) that the flowchart contact process is run is automatically found and
given to the high-value cell.

Security and offer lists
Object-level security applies to offer lists, based on the folders in which your offer
lists, and the offers included in your lists, reside.

When you create a static offer list, you can only add offers to which you have
access. However, anyone with permission to access an offer list is automatically
granted permissions to access the offers included in that list. Therefore, anyone
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who can access your list can also use that offer list and all the offers within it, even
if they would not normally have access to those offers based on their security
permissions.

Similarly, users who can access a folder containing a smart offer list can use that
smart offer list. They will get the same result as anyone else running that offer list,
even if they would not normally have access to particular offers (for example in
another division’s folders).

Treatments
Treatments are unique combinations of a cell and an offer version at a particular
point in time. Because they enable you to track responses in a very specific way,
using treatment codes for response tracking is a best practice.

Treatments are automatically created when you run a flowchart with contact
processes (Call List or Mail List) that have been associated with offers. Each
treatment is uniquely identified by a system-generated treatment code whose
format is specified in the offer template(s) from which the offer(s) were produced.
Treatment codes cannot be overridden by users.

Each time a contact process is run (except in test mode), Campaign records the
following details:
v The offer version(s) assigned in the contact process;
v The cell(s) to which the offers are assigned;
v The treatment code for each unique combination of offer version, cell, and

date/time;
v The contact process run date.

Running the same contact process twice (in production runs) creates two treatment
instances, each with a unique treatment code. This enables you to track responses
in a very specific way, back to an exact contact instance. For example, you could
run the same promotion on January 15 as you ran on February 15, and if you used
the treatment codes for tracking, people responding to the February 15 mailing
would be distinguishable from people responding to the January 15 mailing by
their treatment codes, even if they were targeted by both promotions.

Treatment codes are not available prior to flowchart runs because they are
generated only at run-time, and therefore are not suitable for pre-printed codes
requirements. However, they can be output as Campaign-generated fields for
tracking or on-demand print purposes.

Control groups
When you plan an offer, you should consider whether you want to use holdout
control groups for cells assigned that offer. Control groups are non-contact groups
that you can use to compare the "lift" or difference in response from an active
target cell that received an offer.

Controls are applied at the cell level in Campaign. When you assign offers to cells,
either in a contact process in a flowchart or from a target cell spreadsheet, you can
optionally specify one control cell for each target cell.
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Association of control cells to target cells
A single control cell can be used as the control for multiple target cells, but each
target cell may only have a single control cell, where the cell is defined by its
cellID. When a single control cell is used in multiple contact processes, you must
configure the control cell relationship for the target cell the same way in each
contact process. If different control relationships are required, create a copy of the
cell (e.g., by attaching a Select process and performing a Select All from the
previous cell). This will create another target cell to which you can apply a
different relationship to the control cell.

Working with offers
You can perform the following tasks relating to offers:
v “Creating new offers”
v “Duplicating offers” on page 119
v “To edit an offer” on page 120
v “To move an offer or offer list” on page 120
v “Adding offers to offer lists” on page 121
v “Deleting offers” on page 121
v “Retiring offers” on page 122
v “To assign an offer to a cell in a flowchart CSP” on page 144
v “Searching for offers” on page 124
v “To view offer reports from a Summary page” on page 125

Note: Working with offers requires the appropriate permissions. For information
on permissions, see the Campaign Administrator's Guide.

Creating new offers
You should create offers to represent the marketing messages you want to
communicate to your customers or prospects. Whether you create a new offer or
simply a version of an offer depends on how offer templates were defined by your
administrator.

You must create a new offer in the following situations:
v Whenever non-parameterized offer fields change;
v When you need a new offer code for tracking purposes (for example, for

pre-printing response codes on mailers).

In addition to creating a completely new offer, you can add an offer by duplicating
an existing offer and modifying it as required.

Note: To be able to create offers in a folder, you must have the appropriate
permissions in the security policy governing that folder.

To add a new offer

Note: Before you can create a new offer, you must have access permissions for at
least one offer template on which to base the offer.
1. Select Campaign > Offers.

You see the Offers page.
2. Click the Add an Offer icon.
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If you have more than one offer template in your Campaign system, you see
the Select an Offer Template page. If only one offer template exists, you do not
select a template; you are taken directly to the New Offer page.

3. Select the template on which to base your new offer. The selected offer
template’s name, description, suggested usages, offer and treatment code
formats, and static and parameterized attributes are displayed.

4. Click Continue.
You see the New Offer page.

5. Enter values for the new offer, including default values for any parameterized
attributes.
For attributes with values supplied in a drop-down list and that allow the
addition of list items, you can add list items here as you create the offer. Any
additions to the list are saved back to the offer custom attribute and are then
available to all users. Once you save changes, you cannot remove list items that
you add. Only administrators can remove items from lists, by modifying the
custom attribute.

Note: Offer names have specific character restrictions. For details, see “Special
characters in IBM Unica Campaign object names,” on page 219.

6. When you have finished entering your offer details, click Save Changes.
You see the Offer Summary page for the new offer.

Relevant products for offers
Relevant products is a required attribute in offer templates, although it does not
need to be populated in each offer. When you create an offer, you can specify a
query which returns the list of product IDs that you want to associate with this
offer. These product IDs can then be used for inferred response tracking to
determine whether an event (for example, a purchase) is considered to be a
response (for example, a purchase of one of the relevant products associated with
an offer is considered a response).

You can also import a list of product IDs during offer creation by copying them
from a source file and pasting them into Relevant Products definition when
creating a new offer.

To import a list of relevant products to an offer by pasting
1. In Campaign, when creating a new offer, on the New Offer page, click Import

Product IDs. The Select Products window opens.
2. Copy product IDs from your source file, using Copy from the context menu or

Ctrl+C.

Note: When copying product IDs, you can use one or more of the following
delimiters: tab, comma, or linefeed/newline. Multiple consecutive delimiters
are ignored. If product IDs are text strings, spaces are not stripped, and case is
preserved.

3. Paste the IDs that you have copied into the Import Product IDs list, using
Paste from the context menu, or Ctrl+V. While working in the Select Products
window, you can also manually add, edit, or delete entries from the Import
Product IDs list. There is no limit to the number of entries you can paste into
the Import Product IDs list.

4. When you have finished adding entries to the Import Product IDs area, click
Import.
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The IDs from the Import Product IDs area are imported and listed in the Select
Products Where section, with “PRODUCTID =” prepended to each product ID.
If any errors are detected during import (for example, alphabetic characters
when the Product ID field is numeric, or exceeding the maximum string length
for a text product ID), you see a pop-up for each error. Note each error and
click OK to view the next error.

Note: The Import feature only imports a product ID once; duplicate
occurrences of the same value are automatically ignored.

Note: You can continue to paste and import product IDs until you click Save
Changes on the Select Products window. Once you have exited the Select
Products window, you cannot import additional product IDs. Clicking Import
Product IDs again clears any existing query to allow you to begin anew. If you
do not want to clear your existing query, click Cancel when prompted for
confirmation.

5. When you have finished importing product IDs, click Save Changes. The
product IDs that were in the Select Products Where list are saved as a query for
the offer, and the list of product IDs is displayed under Relevant Product(s).

6. Continue creating the offer.

To edit the relevant products query for an offer

After importing a list of relevant products for an offer, the list is saved as a query.
You can edit this query, including adding additional query conditions, when you
edit the offer.
1. In Campaign, open the offer for which you want to edit the list of Relevant

Products.
2. Under the list of Relevant Products, click Edit Query . The Select Products

window opens, displaying the list of IDs currently in the query under Select
Product Where.

3. Edit the query, using the << button to remove a selected entry from the list, or
the up and down arrow buttons to change the order of entries. Add a query
clause using any attribute in the UA_Products table, including Product ID,
using the >> button to move it to the Select Products Where list.

4. When you have finished editing the query, click Save Changes to save the
query

5. On the offer Edit page, click Save Changes to save the offer.

To clear the relevant products query for an offer

After importing a list of relevant products for an offer, the list is saved as a query.
You can clear the entire query, including all existing product IDs in the query
when you edit the offer.
1. In Campaign, open the offer for which you want to clear the list of Relevant

Products.
2. Under the list of Relevant Products, click Import Product IDs . You see a

warning indicating that importing Product IDs will reset all existing conditions.
3. Click OK . The Select Products window opens, with no IDs displayed. You can

now import new Product IDs, or import no IDs to leave the query empty.
4. Click Save Changes to save the query
5. On the offer Edit page, click Save Changes to save the offer.
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To remove selected products from the relevant products query

You can remove selected products from the query rather than clearing the entire
query.
1. In Campaign, open the offer for which you want to remove selected product

IDs from Relevant Products.
2. In the list of Relevant Products, select the items you want to remove by holding

the Ctrl key and selecting with your mouse.
3. When you have finished selecting the items you want to remove, click Remove

. The selected items are removed from Relevant Products.
4. Click Save Changes to save the offer.

Duplicating offers
Duplicating existing offers to create new ones can save data entry time. Retired
offers as well as active offers can be duplicated. Offers that are created by
duplication are automatically assigned unique offer codes; they are named "Copy
of <original offer name>" and have the same description, security policy, and offer
attribute values as the original offer.

Note: Duplicated offers are created in the same folder as their originals, but can be
moved to a different location later. You must have the appropriate permissions to
be able to duplicate and move offers.

To duplicate an offer from the Offers page
1. Select Campaign > Offers. The Offers page appears.
2. Navigate to the folder containing the offer(s) you want to duplicate.
3. Select the checkbox(es) next to the offer(s) you want to duplicate.
4. Click the Duplicate Selected Offers icon. A confirmation window appears.
5. Click OK to continue. The selected offer(s) are duplicated and are displayed in

the list of offers.

To duplicate an offer from the offer's Summary page
1. On the Offer Summary page of the offer you want to copy, click the Create

Duplicate Offer icon. A confirmation window appears.
2. Click OK to continue. You see the New Offer page in Edit mode, with fields

pre-populated with values from the original offer but with a new offer code.
3. Edit the values that you want to change, including the offer name and

description.

Note: Offer names have specific character restrictions. For details, see “Special
characters in IBM Unica Campaign object names,” on page 219

4. Click Save Changes to create the new offer. The offer is saved; you are taken to
the Offer Summary page of the new offer.

Grouping offers
You might want to group offers for reporting or analysis purposes. For example,
you might want to see the response rates to a "Free Shipping" offer that was sent
through various channels and offered at different times of year.

Note: For any report to use an offer attribute for grouping or roll-up purposes, the
report must be customized by your report administrator.
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You can group offers in two ways.
v Using attributes
v In folders

Using attributes
You can create any number of custom attributes in your offers to use as "offer
grouping fields." For example, if you have various college-affiliation credit card
promotions, you could create a custom attribute called "region" that you can then
use in reports. This would allow you to group together offers targeted to alumni of
colleges in New England colleges versus those on the West coast.

When you create offers that use custom attributes, you must enter the values
manually. You can also duplicate a similar offer to reduce data entry effort, as the
values of parameterized attributes will also be copied.

Offer attributes can also be used within smart offer lists to identify and group
offers.

Grouping offers in folders
It can be useful to group offers in folders for reporting purposes. If you maintain
all related offers in the same folder, and specify the folder as the target when
prompted for offers to report on, all the offers in that folder (and in any of its
subfolders) are automatically selected for reporting.

Note: Including folder and subfolder contents for reporting in this way does not
achieve “roll up” reporting for the offers. They are simply selected based on
inclusion in a folder structure.

To edit an offer

You can edit an existing offer at any time, whether or not it has been used in a
contact process, depending on your roles and permissions.

Note: Once an offer has been used in production (once it has been assigned to a
cell in a flowchart that has been run in production and logged to contact history),
you can edit only the offer name, description, and default values for parameterized
offer attributes. This restriction ensures that Campaign can track the exact offer
details for offers that have already been given out to individuals.
1. Select Campaign > Offers. The Offers page appears.
2. Navigate to the offer you want to edit and click the hyperlinked offer name.

The offer’s Summary page appears in Read-Only mode.
3. Click the Edit icon to enter Edit mode.
4. Make your changes.

Note: Offer names have specific character restrictions. For details, see “Special
characters in IBM Unica Campaign object names,” on page 219

5. When you have finished making your changes, click Save Changes. Your
changes are saved and you are returned to the offer page in Read-Only mode.

To move an offer or offer list

You can move one or more offers among folders. The procedure for moving offers
is the same as that for moving offer lists, and you can move offers and offer lists in
the same operation.
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Note: When you move any objects in Campaign you must be aware that access to
different locations can be governed by different security policies. You can only
move offers into a folder with a security policy in which you have permissions to
do so.
1. From the Offers page, select the offer(s) or offer list(s) you want to move, and

click the Move Selected Items icon.
An alternative way to move an offer is to view its Offer Summary page and
click the Move to Another Folder icon. Be aware, however, that this alternative
method is available only for moving offers, not offer lists.
The Move Items To window appears.

2. Navigate to the folder to which you want to move the selected items.
3. Click Accept this Location.

The selected offer(s) or offer list(s) are placed in the folder you chose.

Adding offers to offer lists
You can add offers to static offer lists either when you create the offer list, or by
editing the list.

Note: Newly created offers can become part of smart offer lists with no action on
your part if they meet the smart offer list query criteria.

Deleting offers
You must have the appropriate permissions before you can delete an offer or offer
list. In addition, to preserve system integrity, Campaign will not allow you to
delete offers or offer lists that have been referenced in system tables. This includes
offers or offer lists that:
v are associated with a campaign;
v have been assigned to a cell in a contact process in a flowchart for which contact

history has been populated; or
v have been assigned to a cell in an Optimize process in a flowchart.

Important: If you attempt to delete an offer or offer list in these situations, a
confirmation message appears indicating that the offer or offer list will be retired
instead of deleted. To prevent further use of offers or lists that have been
referenced in system tables, you should retire rather than delete them.

If the offers you want to delete belong to any static offer lists, you will be asked to
confirm the deletion. If you choose to continue, the deleted offer(s) are
automatically removed from any static offer lists.

Contact processes containing cells that were assigned offers that have subsequently
been deleted will remain configured, but the offer will be indicated as "Unknown
Offer" in the process configuration dialog, and a warning will be produced when
the flowchart is run.

The procedure for deleting offers is the same as that for deleting offer lists, and
you can delete offers and offer lists in the same operation.

To delete an offer or offer list
1. From the Offers page, select the offer(s) or offer list(s) that you want to delete,

and click the Delete Selected Items icon.
OR
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From the Offer Summary page of the offer you want to delete, click the Delete
This Offer icon. A confirmation window appears.

2. Click OK. You are returned to the Offers page. The deleted offer(s) is (are) no
longer displayed.

Retiring offers
If you have the appropriate permissions, you can retire offers and offer lists to
prevent their further use. Retiring an offer does not affect campaigns or flowcharts
in which the offer has already been used, and maintains the data integrity with
any system table data that has been generated based on the offer, such as contact
and response history.

Retired offers remain visible in the offer hierarchy, but are grayed out. They can be
found using the search feature, can be duplicated to create new offers, and are
available for reporting. However, they can no longer be assigned, and cannot be
given out as part of an offer list.

You can clean up static offer lists by deleting retired offers from them. Smart offer
lists do not require cleanup as they will resolve only to non-retired offers matching
their query criteria.

Note: Once you retire an offer, you cannot re-enable it. Instead, if you need an
offer with the same details, you can create a new one by duplicating the retired
offer.

The procedure for retiring offers is the same as that for retiring offer lists, and you
can retire offers and offer lists in the same operation.

To retire an offer or offer list
1. From the Offers page, select any offers or offer lists that you want to retire, and

click the Retire Selected Lists icon.
An alternative way to retire an offer is to view its Offer Summary page and
click the Retire This Offer icon. However, this method is available only for
offers, not offer lists.

2. Click OK.

The selected offers and offer lists are retired and displayed in gray.

To assign offers to cells from the process configuration dialog

Note: If your Campaign environment is integrated with Marketing Operations,
you must use Marketing Operations to assign offers or offer lists to output cells in
the target cell spreadsheet form of a campaign project. If your Campaign
environment is configured to access legacy campaigns, use the instructions in this
guide to assign offers or offer lists to output cells in legacy campaigns. For legacy
campaigns, there are two ways to assign offers to cells: from the campaign's target
cell spreadsheet, or within a process configuration dialog. For more information,
see “About integration with IBM Unica Marketing Operations” on page 2.

You can assign offers or offer lists to an output cell from the configuration window
of a contact process.

Before you configure the contact process, ensure that the offer or offer list that you
want to use exists.
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1. In a flowchart in Edit mode, double-click the contact process containing the
cell(s) to which you want to assign your offer(s). You see the process
configuration dialog.

2. Click the Treatment tab.
You see the Assign offers to cells interface, displaying one row for each target
cell defined in the process.

3. For each target cell displayed in the table, click the Offer column to select from
a drop-down list of available offers, or click Assign Offers.

Note: If your input cell(s) are linked to a top-down cell defined in the Target
Cell Spreadsheet (TCS) and offers or offer lists have already been assigned to
the cell(s) in the TCS, those will be displayed here. You can override these
assignments if desired. Any changes you make in the contact process will be
reflected in the TCS after you save the flowchart.

4. To use holdout control groups, select the Use Holdout Control Groups
checkbox.
The offer assignment table dynamically updates to display additional columns
for indicating whether a target cell is a control, and what cell is a control for
the current cell.
a. For each cell, indicate whether it is a control cell by clicking in the Control?

column and selecting Y or N. By default, the setting is N. Cells that are
designated as control cells cannot be assigned offers. Once designated as
control cells, these cells appear in the Control Cell drop-down list, so that
you can select them as controls against target cells.

b. For each cell that is not a control cell, optionally specify a control cell from
the Control Cell drop-down list. This list is populated with the names of
cells for which you have indicated Control? = Y.

5. Click the Parameters tab to specify offer parameters for each cell. If the offers
you are assigning contain parameterized attributes, you can view the default
values and override those values if you want to. You see one row per
parameter per offer. For example, if one offer contains four parameterized
attributes, you will see four rows for that offer.

6. Use the For Cell(s) drop-down menu to indicate which cell(s) will have the
parameter values you specify applied to them.
If you have multiple cells and select [All Cells], you see one row per offer per
parameter. Values that you enter in the Assigned Value field are applied to
every cell that received that offer.
If the same offer is assigned to multiple cells but with different parameter
values for different cells, the [All Cells] view displays [Multiple Values] for
those parameters.
If you select an individual cell, the table displays only the offers assigned to the
cell you selected. Values that you enter in the Assigned Value field are applied
only to that cell.

Note: If you have many parameter values to enter, you can save data entry
effort by using the [All Cells] option to apply values that will be applicable to
most of the cells, then select individual cells to override their parameter values.

7. Edit the value(s) in the Assigned Value field(s) as required.

Note: You can use constants, derived fields, or table fields as the parameter
values.
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8. When you have finished assigning offers and specifying offer parameter values,
you need to complete the remainder of the process configuration.

Searching for offers
Campaign supports searches for offers but not for offer lists. You can perform a
basic search for offers using any of the following criteria:
v Name or partial name
v Description or partial description
v Offer code or partial offer code
v Owner name

In addition, you can use the Advanced Search feature to find offers or offer lists
using queries based on offer attributes and specified values.

To use Advanced Search to search for offers
1. From an Offers folder, click the Advanced Search icon.

The Advanced Search Options window appears.
2. In the Create a Condition section, select an offer attribute to use in the On

This Attribute field.
3. Based on the type of attribute you selected, you can enter further conditions for

searching. For example:
v On the attribute "Cost Per Offer", search for values less than or equal to

$10.00
v On the attribute "Expiration Date", search for specified date of 11/30/2007
v On the attribute "Description", search for specified values that do not contain

the string "2005"
4. Click AND>> or OR>> to move your set(s) of criteria to the Find Offers

Where section, and to build your query. To remove a condition from the Find
Offers Where section, click << .

Note: Depending on the operator(s) that you use in your query (for example,
=, >, contains, begins with, and so on), you might be able to select multiple
values or only a single value. Be aware that in some cases when you choose
multiple values with an operator, you create "OR" conditions. For example, if
you create a query where "Color =" and select blue, red, and white as the
colors, the query you create is "Color = blue OR color = red OR color = white."

5. When you have finished building your query, click Search.
The Search Results page displays any offers that match your search criteria.

All Offers page icons

The All Offers page uses the following icons

The icons, left to right, are described in the following table.
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Table 15. The All Offers page icons

Icon Name Description

Add an Offer Click to add a new offer.

Add a List Click to add a new offer list.

Add a Subfolder Click to add a new offer subfolder.

Advanced Search Click to open the Advanced Search Options dialog, where
you can specify attributes and values to search for offers.

Print this Item Select one or more offers by clicking the checkbox next to
each offer, then click this icon to print the selected offer(s).

Move Selected Items Select one or more offers by clicking the checkbox next to
each offer, then click this icon to move the selected offer(s).

Delete Selected Items Select one or more offers or offer lists by clicking the
checkbox next to each item, then click this icon to delete
the selected item(s).

Retire Selected Lists Select one or more offers or offer lists by clicking the
checkbox next to each item, then click this icon to retire the
selected item(s).

Duplicate Selected Offers Select one or more offers by clicking the checkbox next to
each offer, then click this icon to duplicate the selected
offer(s).

Reload Offers Click this icon to refresh the list of offers and offer lists on
the page.

To view offer reports from a Summary page

You can access reports on offers from their Summary pages. These are the same as
the reports available in the Campaign Analytics area of the application, except that
they provide data only for the current offer.
1. Click Campaign > Offers.

The Offers page appears.
2. Navigate through the folder structure to find the offer for which you want to

view a report.
3. Click the offer name.

The Offer Summary page appears.
4. Click the Analysis tab.
5. Select a report from the Report Type drop-down list.

Campaign displays the selected report.

Working with offer lists
You can perform the following tasks with offer lists:
v “To add a static offer list” on page 126
v “To add a smart offer list” on page 126
v “To edit an offer list” on page 127
v “Moving offer lists” on page 127
v “Deleting offer lists” on page 127
v “Retiring offer lists” on page 127
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v “Assigning offer lists to cells” on page 127

Note: Working with offer lists requires the appropriate permissions. Form
information on permissions, see the Campaign Administrator's Guide.

To add a static offer list
1. Select Campaign > Offers.

The Offers page appears.
2. Click the Add a List icon.

The New Offer List page appears.
3. Enter a name, security policy, and optionally a description for the offer list.

Note: Offer list names have specific character restrictions. For details, see
“Special characters in IBM Unica Campaign object names,” on page 219.

4. Leave the This is a smart offer list checkbox unchecked.
5. In the Included Offers section, use the Tree or List View to select offers to add

to your list. Move the selected offers to the Included Offers box using the >>
button.

6. When you have finished selecting your offers, click Save Changes. You are
returned to the Offer List Summary page for your new list.

To add a smart offer list
1. Select Campaign > Offers.

The Offers page appears.
2. Click the Add a List icon.

The New Offer List page appears.
3. Enter a name, security policy, and optionally a description for the offer list.
4. Select the This is a smart offer list checkbox.
5. In the Included Offers section, use existing offer attributes, their values, and

the AND and OR operators to create conditions for including offers in this offer
list.

6. If desired, use the folder view under Restrict search access (for all users) to
limit the search to selected folders. To include subfolders in search results,
select the Include Subfolders checkbox.

Note: Any offers chosen as a result of this search will be available to any user
with access permissions to this offer list, even if they do not normally have
permissions to see or access the offers.

7. If desired, use the drop-down lists under Order Matching Offers by to select
the offer attribute by which you want matching orders to be sorted, and
whether the sort is in Ascending or Descending order.

8. If desired, indicate whether you want to limit the search results to the first "X"
offers matching. By default, there is no limit.

9. When you have finished defining the criteria for your smart offer list, click
Save Changes. You are returned to the Offer List Summary page for your new
list.
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To edit an offer list

After you save your offer list changes, any campaigns using offer lists will
automatically use the latest offer list definitions when they are next executed.
1. Select Campaign > Offers.

The Offers page appears.
2. Click the hyperlinked name of the offer list that you want to edit.

The Summary tab for the offer list appears.
3. Click the Edit icon.

The offer list details appear in Edit mode.
4. Make the desired changes.

Offer list names have specific character restrictions. For details, see “Special
characters in IBM Unica Campaign object names,” on page 219.

5. When you have finished making your changes, click Save Changes. You are
returned to the Offer List Summary page for your list.

Moving offer lists
You can move one or more offer lists among folders by performing the same steps
as you do to move offers, and you can move offers and offer lists in the same
operation.

Deleting offer lists
You can delete one or more offer lists by performing the same steps as you do to
delete offers, and you can delete offers and offer lists in the same operation.

Retiring offer lists
You can retire an offer list at any time to prevent its further use. Retiring an offer
list does not affect the offers contained in that list.

Retired offer lists remain visible in the offer hierarchy, but are grayed out. They are
available for reporting; however, they can no longer be assigned.

Note: Once you retire an offer list, you cannot re-enable it. If you need an offer list
with the same details as a retired one, you must manually recreate it.

You retire offer lists by performing the same steps as you do to retire offers, and
you can retire offers and offer lists in the same operation.

Assigning offer lists to cells

Note: If your Campaign environment is integrated with Marketing Operations,
you must use Marketing Operations to assign offers or offer lists to output cells in
the target cell spreadsheet form of a campaign project. If your Campaign
environment is configured to access legacy campaigns, use the instructions in this
guide to assign offers or offer lists to output cells in legacy campaigns. For legacy
campaigns, there are two ways to assign offers to cells: from the campaign's target
cell spreadsheet, or within a process configuration dialog. For more information,
see “About integration with IBM Unica Marketing Operations” on page 2.

You can assign offer lists to cells in contact processes in the same way as you
assign individual offers. You can assign any combination of offers and offer lists to
the same cell.
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However, any parameterized attributes in the offers contained in the offer list will
use their default values. You will not be able to assign parameter values for offers
contained in the offer list. If you need to change parameterized values, you can do
one of the following:
v change the default value(s) associated with the existing offer, create a copy of the

offer with the desired defaults, and ensure that it is used in the offer list;
v assign the offer individually, outside of an offer list.

Managing offers when Marketing Operations is integrated with
Campaign

If your IBM Unica Campaign environment is integrated with IBM Unica Marketing
Operations, there are two options for offer management.
v If your system is configured so that offers are managed through the Marketing

Operations version of the feature, then you use the Offers option from the
Operations menu. For information about creating offers in this way, see the IBM
Unica Marketing Operations and Campaign Integration Guide.

v If your system is configured so that offers are managed through the Campaign
version of the feature, then you use the Offers option from the Campaign menu.

Ask your system administrator which offer management option is configured on
your system.

Introduction to using Marketing Operations assets in Campaign offers

If both Marketing Operations and Campaign are installed, and you have licensed
the IBM Unica Marketing Asset Management add-on for Marketing Operations,
your campaigns can include digital assets from your Marketing Operations asset
libraries. For example, an offer can include a product logo that is stored in a
Marketing Operations asset library.

To include an asset in an offer, a user creates an offer based on a template that
includes the CreativeURL attribute. A "Creative URL" is a pointer that indicates
the location of an asset in Marketing Operations. The asset that the CreativeURL
attribute points to is included in the offer.

The CreativeURL attribute allows users to move seamlessly from Campaign to
Marketing Operations when configuring offers, offer templates, or campaigns.

For example, when creating or editing a campaign, you can go from a Target Cell
Spreadsheet (TCS) cell to the offer related to that cell. From the offer, you can go to
the related asset in Marketing Operations, where you can view or modify it. You
can also upload a new asset to the library for immediate use in the campaign.

The following example shows one possible workflow. Your workflow might differ.

Important: Campaign may or may not be integrated with Marketing Operations.
However, offer integration must not be enabled. Offer creation is performed in
Campaign.
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How to use a Marketing Operations asset in a Campaign offer
This topic explains how to relate a digital asset from Marketing Operations to a
Campaign offer.

An asset is an electronic file that is designed for use in a marketing program.
Examples include logos, brand images, marketing research documents, reference
materials, corporate collateral, or document templates. If you use both Marketing
Operations and Campaign, you can include a file from a Marketing Operations
asset library as part of a Campaign offer. To include an asset in an offer, you use
the CreativeURL attribute. A "Creative URL" is a pointer to a file in a Marketing
Operations asset library

Table 16. How to use a Marketing Operations asset in a Campaign offer

Task Details

Prerequisite: Create and populate
an asset library in Marketing
Operations.

Marketing Operations administrators create asset libraries, which serve as
repositories for files. Marketing Operations users can upload digital assets and
organize them in folders within the asset libraries.

For a list of prerequisites and guidelines, see the Campaign Administrator's
Guide.

Prerequisite: Add the CreativeURL
attribute to an offer template.

Campaign administrators add the CreativeURL attribute to an offer template
when defining the template.

For more information, see the Campaign Administrator's Guide.

Chapter 6. Offers 129



Table 16. How to use a Marketing Operations asset in a Campaign offer (continued)

Task Details

Create an offer based on a template
that includes the CreativeURL
attribute, and relate one asset to the
offer.

1. Select Campaign > Offers, click the Add an Offer icon, and select a
template that includes the CreativeURL attribute.

2. Use the New Offer page to define the offer (name, security policy, and
other information), then click Browse Library in the Creative URL. (Steps 2
- 5 can also be done from the Target Cell Spreadsheet view mode.)
Note: In an integrated UMO-UC environment, you can type the URL in
the Creative URL field for an asset stored in another location, such as on a
server.

3. In the pop-up, click a library to open it. The library window opens.

4. In the library window, go to a folder in the asset library, and select the
asset that you want to use in this offer.

5. To add an asset, click Add Asset, then define the asset name, owner, and
other information. In the File field, click Upload, then browse to the asset.
You can upload a File, Preview File, or Thumbnail.

6. Follow the prompts to select and upload assets to the library, save changes,
and accept the asset.

7. Click Save Changes to save the offer.

A link to the specified asset is now included in the Creative URL field.

Assign offers to cells in the
campaign Target Cell Spreadsheet
(TCS).

1. Go to the All Campaigns page, click a campaign, select the Target Cells tab,
and edit the TCS.

2. Click in the Assigned Offers column and click Select one or more offers.

3. Use the Select Offers window to select the offer you created.

4. Save and exit the TCS.

Your campaign now includes a digital asset from Marketing Operations.
Typically, a campaign now goes through a review and adjustment process,
which is explained in the following steps.

Optionally, modify the offer. 1. Go to the All Campaigns page, click a campaign, select the Target Cells tab,
and edit the TCS.

2. Click in the Assigned Offers column and click View offers.

3. The View/Edit Offer window opens. Select the offer and click Preview. (If
you decide to remove an offer, select it and click Remove.)

4. To open the offer for editing, click the Edit icon at the top of the pop-up
window.

5. With the offer open for editing, you can edit the values of parameterized
attributes. You can also access Marketing Operations assets:

a. Click the Browse Library link in the Creative URL field.

b. In the window that opens, click a library.

c. In the resulting window, go to a folder in the asset library, and select an
asset to use in this offer.

d. If you want to add an asset, click Add Asset, then provide the required
information. In the File field, click Upload, then browse to the asset.
You can upload a File, a Preview File, or a Thumbnail. Follow the
prompts to complete the action.

e. Click Save Changes to save the offer.

A link to the selected asset is now included in the Creative URL field.

Save and exit. Close the windows in IBM Marketing Operations and return to the Campaign
TCS. Save and exit the TCS.
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Chapter 7. Cells

A cell is a list of identifiers (such as customer or prospect IDs from your database)
to which you assign one or more offers in Campaign.

You create cells by configuring and running data manipulation processes in
flowcharts. These output cells can also be used as input for other processes in the
same flowchart (downstream from the process that created them).

Each cell generated in a flowchart has:
v a system-generated cell code. The cell code has a standard format determined by

your system administrators, and is unique when generated. Cell codes are not
checked for uniqueness unless the flowchart configuration parameter
AllowDuplicateCellCodes is set to "No," in which case cell codes are enforced to
be unique only within the current flowchart. For details about cell codes and cell
code generators, see the Campaign Administrator's Guide. For details about
configuration parameters provided by IBM Unica Marketing, see the Marketing
Platform Administrator's Guide.

v a system-generated cell name, unique within the current flowchart.

In addition to creating cells in flowcharts, you can also create placeholder cell
codes in the target cell spreadsheet, to which you can later link cells created in
flowcharts.

Cell names and codes
Cell names and codes are important because they establish the links between
processes that output cells or use cells as input.

Cell codes

Cell codes have a standard format determined by your system administrators, and
are unique when generated. Because cell codes can be edited, they are not checked
for uniqueness unless the flowchart configuration parameter
AllowDuplicateCellCodes is set to "No," in which case cell codes are enforced to be
unique only within the current flowchart. There is no checking for uniqueness in
the target cell spreadsheet (TCS). For details about cell codes and cell code
generators, see the Campaign Administrator’s Guide. For details about configuration
parameters provided by IBM Unica Marketing, see the Marketing Platform
Administrator’s Guide.

Cell names

Note: Cell names have specific character restrictions. For details, see “Special
characters in IBM Unica Campaign object names,” on page 219.

By default, cell names are based on the process from which they are generated (for
example, if a cell is generated by a process named "Select1", then the default cell
name is "Select1") but they can be overridden. If you change a process name, the
names of cells generated by that process are automatically changed as well, both in
that process and in any connected downstream processes within the same
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flowchart. If you change a cell name, you might also affect the links between that
cell and any downstream processes using that cell as input.

For example, if you have a Segment process that generates two output cells named
Segment1 and Segment2, and these cells are used as input into two Mail List
processes (Mail List 1 and Mail List 2), if you change the names of the Segment
cells after you have already connected the Mail List processes, you need to
understand how Campaign handles the new cell names.

The following diagram illustrates a basic example of a Segment process that
outputs two cells, each cell then becoming the input for downstream Mail List
processes.

Segment
process

Mail List 1
process

Mail List 2
process

Output cell
"Segment1"

Output cell
"Segment2"

Examples: cell renaming scenarios
Scenario 1: All new cell names are different from any of the
original names

If no new cell names overlap with the original default names (that is, in the
example, if you do not use "Segment1" or "Segment2" as the name for either of the
Segment output cells), then Campaign can maintain the original linkages based on
the original "order" of the cells. In this situation, because there is no overlap or
re-use of either of the original cell names, the linkage between the output cells
from the Segment process and the two respective Mail List processes remains
unchanged, as shown in the following diagram.
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process

Mail List 1
process

Mail List 2
process

Output cell
"Segment1"

renamed
"NewName1"

Output cell
"Segment2"

renamed
"NewName2"

Linkages do
not change

because new
cell names do

not overlap 
with or reuse

the original set
of names

Input cell
"Segment1"

Input cell
"Segment2"

Scenario 1:
All new cell names are different

from any of the original cell names

Scenario 2: The set of new cell names is identical to the original
set of cell names, but re-ordered

If the new names you choose for your cells are exactly the same as the names in
the original set and simply re-ordered, the downstream processes will look for
available output cells by name (that is, the new cell names), and the linkages will
be switched as necessary. In the example, the newly renamed Segment2 output cell
is now the input cell to Mail List 2, and the newly named Segment1 cell is now the
input cell to Mail List 1, as shown in the following diagram.

Segment
process

Mail List 1
process

Mail List 2
process

Output cell
"Segment1"

renamed
"Segment2"

Output cell
"Segment2"

renamed
"Segment1"

Scenario 2:
New cell names are identical to original 

set of cell names, but re-ordered

Linkages 
change based 

on new cell 
names 

Input cell
"Segment1"

Input cell
"Segment2"

The following diagram illustrates the same situation with three output and input
cells.
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Segment
process

Mail List 1
process

Mail List 2
process

Output cell
"Segment1"

renamed
"Segment2"

Output cell
"Segment2"

renamed
"Segment3"

Linkages change based on cell names. The 
downstream processes are relinked based on the
original output cell names that they were linked to.

Input cell
"Segment1"

Input cell
"Segment2"

Scenario 2a:
New cell names are identical to original 

set of cell names, but re-ordered

Mail List 3
process

Output cell
"Segment3"

renamed
"Segment1"

Input cell
"Segment3"

Scenario 3: The set of new cell names overlaps with some of the
original cell names, and new cell names are introduced

If the new names overlap with some of the original names, and new cell names are
added, any links using names in the original set of cell names can be recognized,
otherwise they are broken. For example, if you rename cell "Segment1" to
"Segment2" and rename cell "Segment2" to "NewSegment", the new "Segment2"
will be hooked up to Mail List2 and Mail List1 will become unconfigured, because
it cannot find an input cell name with the name "Segment1."

Segment
process

Mail List 1
process becomes

unconfigured

Mail List 2
process

Output cell
"Segment1"

renamed
"Segment2"

Output cell
"Segment2"

renamed
"NewSegment"

Input cell
"Segment1"

cannot be found
Input cell

"Segment2"

Scenario 3:
New cell names are introduced

to original set of cell names

Working with cells
You can perform the following tasks with cells:
v “To create a cell in a flowchart process” on page 135
v “Limiting the size of output cells” on page 135
v “Changing the cell name” on page 139

134 IBM Unica Campaign: User's Guide



v “Resetting the cell name” on page 140
v “About copying and pasting cell names and codes” on page 140
v “Changing the cell code” on page 141
v “To link flowchart cells to target cells using the process configuration dialog” on

page 143
v “To unlink flowchart cells from target cells using the process configuration

dialog” on page 144
v “To assign an offer to a cell in a flowchart CSP” on page 144
v “Assigning offer lists to cells” on page 145
v “To set parameters in offers assigned to cells” on page 145

To create a cell in a flowchart process

You create cells as the output of any data manipulation process (such as Audience,
Extract, Merge, or Select) in a flowchart.
1. In a flowchart in Edit mode, configure a data manipulation process.
2. When you run the process, one or more cells (depending on the type of process

and the configuration details) are created as the output of the process.

Note: In addition to creating cells in flowcharts, you can also create
placeholder cells in the target cell spreadsheet, then later link them to cells in
flowcharts.

Limiting the size of output cells
To limit the number of IDs generated by data manipulation processes such as
Audience, Extract, Merge, or Select, click the Cell Size Limit tab of the process
configuration dialog.

The options that you have for limiting output cell size depend on whether the
process accepts input from a cell or a table. In processes that can accept either type
of input, the Cell Size Limit window changes dynamically to present options
appropriate to the input type.
v Processes taking input from an output cell
v Processes taking input from a table

For either type of input, you can also change the random seed for use in selecting
IDs randomly.

Processes taking input from an output cell
If the process takes input from an output cell, use the Cell Size Limit tab to limit
the number of IDs to be output.
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On this window, you specify the limits that you want to place on the output cell
size.
v Unlimited cell size returns all IDs satisfying the query or selection criteria on

the tab of this process. This is the default option.
v Limit output cell size to returns an exact specified number of unique IDs,

selected randomly from all IDs that meet your query criteria. In the text box,
enter the number of IDs that you want returned. With this method, for processes
taking input from cells, Campaign matches the deduplicated records returned
from the database to those of the input cell(s), then performs a random selection
to arrive at the final cell size. Note that the ID list in cells passed from process to
process is always unique.

Note: Selecting records with the Random option uses a large amount of temporary
space and takes the most time, because all IDs must be retrieved to the Campaign
server. Use this option only when it is important for exactly N records to be
returned.

Limiting the output cell size based on the input cell size
In processes that take input from cells, you can use the sizes of cells from
connected incoming processes as attributes for limiting the output cell size, even if
you are not using the actual cell data or IDs.

For example, if you connect 3 processes that each have one output cell, to a Select
process, you might use only one of the three incoming cells as the actual data
input for the Select process, but you can use the attributes of the other incoming
cells to specify the output cell size for the Select process. A solid line connects the
process whose output cell is actually used by the Select process; dotted lines
connect the processes whose output cells are not used as data input but only have
a temporal relationship with the Select process.
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Use the Limit output cell size based on sizes of input cells checkbox to specify
the input cells whose size attributes you want to use for limiting your current
process’s output cell size. Some of these options act in conjunction with the Limit
output size to value that you specify.

To limit output cell size based on size of input cells:

1. Click the Cell Size Limit tab in the process.
You see the Cell Size Limit window.

2. Choose the method by which the limits will be calculated by selecting an
option from the pull-down list:
v Largest Checked Cell — specifies that the output cell size should not exceed

the size of the largest selected input cell. For example, if cells A, B, and C are
checked, with sizes of 250, 500, and 100 respectively, the size of the output
cell for this process would be limited to 500, the largest of the input cell
sizes.

v Maximum Size (Above) Minus Sum of All Checked Cells — use this
option in conjunction with the Limit output cell size to value specified
above. This option specifies that the output cell size should not exceed ,
where is the difference between the number specified in the Limit output
cell size to field above, and the sum of all selected input cells. For example,
if you entered 1000 as the Limit output cell size to value, and checked input
cells A and B with sizes 100 and 200 respectively, the size of the output cell
for this process would be limited to 1000 – (100+200) = 700.

v Size of Any Checked Cells — specifies that the output cell size should not
exceed the size of any of the selected input cells. For example, if cells A, B,
and C are checked, with sizes of 250, 500, and 100 respectively, the size of the
output cell for this process would be limited to 100, the smallest of the input
cell sizes.

v Sum of All Checked Cells — specifies that the output cell size should not
exceed the total size (sum) of all the selected input cells. For example, if cells
A, B, and C are checked, with sizes of 250, 500, and 100 respectively, the size
of the output cell for this process would be limited to 850, the sum of all
three of the input cell sizes.

3. In the list of input cells, select the checkboxes for the input cells on whose
size(s) you want the output cell size criteria to be based.

Processes taking input from a table
If the process takes input from a table (or a strategic segment, in processes that
allow this option), the Cell Size Limit window appears.
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Use this window to specify limits on the output cell size. The key differences
between the Limit options is in their impact on resources and the final number of
resulting records when your data source is non-normalized.
v Unlimited cell size: Returns all IDs that meet the query or selection criteria on

the tab of this process. This is the default option.
v Limit output cell size to: Returns an exact specified number of unique IDs,

selected randomly from all IDs that meet your query criteria. Enter the number
of IDs that you want returned. Campaign deduplicates the complete set of IDs
prior to random selection, then retains only the specified number of records, so
that a list of unique IDs is returned even when duplicates exist on the ID fields.

Note: Selecting records with this option uses a large amount of temporary space
and takes the most time, because all IDs must be retrieved to the Campaign
server. Use this option only when the data is not normalized on the ID field, and
if it is important that exactly N records are returned.

v Limit selection based on: Use these options to limit Campaign records that meet
your query criteria. These options reduce the time and memory resources used
in selecting the final set of records, but can result in fewer than your specified
number of unique IDs.
– First N (fastest): Campaign retrieves only the first records that meet your

query criteria from the database. Campaign stops accepting records once the
number of records has been received. Campaign then deduplicates these IDs;
if the data has not been normalized, then your final result contains fewer than
unique records. This is the fastest method because it takes less time to retrieve
data and uses less temporary space.

– Random: Campaign retrieves from the database all records that meet your
query criteria, then selects number of records randomly from those records.
Campaign then deduplicates these retained IDs; if the data has not been
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normalized, your final result contains fewer than unique records. This option
uses less temporary space because only the randomly selected records are
retrieved and stored by Campaign.

Applying test run output cell size limitations
In some processes, including Audience and Select, you can also limit cell size
specifically for test runs. Use the options in this section to control the amount of
data returned and subsequently processed during a test run.
v Unlimited cell size — this is the default option. The number of IDs returned

from the query or selection criteria on the Source tab of this process is not
changed. With this option, the test run operates on all the data that it would
during a production run, but offer and contact histories are not populated.

v Limit output cell size to — returns an exact specified number of IDs, selected
randomly from all IDs that meet your query criteria. In the text box, enter the
number of IDs that you want returned. With this method, Campaign
deduplicates the complete set of IDs prior to random selection, then retains only
the specified number of records, so that a list of unique IDs is returned even
when duplicates exist on the ID fields.

Note: Selecting records with this option uses a large amount of temporary space
and takes the most time, because all IDs must be retrieved to the Campaign server.
Use this option only when the data is not normalized on the ID field, and if it is
important for exactly N records to be returned.

Changing the cell name
By default, the name of a cell created in a process matches the process name. For
processes that create more than one cell, the output cell names are a concatenation
of the process name and the segment name. For example, a Segment process
named "Segment1" creating 3 segments will have output cells whose default names
are "Segment1.Segment1", "Segment1.Segment2", and "Segment1.Segment3."

Cell names are designed to be linked to the name of the process from which they
were created. If you edit a process name, the cell names will automatically change
as well.

However, if you edit the cell names, you remove their link to the process name.
This means that if you subsequently change the process name, the cell name(s) will
no longer automatically change.

To change the name of a cell in a flowchart process

Note: When you save changes to the output cell name, if Auto Generate is
selected for the cell code, the cell code is regenerated. If you do not want the cell
code to change, uncheck Auto Generate prior to editing the cell name.
1. In a flowchart in Edit mode, double-click the process whose output cell name

you want to change. You see the process configuration dialog for the process.
2. Click the General tab. You see the general information for the process,

including the process name and the output cell name.
3. Place your cursor in the Output Cell Name field so that the text is selected,

and edit the cell name.
4. Click OK. Your changes are saved. If you have edited the cell name so that it

no longer matches the process name, these names are no longer linked.
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Note: Saving a flowchart does not trigger any type of validation. To check that
your flowchart has configured correctly with no errors, you can manually
perform a flowchart validation.

Resetting the cell name
By default, the name of a cell created in a process matches the process name. For
processes that create more than one cell, the output cell names are a concatenation
of the process name and the segment name. For example, a Segment process
named "Segment1" creating 3 segments will have output cells whose default names
are "Segment1.Segment1", "Segment1.Segment2", and "Segment1.Segment3."

If you rename the process, the cell name(s) will automatically change as well, so
that the cell name and process name remain linked.

However, if you have change the cell name manually so that it is different from the
process name, the cell and process names are no longer linked. You can restore the
link by renaming the cell name to the same as the process name.

To reset the cell name
1. In a flowchart in Edit mode, double-click the process whose output cell name

you want to reset. You see the process configuration dialog for the process.
2. Click the General tab. You see the general information for the process.
3. The next step varies depending on whether you are editing a process that

outputs a single cell or multiple cells:
v In processes that output a single cell, edit the text in the Output Cell Name

field so that it is identical to the process name displayed in the Process Name
field.

v In processes that output multiple cells, click Reset Cell Names. The cell
names revert to the default format, which is a concatenation of the current
process name and the segment name.

The process and cell names are now relinked. If you now change the process
name, the output cell name will automatically change as well.

4. Click OK. Your changes are saved and the process configuration dialog closes.

About copying and pasting cell names and codes
In processes that output more than one cell, you can use the copy and paste
feature to edit multiple output cell names and codes in the Output Cells grid.

To copy and paste all cells in the grid

In processes that output more than one cell, you can use the copy and paste
feature to edit multiple output cell names and codes in the Output Cells grid.
1. In a flowchart in Edit mode, double-click the process for which you want to

copy and paste cell names and codes. You see the process configuration dialog
for the process.

2. Click the General tab. You see the general information for the process,
including the Output Cells grid.

3. In the Output Cells grid, click anywhere to select all cells. All cells are always
selected for pasting regardless of the cursor position.

Note: The Cell Code column is not selectable or editable unless you clear the
Auto Generate Cell Codes checkbox.

4. Click Copy. All cells are copied to the clipboard.
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5. Click inside the cell that will be at the top left position of where you want to
paste the cells.

6. Click Paste. The contents of your copied cells replaces the original content of a
block of cells the same size as that which was copied.

To paste cell names and codes from an external spreadsheet
1. Select and copy cells or text from an external spreadsheet or other application

using that application’s copy feature.
2. In Campaign, in a flowchart in Edit mode, double-click the process for which

you want to copy and paste cell names and codes. You see the process
configuration dialog for the process.

3. Click the General tab. You see the general information for the process,
including the Output Cells grid.

Note: The Cell Code column is not selectable or editable unless you clear the
Auto Generate Cell Codes checkbox. If you want to paste content into the Cell
Code column, make sure you clear this checkbox.

4. Click inside the cell where you want to paste what you have copied. If you are
copying and pasting a rectangular group of cells, click inside the cell that will
be the top left cell of the rectangle.

5. Click Paste. The contents of your copied cell(s) replaces the original contents of
a block of cells the same size.

Changing the cell code
By default, a cell’s code is automatically generated by the system, based on the
format defined for all cell codes by your system administrators. Cell code
uniqueness is enforced across flowcharts and campaigns, but cell codes can be
duplicated within flowcharts if you have the flowchart configuration parameter
AllowDuplicateCellCodes set to "Yes."

For more details about configuration parameters in the central configuration
parameter provided by IBM Unica Marketing, see the Marketing Platform
Administrator’s Guide.

Note: Although you can override the default system-generated cell code, any cell
code you enter manually must still conform to the cell code format. This format is
displayed below the Cell Code field in the process configuration dialog. Code
formats are represented by constants and variables as follows: uppercase letters
represent alphabetical constants, a lowercase "n" represents a numeric character.
For example, a cell code format of "Annn" indicates that the cell code must be 4
characters long, with the first character being uppercase "A", followed by 3
numbers. A sample cell code of this format would be "A454."

To change the code for a cell in a flowchart process
1. In a flowchart in Edit mode, double-click the process whose output cell name

you want to change. You see the process configuration dialog for the process.
2. Click the General tab. You see the general information for the process.
3. Clear the Auto Generate checkbox if it is selected. The Cell Code field becomes

editable.
4. In the Cell Code field, edit the cell code. Remember that the modified code

must conform to the cell code format displayed below the Cell Code field.
5. When you have finished editing the cell code, click OK. The process

configuration dialog closes and your changes are saved.
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To match and link flowchart cells using the Match and Link
Target Cells dialog

In addition to linking cells from each process's configuration dialog, you can link
and manage target cells for the entire flowchart from the Match & Link Target
Cells dialog. Before you do this, make sure placeholder cell codes and names exist
in the target cell spreadsheet for the campaign. If you want to perform
Automatching, make sure the cells defined in the target cell spreadsheet have the
same name, or names starting with at least the same three characters as the output
cell names.
1. In a flowchart in Edit mode, select the Options > Match & Link Target Cells

option.
You see the Match and Link Target Cells dialog, displaying Available Target
Cells in the left pane, and flowchart output cells in the right pane.

2. To automatically match target cells and flowchart output cells based on name,
click Automatch.
Successfully automatched cells have a status of Exact or Best Match displayed
in the right pane. Target cells that have been matched display in red.

3. To complete the linking of these matched pairs of cells, click OK to save and
close the dialog.
You see a warning indicating that the flowchart run results will be lost. Click
OK to continue.
The next time you view the Match & Link Target Cells dialog for this
flowchart, you see that the status of the cells you matched and linked is
displayed as Linked.

Note: Target cell linkages are not saved in the database until you save the
flowchart. If you cancel changes in the flowchart, cell linkages are not saved to
the database.

To unmatch or unlink flowchart cells using the Match and Link
Target Cells dialog

Note: Unlinking cells that have associated contact history causes these cells to be
"retired". Because retired cells are not displayed in the target cell spreadsheet, they
will no longer be visible there. To retain cells in the target cell spreadsheet, delete
contact history for the cell before unlinking it.
1. In a flowchart in Edit mode, select the Options > Match & Link Target Cells

option.
Any matched or linked cells are displayed in the right pane, with their status
indicated in the Status column.

2. To unmatch all matched cell pairs, click Unmatch All.
The unmatched target cells are refreshed in the Available Target Cells pane,
and the output cell Status and Target Cell Name columns are cleared. Linked
pairs of cells are not changed.

3. To unlink all linked cell pairs, click Unlink All.
Previously linked pairs are unlinked, but they remain matched. The target cells
now appear in the Available Target Cells list in red, as matched target cells.
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Note: Target cell linkages are not saved in the database until you save the
flowchart. If you cancel changes in the flowchart, cell linkages are not saved to
the database.

To manually match and link flowchart cells using the Match
and Link Target Cells dialog

1. In a flowchart in Edit mode, select the Options > Match & Link Target Cells
option.
You see the Match and Link Target Cells dialog, displaying Available Target
Cells in the left pane, and flowchart output cells in the right pane.

2. Select one or more pairs of target cells and flowchart output cells to match, and
click Match > >.
The selected target cells are matched, in order, with the selected flowchart
output cells. Successfully matched output cells have a status of Manual
displayed, and target cells that have been matched display in red.

3. To complete the linking of these matched pairs of cells, click OK to save and
close the dialog.
You see a warning indicating that the flowchart run results will be lost. Click
OK to continue.
The next time you view the Match & Link Target Cells dialog for this
flowchart, you see that the status of the cells you matched and linked is
displayed as Linked.

Note: Target cell linkages are not saved in the database until you save the
flowchart. If you cancel changes in the flowchart, cell linkages are not saved to
the database.

To link flowchart cells to target cells using the process
configuration dialog

Before you do this, make sure placeholder cell codes and names exist in the target
cell spreadsheet for the campaign.
1. In a flowchart in Edit mode, double-click the process whose output cell(s) you

want to link to cell(s) in the target cell spreadsheet. You see the process
configuration dialog for the process.

2. Click the General tab. You see the general information for the process.
3. Access the Select Target Cell window.

v In processes that output a single cell, such as Select, click Link to Target
Cell....

v In processes that output multiple cells, such as Segment, click the Output
Cell Name or Cell Code row for each cell that you want to link. Click the
ellipsis button that appears.

You see the Select Target Cell window, displaying the cells defined in the target
cell spreadsheet for the current campaign.

4. In the Select Target Cell window, select the row for the cell to which you want
to link the current output cell.

5. Click OK. The Select Target Cell window closes. The Output Cell Name and
Cell Code in the process configuration dialog are replaced with the code and
name of the cell in the target cell spreadsheet. These are italicized, indicating
that they are linked to the target cell spreadsheet.

6. Click OK. The process configuration dialog closes and your changes are saved.
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To unlink flowchart cells from target cells using the process
configuration dialog

Important: Unlinking cells that have associated contact history causes these cells to
be "retired". Because retired cells are not displayed in the target cell spreadsheet,
they will no longer be visible there. To retain cells in the target cell spreadsheet,
delete contact history for the cell before unlinking it.
1. In a flowchart in Edit mode, double-click the process whose output cell(s) you

want to unlink from cell(s) in the target cell spreadsheet. You see the process
configuration dialog for the process.

2. Click the General tab. You see the general information for the process.
3. Access the Select Target Cell window.

v In processes that output a single cell, such as Select, click Link to Target
Cell....

v In processes that output multiple cells, such as Segment, click the Output
Cell Name or Cell Code row for the cell that you want to unlink. Click the
ellipsis button that appears.

You see the Select Target Cell window, displaying the cells defined in the target
cell spreadsheet for the current campaign. The currently linked cell is
highlighted.

4. In the Select Target Cell window, select [Not Linked]. The cell name and code
are no longer highlighted.

5. Click OK. The Select Target Cell window closes. The Output Cell Name and
Cell Code in the process configuration dialog are no longer italicized, indicating
that they are not linked to the target cell spreadsheet.

6. Click OK. The process configuration dialog closes and your changes are saved.

To assign an offer to a cell in a flowchart CSP

Before you can do this, you must have created the offers and cells.
1. In a flowchart in Edit mode, double-click the process whose output cell(s) you

want to assign an offer(s). You see the process configuration dialog for the
process.

2. Click the Treatment tab. You see the offer assignment interface for the process,
with a grid displaying all input cells to the process.

3. If you want to use control groups that are completely excluded from contact,
check the Use Holdout Control Groups checkbox. Columns relevant for control
groups are added to the target cells grid.

4. For each cell, click in the Control? column and indicate whether this cell is a
control cell or not by choosing Y or N. If you specify that a cell is a control cell,
the remaining columns for that cells are disabled, and you cannot specify a
control cell or an offer for that cell. If you specify that a cell is not a control
cell, you can specify a control cell and an offer for the cell.

5. For each non-control cell, specify a cell that will be a control, and one of more
offers.
There are two ways to assign offers:
v Click the cell’s Offer column to view and select from a list of available offers

or multiple offers;
v Click Assign Offers... to open the Assign Offer(s) window, where you move

offers from the Available Offers list to the Assigned Offers list using the
Add>> and <<Remove buttons.
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Note: To assign one or more offers to multiple cells, select all rows to which
you want to assign offers, and click Assign Offers... to open the Assign Offer(s)
window.

6. When you have finished assigning offers to the cells in the process, click OK.
The process configuration dialog closes and your changes are saved.

Assigning offer lists to cells
You assign an offer list to a cell in the same way as you assign a single offer or
multiple offers to a cell, whether from a flowchart or in the target cell spreadsheet.
However, you cannot specify the values for parameters in offers within the offer
list. The default values for parameterized offer fields are used.

To set parameters in offers assigned to cells

After you assign offers to cells in flowchart contact-style processes (CSPs), you can
specifying the values for parameterized attributes in the assigned offers.
1. In a flowchart in Edit mode, double-click the process for whose input cell(s)

you want to set the values for parametized offer attributes. You see the process
configuration dialog for the process.

2. Click the Parameters tab. You see the interface for specifying the parameter
values for each input cell.

3. In the For Cell(s) field, use the drop-down list to select a particular cell by
name, or select [All Cells] to assign the same parameter values to more than
one cell. You can also click the ellipsis button to open the Select Cells to Use
window, in which you can select the cells you want to use as input.
For the cell that you selected or for all cells, you see one row for each
offer/parameter combination

Note: Selecting [All Cells] provides the conglomerate view of
cells/offers/parameters.

4. For each offer/parameter combination, click the Assigned Value column to
display the available values in a drop-down list (if applicable), or edit the text
in the field. For every cell that received the offer, the parameter value is set to
the value you enter.

Note: If you have more than one cell, all assigned to the same offer but with
different values for the same parameter, one row is displayed for that offer, but
the value [Multiple Values] is displayed under the Assigned Value column.

5. When you have finished specifying the values for offer parameters, click OK.
The process configuration dialog closes and your changes are saved.

About the target cell spreadsheet

Note: If your Campaign environment is integrated with Marketing Operations,
you must use Marketing Operations to work with target cell spreadsheets. If your
Campaign environment is configured to access legacy campaigns, use the
instructions in this guide to work with target cell spreadsheets for legacy
campaigns. For more information, see “About integration with IBM Unica
Marketing Operations” on page 2.

The target cell spreadsheet (TCS) is a spreadsheet-type feature for each campaign
that displays all cells used in flowcharts within that campaign, and their details,
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including assigned offers. In addition to providing an accessible view of all cells as
used in the campaign’s flowcharts, it is a tool for cell-based offer assignment.

The target cell spreadsheet can be edited at any time, and writes values to the
Campaign system tables when it is saved.

It can be used in two modes:
v Top-down — you create all target and control cells in the target cell spreadsheet,

then later link them to cells created in flowcharts using their cell codes. For cells
created within the TCS, all fields except those that are "Used in Flowchart" can
be edited in the TCS.

v Bottom-up — each target cell that you create in a flowchart process is displayed
in the TCS after you save the flowchart. For cells created from flowcharts, only
the custom attributes can be edited in the TCS.

You can switch between the two modes at any time, although in general this will
not be done often, because the top-down and bottom-up definition tasks are likely
to be performed by different people.

Important: You should put in place business rules that minimize the possibility of
a target cell spreadsheet being edited when any of the flowcharts in the associated
campaign are being edited or run. Incorrect data might be saved and conflicts can
arise if edits are made to the flowchart and the TCS by different users at the same
time, for example, if one user is editing contact processes from within a flowchart,
while another user is changing offer assignments for the same cells from the TCS.

However, in some cases you will need to switch between modes. For example, if
you are working in a flowchart and find that a target cell has not been defined in
the TCS in top-down mode, you can save the flowchart, then switch to top-down
mode (go to the TCS and create the cell there), then switch back to bottom-up
mode (go back to the flowchart and link to the new cell in the TCS. The contact
process then configures successfully).

Cells created in the TCS in top-down mode never are visually disabled (grayed
out) if they are unused in bottom-up mode.

Cell status information in the target cell spreadsheet
The target cell spreadsheet in Campaign displays the current status of each cell,
including the cell count, last run type (production or test run of a flowchart,
branch, or process), and the last run time. The cell count is the number of unique
audience IDs for each cell that is linked to an output cell in a flowchart that has
been run. This cell status is the result of the latest saved production or test run of
the corresponding process.

Cell status information displays in the target cell spreadsheet in either Campaign
(stand-alone) or Marketing Operations (when integrated).

Updating the cell counts
If you make changes to a process configuration, any previous run results are lost
and the Cell Count, Last Run Type and Last Run Time columns appear blank in
the target cell spreadsheet. You must run the flowchart, branch, or process in
production or test mode and subsequently save the flowchart to update the cell
count.
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Note the effect on the cell counts in the TCS for the following types of process
configuration changes.
v Linking a flowchart output cell to a target cell. The cell count remains blank

until the next saved production or test run.
v Unlinking a flowchart output cell from a target cell. Any previous run results

are removed and the cell count is blank.

To refresh the cell counts manually

The cell counts in the target cell spreadsheet are updated automatically when you
run the flowchart, branch, or process in production, or when you save a test run. If
the TCS is open when the run completes, you must refresh the cell counts
manually by clicking the Get Cell Status icon.

Working with the target cell spreadsheet
See the following topics for information on working with the target cell
spreadsheet (TCS):
v “To add one row to the target cell spreadsheet”
v “To add multiple empty rows to the target cell spreadsheet”
v “To duplicate rows in the target cell spreadsheet” on page 148
v “To search in the target cell spreadsheet” on page 148
v “To specify whether the current cell is a control cell” on page 148
v “To specify a control cell for the current cell” on page 149
v “To generate and use cell codes in the target cell spreadsheet” on page 149
v “To edit the target cell spreadsheet” on page 149
v “To paste data from an external source into the target cell spreadsheet” on page

150
v “To assign offers to cells in the target cell spreadsheet” on page 152
v “To unassign offers from cells in the target cell spreadsheet” on page 153
v “To view assigned offers or offer lists” on page 153

To add one row to the target cell spreadsheet
1. In the campaign for which you want to add a cell, click the Target Cells tab.

The target cell spreadsheet for the current campaign appears.
2. Click the Edit icon.

The spreadsheet appears in Edit mode. Existing cells that are used in
flowcharts are highlighted in color.

3. Click the Add a Cell icon.
One row is added to the bottom of the spreadsheet.

To add multiple empty rows to the target cell spreadsheet
1. In the campaign for which you want to add cells, click the Target Cells tab.

The target cell spreadsheet for the current campaign appears.
2. Click the Edit icon.

The spreadsheet appears in Edit mode. Existing cells that are used in
flowcharts are highlighted in color.

3. Click the Add Many Cells icon and select N empty rows from the drop-down
list. The Add Multiple New Rows window appears.

4. In the Number of Rows to Create field, enter the number of rows you want to
add.
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5. Click Create Target Cells.
You see the new target cell rows added to the bottom of the spreadsheet, with
the cell code and cell name already populated.

6. Enter any additional information you have for the new cells in the spreadsheet,
then click Save or Save and Return to save your changes.

To duplicate rows in the target cell spreadsheet
1. In the campaign for which you want to duplicate cells, click the Target Cells

tab. The target cell spreadsheet for the current campaign appears.
2. Click the Edit icon.

The spreadsheet appears in Edit mode. Existing cells that are used in
flowcharts are highlighted in color.

3. Select the row that you want to duplicate.
4. Click the Add Many Cells icon and select N duplicate rows from the

drop-down list.
The Add Multiple New Rows window appears.

5. In the Number of Rows to Create field, enter the number of rows you want to
add.

6. Click Create Target Cells.
You see the new target cell rows added below your selected row, with the cell
code and cell name already populated. All other column values except Used in
Flowchart are copied from your original cell row.

7. Enter any additional information you have for the new cells in the spreadsheet,
then click Save or Save and Return to save your changes.

To search in the target cell spreadsheet

The Search function in the target cell spreadsheet allows you to enter a partial
string and find matches in any column of the spreadsheet. For example, entering
"924" in the search field will match both the row containing the cell with code
"A0000000924" as well as the row for a cell assigned to an offer named
"Offer9242007."

Note: The search function is only available in Edit mode in the target cell
spreadsheet.
1. In the campaign for which you want to search for cells, click the Target Cells

tab.
The target cell spreadsheet for the current campaign appears.

2. Click the Edit link in the spreadsheet.
The spreadsheet appears in Edit mode. Existing cells that are used in
flowcharts are highlighted in color.

3. Click Search.
4. In the Find window, enter the string for which you want to search, then click

Find String.
The row containing the first match found for your search string is highlighted.

5. Click Find Next to continue finding matches in the spreadsheet.

To specify whether the current cell is a control cell
1. In the target cell spreadsheet in Edit mode, click in the Control Cell column for

the cell you are editing.
The cell becomes editable, with a drop-down list.
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2. Select Yes or No from the drop-down list to indicate whether the current cell is
a control cell.

3. Click Save or Save and Return to save your changes.

Important: If you assign a control cell (for example, Cell A) as the control for one
or more target cells, then subsequently change the Cell A to a target cell, Cell A is
removed as a control from any target cells that previously used it as a control.

To specify a control cell for the current cell
1. In the target cell spreadsheet in Edit mode, click in the Control Cell Code

column for the cell you are editing.
The cell becomes editable, with a drop-down list. Cell codes for any cells
designated as control cells (in other words, that have a value of Yes in their
Control Cell column) are available to be selected as control cells.

2. Select the cell to be used as a control for the current cell from the drop-down
list.

3. Click Save or Save and Return to save your changes.

To generate and use cell codes in the target cell spreadsheet

Use this feature to have Campaign generate a unique cell code for use in the target
cell spreadsheet.
1. In the target cell spreadsheet in Edit mode, click the Generate Cell Code icon.

A window with the generated cell code appears.
2. Click inside the window and use your mouse to select the cell code.
3. Right-click and select Copy from the context menu.
4. Click the field in the target cell spreadsheet in which you want to paste the cell

code.
5. Right-click and select Paste from the context menu. The generated cell code is

pasted into the target cell spreadsheet.
6. Click Save or Save and Return to save your changes.

To edit the target cell spreadsheet

When you edit the attributes of cells in the target cell spreadsheet at any time, be
careful that you are not doing so at the same time that any flowcharts in the
associated campaign are being edited or run.

Important: Incorrect data might be saved and conflicts can arise if edits are made
to the flowchart and the TCS by different users at the same time, for example, if
one user is editing CSPs from within a flowchart, while another user is changing
offer assignments for the same cells from the TCS.
1. In the campaign for which you want to edit cells, click the Target Cells tab.

The target cell spreadsheet for the current campaign appears.
2. Click the Edit icon.

The spreadsheet in Edit mode appears. Existing cells that are used in
flowcharts are highlighted in color.

3. Click the cell field(s) that you want to edit, and make your changes.
4. Use the icons on the Campaign toolbar to move a selected row in the

spreadsheet up or down, or to delete selected rows.
5. When you have finished making your edits, click Save or Save and Return to

save your changes.
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To paste data from an external source into the target cell
spreadsheet
1. In the campaign for which you want to edit cells, click the Target Cells tab.

You see the target cell spreadsheet for the current campaign.
2. Click the Edit link in the spreadsheet. You see the spreadsheet in Edit mode.

Existing cells that are used in flowcharts are highlighted in color.
3. In your external application, copy the cell contents or text that you want to

paste into the target cell spreadsheet.
4. In the target cell spreadsheet in Edit mode, click the cell in which you want to

paste the copied contents or, to select multiple cells, click and hold the Shift
key while selecting cells.

5. Right-click and select Paste from the context menu. Your copied cell contents
are pasted into the selected cell(s).

6. Click Save or Save and Return to save your changes.

To import data from a .csv file into the target cell spreadsheet

You can import large amounts of target cell data into the Target Cell Spreadsheet
from a file in .csv format. The file must be formatted as specified in "Required
Format for .csv File For Importing to TCS".
1. In the campaign for which you want to import target cell data, click the Target

Cells tab. You see the target cell spreadsheet for the current campaign.
2. Click the Import Target Cells icon in the spreadsheet.
3. In the Import TCS dialog, use the Browse button to navigate to the .cvs file

that you want to import, select the file, and click Open in the Choose file
dialog.

4. Click Import.
5. The Target Cell Spreadsheet refreshes, with the contents of the .csv file

appended below any existing cells in the TCS.

Required Format for CSV File to Import to the Target Cell
Spreadsheet

To successfully import data to the Target Cell Spreadsheet, the comma-separated
values (.csv) file that you prepare must match the following format. When you
export the contents of the Target Cell Spreadsheet, this is also the format in which
data is exported.
v The file must contain a header row with column names matching the predefined

and custom cell attributes.
v Each row must have the same number of columns as specified in the header

row.
v If there is no data for a given column, it should be left blank.
v Values of custom attributes will be converted to the appropriate data type. For

dates, the date string must be in the user's locale format.

Column Name Description Required Valid Values

CellName Name of the target cell. Yes

CellCode Cell code assigned to this
target cell. If empty,
Campaign will generate a
cell code, otherwise the
specified value will be used.

Yes, if this
row is
marked as
IsControl =
Yes.

Cell code must match the
defined cell code format.
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Column Name Description Required Valid Values

IsControl Indicates whether the cell in
this row is a control cell or a
regular target cell.

No Yes, No

ControlCellCode The CellCode of a cell that is
marked as IsControl = Yes.

No A valid cell code that
exists for a call marked as
IsControl = Yes.

AssignedOffers A semicolon-delimited set of
offers, offer lists, or a
combination of both.

No Offers can be specified
using offer codes, and
offer lists can be specified
using offerlist names.The
format is:
OfferName1[OfferCode1];
OfferName2[OfferCode2];
OfferListName1[];
OfferListName2[], where
the offer name is optional,
but the offer code is
required, and the offer list
name is required with
empty square brackets.

FlowchartName Name of the associated
flowchart.

No. This
column will
be populated
by
Campaign. If
specified, it
will be
ignored. Will
be populated
for export.

CellCount The counts for this cell. No. This
column will
be populated
by
Campaign. If
specified, it
will be
ignored. Will
be populated
for export.

LastRunType The type of the last
flowchart run.

No. This
column will
be populated
by
Campaign. If
specified, it
will be
ignored. Will
be populated
for export.
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Column Name Description Required Valid Values

LastRunTime The time of the last
flowchart run.

No. This
column will
be populated
by
Campaign. If
specified, it
will be
ignored. Will
be populated
for export.

Custom Attr1 Add a column for each
custom cell attribute you
have defined for which you
are importing data.

No Valid values as required
by the custom attribute's
data type and user
locale/format.

To export data from the target cell spreadsheet

You can export the contents of the Target Cell Spreadsheet in .csv format to a
location on your local or networked drive. The entire contents of the TCS is
exported; you cannot select a subset of the contents.
1. In the campaign for which you want to export TCS contents, click the Target

Cells tab. You see the target cell spreadsheet for the current campaign.
2. Click the Export Target Cells icon.
3. In the File Download dialog, click Save.
4. In the Save As dialog, specify a file name for the file, navigate to the directory

where you want to save it, and click Save. The File Download dialog indicates
that the download is complete.

5. Click Close to return to the Target Cell Spreadsheet.

To assign offers to cells in the target cell spreadsheet

You can assign offers to cells in "top down" mode in the target cell spreadsheet.
1. In the campaign for which you want to assign offers to cells, click the Target

Cells tab. You see the target cell spreadsheet for the current campaign.
2. Click the Edit link in the spreadsheet. You see the spreadsheet in Edit mode.

Existing cells that are used in flowcharts are highlighted in color.
3. In the target cell spreadsheet in Edit mode, click the Assigned Offer(s) column

in the row for the cell to which you want to assign offers.
You see the Search Offers icon.

4. Click the Search Offers icon.
You see the Select Offer(s) window.

5. In the Select Offer(s) window, navigate through the offer folders to select one or
more offers or offer lists, or click the Search tab to find an offer by name,
description, or code.

6. When you have selected the offer(s) you want to assign to the current cell, click
Accept and Close.
The Select Offer(s) window closes, and the Assigned Offer(s) column is
populated with your selected offer(s).

7. When you have finished assigning offers to cells, click Save or Save and
Return to save your changes.
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To unassign offers from cells in the target cell spreadsheet

After you have assigned offers to cells, you can unassign them.
1. In the campaign for which you want to unassign offers from cells, click the

Target Cells tab. You see the target cell spreadsheet for the current campaign.
2. Click the Edit link in the spreadsheet. You see the spreadsheet in Edit mode.

Existing cells that are used in flowcharts are highlighted in color.
3. In the target cell spreadsheet in Edit mode, click the Assigned Offer(s) column

in the row for the cell for which you want to unassign offers.
You see the View Offers icon.

4. Click the View Offers icon.
You see the View/Edit Offer Details window, with the assigned offers or offer
lists in the Assigned offers section.

5. Select the offer(s) or offer list(s) that you want to remove from the cell, and
click the >> button to move the selected items to the Removed offers section.

6. When you have finished removing offers or offer lists, click Accept Changes.
The View/Edit Offer Details window closes and the removed offer(s) or offer
list(s) are no longer displayed in the Assigned Offer(s) column for the cell.

7. When you have finished unassigning offers from cells, click Save or Save and
Return to save your changes.

To view assigned offers or offer lists

After you have assigned offers or offer lists to cells, you can view the assigned
offers or preview the contents of assigned offer lists.
1. In the campaign for which you want to view the offers or offer lists assigned to

cells, click the Target Cells tab. You see the target cell spreadsheet for the
current campaign.

2. Click the Edit link in the spreadsheet. You see the spreadsheet in Edit mode.
Existing cells that are used in flowcharts are highlighted in color.

3. In the target cell spreadsheet in Edit mode, click the Assigned Offer(s) column
in the row for the cell for which you want to view assigned offers or offer lists.
You see the View Offers icon.

4. Click the View Offers icon.
You see the View/Edit Offer Details window, with the assigned offers or offer
lists displayed in the Assigned offers section.

5. Select an offer list and click Offer List Preview.
You see the Summary page for the selected offer list, displaying the preview of
included offers.

Target Cells tab icons

The Target Cells tab uses the following icons.

The icons, left to right, are described in the following table.
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Table 17. Icons for Target Cells tab

Icon Name Description

Edit Click this icon to edit the target cell spreadsheet (TCS).
Note: Editing the target cell spreadsheet requires the
appropriate permission. For more information, see the
Marketing Platform Administrator's Guide.

Import Target Cells Click this icon to import the contents of a .csv file to the
Target Cell Spreadsheet.

Export Target Cells Click this icon to export the entire contents of this Target
Cell Spreadsheet to a .csv file.

Get Cell Status Click this icon to refresh the data in the target cell
spreadsheet.
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Chapter 8. Contact history and response tracking

In Campaign, the general term "contact history" refers to information captured
about:
v what offers were sent
v to which customers (or accounts, or households, depending on audience level)
v by which channel

v on what date.

For example, a list of target customers for a campaign can be produced as the
output of a contact process (such as Call List or Mail List) in the campaign’s
flowchart. Each of the target customers belongs to a cell that has been assigned one
or more offers. When the Call List or Mail List process is run in production mode
(not in test mode) with logging to contact history enabled, details are written to
several tables in the Campaign system database.

Together, those tables comprise contact history, which records the specific offer
version (including the values of parameterized offer attributes) given to each ID in
each cell at flowchart run time, as well as the members of control cells, who are
withheld from receiving any communications.

Control cells in Campaign are always hold-out or no-contact controls, therefore
customers belonging to control cells cannot be assigned any offers, and are not
included in contact process output lists (although they are written to the contact
history tables).

Contact history and audience levels
Campaign records and maintains a separate contact history and detailed contact
history for each audience level defined by your system administrators. Each
audience level has its own related contact history and detailed contact history
tables in the Campaign system database, although these can be mapped to the
same underlying physical table in the database.

For more details about contact history and audience levels, see the Campaign
Administrator’s Guide.

Detailed contact history
When all members of a cell are treated the same (that is, when they are all given
the same offer version(s), basic contact history is recorded. However, when
different individuals in the same cell receive a different number of offers or
different offer versions (when offers are personalized so that individuals in the
same cell receive different offer versions), Campaign records exactly what each
individual received in detailed contact history.

All control information is also recorded in detailed contact history, identifying the
specific offer an individual would have received if they had not been selected to be
in the hold-out control group. This information allows for appropriate analysis and
comparison of the target versus control cell for lift and ROI calculations.
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Detailed contact history can quickly grow very large, but it provides complete data
to enable you to perform response tracking to a very detailed level, and to analyze
targets and controls.

Writing entries to contact history tables
Entries are written to the contact history tables only when a flowchart contact
process (Call List or Mail List) runs in production mode with the contact logging
options enabled. Test runs do not populate any contact history tables.

If you have the appropriate permissions, you can enable or disable logging to
contact history in the configuration window for a contact process.

Important: For flowcharts containing contact processes, note that each production
run of a flowchart can generate contact history only once. To generate multiple
contacts from the same list of IDs, snapshot out the list of IDs and read from the
list for each flowchart run. Another way is to use the same list of IDs as input to
multiple contact processes.

When logging to contact history is enabled, contact history captures the following
details:
v The date and time of the contact (by default, this is when the contact process

was run);
v The offer version(s) assigned in the contact process, including parameterized

offer attribute values;
v Exactly which offer version(s) were given to each ID;
v For target and control cells, the treatment codes for tracking each unique

combination of offer version, cell, and date/time.

The production run of a flowchart contact process affects the following system
tables:
v Treatment history (UA_Treatment)
v Base contact history (UA_ContactHistory)
v Detailed contact history (UA_DtlContactHist)
v Offer history

For more details about the system tables that are written to for contact history, see
the Campaign Administrator’s Guide.

Treatment history (UA_Treatment)
Rows are added to the treatment history table (UA_Treatment) each time a
flowchart is run in production mode. In other words, if you have a flowchart
scheduled to run periodically, each new run generates a new set of treatments, one
for each offer per cell, for both contact and control cells, at flowchart run time.
Campaign thus provides the most granular tracking possible, by recording as a
separate instance each time a treatment is generated.Treatment history works
together with base contact history to provide a highly compressed and efficient
way to store complete contact history information. The base contact history table
(UA_ContactHistory) records only the cell membership information for the
appropriate audience, while the treatment(s) given to each cell are recorded in the
treatment history table (UA_Treatment).
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Each treatment instance is identified with a globally unique treatment code that
can be used in response tracking to directly attribute to a specific treatment
instance.

Treatment history also records control cell data if controls are used. Rows
pertaining to offers given to a target cell are called target treatments. Rows
pertaining to offers given to a control cell are called control treatments. Target
treatments will have an associated control treatment if a control cell was assigned
to the target cell in the contact process. Each control treatment is also assigned a
unique treatment code, although the codes are not distributed to hold-out control
members. Control treatment codes are generated to facilitate custom response
tracking where custom flowchart logic is used to identify a control: control
treatment codes can be looked up and associated with the event so that the
response can be attributed to an exact control treatment instance.

Base contact history (UA_ContactHistory)
One row is written to the base contact history table for each combination of contact
ID, cell, and flowchart run date/time, for target cells as well as control cells.

Mutually exclusive cell membership

If your cells are mutually exclusive cells, and each ID can belong to only one cell,
then each ID has one row in the contact history table when it is treated within a
single contact process, regardless of the number of offers assigned. For example,
this is the case if you define cells that correspond to "Low," "Medium," and "High"
value segments, and customers can belong only to one of these segments at any
given time. Even if the "High value" segment is given 3 offers in the same contact
process, only one row is written to base contact history, since base contact history
records cell membership.

Non-exclusive cell membership

However, if individuals can belong to more than one target cell (for example, if
each of your target cells receives offers based on different eligibility rules, and
customers might qualify for none, one, or more than one of the offers), then each
individual has the number of rows in the contact history table corresponding to the
number of cells in which that individual is a member.

For example, if you define two cells: "Customers who have made purchases within
the last 3 months," and "Customers who have spent at least $500 in the last
quarter," an individual could be a member of one or both of these cells. If the
individual is a member of both cells, two entries are written to the base contact
history for that individual when the contact process is run.

Even if multiple rows are written to the contact history table for an individual
because he or she belongs to more than one target cell, all offers given in the same
contact process are considered to be a single "package" or interruption. A unique
"package ID" in the contact history table groups together the rows written by a
particular run instance of a specific contact process for an individual. Multiple
"interruptions" to a person or household would occur only if the individual or
household belonged to multiple cells in separate contact processes.
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Writing additionally tracked fields to contact history
You can create additionally tracked fields and populate them in the base contact
history table. For example, you might want to write out the treatment code from
the treatment table, or an offer attribute, as an additionally tracked field in contact
history.

However, since it is cell membership that is being captured in base contact history,
and each target or control cell writes one row per audience ID, note that if you are
populating additionally tracked fields in base contact history with offer or
treatment data, only the first treatment for each target or control cell is written out.

Example

Cell
Associated control
cell Offer given to cell

TargetCell1 ControlCell1 OfferA, OfferB

TargetCell2 ControlCell1 OfferC

ControlCell1 - -

When the flowchart containing the contact process that assigns the listed offers to
TargetCell1 and TargetCell2 is run in production (with writing to contact history
enabled), a treatment is created for each combination of cell, offer given, and the
run date/time. In other words, six treatments are created in this example:

Treatments Treatment Code

TargetCell1 receiving OfferA Tr001

TargetCell1 receiving OfferB Tr002

ControlCell1 receiving OfferA Tr003

ControlCell1 receiving OfferB Tr004

TargetCell2 receiving OfferC Tr005

ControlCell1 receiving OfferC Tr006

If you have added Treatment Code as an additionally tracked field in base contact
history, only the first target or control treatment for each cell is written out. In this
example, therefore, only three rows are written to base contact history, for the first
treatment for each cell:

Cell Treatment Code

Target Cell1 Tr001

ControlCell1 Tr003

TargetCell2 Tr005

For this reason, capturing offer-level attributes in the base contact history table
may not be a good practice, since it will only provide complete contact information
if:
v only one offer is assigned to any target cell; and
v each control cell is assigned to only one target cell.
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In any other instance, only data associated with the first treatment (or control
treatment) is output. An alternative is to use a database view to flatten and
provide access to offer-level information by joining the UA_ContactHistory and
UA_Treatment system tables. You can also output this information to alternate
contact history.

Note: In detailed contact history and alternate contact history, the behavior is
different; a row is written for each treatment (rather than a row for each cell).
Therefore, if you output offer attribute information as additionally tracked fields,
complete treatment information can be displayed as rows are written out for all
treatments.

Updates to contact history
New entries to the contact history table are appended after existing entries. You
can manually clear selected entries using the Clear History function.

Detailed contact history (UA_DtlContactHist)
The detailed contact history table is written to only if you are using a scenario
where individuals within the same cell receive different versions of an offer. For
example, members of the same cell might receive the same mortgage offer, but the
offer can be personalized so that Person A receives a 5% rate offer, while Person B
receives a 4% rate offer. Detailed contact history contains one row for each offer
version that an individual receives, as well as one row for each control cell based
on the offer versions they would have received.

Offer history
Offer history is comprised of multiple system tables which collectively store the
exact information about an offer version that has been used in production. New
rows are added to the offer history table only if the combination of parameterized
offer attribute values are unique. Otherwise, existing rows are referenced.

For more details about the contact history tables, see the Campaign Administrator’s
Guide.

Disabling writing to contact history

Important: It is possible to disable writing to contact history, but the best practice
is not to disable contact history loggin. If you execute a campaign in production
and do not log to contact history, you will be unable to accurately re-generate this
history at a later date if any underlying data changes.

However, you can run contact processes without writing to contact history tables
in two ways:
v “Performing a test run”
v “To disable logging options” on page 160

Performing a test run
Entries are written to the contact history tables only when a flowchart contact
process (Call List or Mail List) runs in production mode with the contact logging
options enabled. Test runs do not populate any contact history tables.
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To disable logging options

Each contact process can be configured to disable logging to contact history during
production runs.
1. Double-click the contact process for which you want to disable logging to

contact history. You see the process configuration dialog.
2. Click the Log tab. You see the window for configuring logging of contact

transactions.
3. To prevent any logging to contact history, clear the Log to Contact History

Tables and the Log into Other Destinations checkboxes.
Optionally, you can also click More Options to see the Contact History
Logging Options window. This window provides additional control over which
information is logged to the contact history. See “To configure a contact process
(Mail List or Call List)” on page 81 for more information.

4. Click OK. The process configuration dialog closes and your changes are saved.
When you run this contact process, no entries will be written to the contact
history tables or to alternate logging destinations until these options are
re-enabled.

Clearing contact and response history
You might want to clear contact or response history records if, for example, a
production run was executed by mistake, or if, after a production run, you decide
to cancel the campaign.

Important: Clearing contact and response history permanently deletes this data
from the database. Cleared contact and response history cannot be recovered. If
later recovery might be required, back up the system table database prior to
clearing any history.

Referential integrity across all Campaign system tables is always preserved. All
contact history tables are written to simultaneously, and any clean up of contact
history is also done simultaneously across all contact history tables. For example,
treatment table entries cannot be deleted if there entries in the base or detailed
contact history tables referencing them.

You can clear contact history only if you have the appropriate permissions to do
so, and if there are no associated response history records. Therefore, if you clear
contact history you must also clear the associated response history.

Important: In typical situations, it is best not to delete contact history for which
responses have been recorded. However, if you must delete such contact history,
you can choose to clear all associated contact and response history records, or clear
only the response history records.

To clear contact history and response history

Important: Clearing contact history permanently deletes contact history records
from the system tables. This data is not recoverable.
1. In a flowchart in Edit mode, double-click the contact process for which you

want to clear history. You see the process configuration dialog.
2. Click the Log tab. You see the window for configuring logging of contact

transactions.
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3. Click Clear History. You see the Clear Contact History window.

Note: If no contact history entries exist, when you click Clear History an error
message indicates that there are no entries to clear.

4. Choose the appropriate option for clearing history: all entries, all entries
between a selected date range, or specific flowchart runs, identified by the run
date and time.

5. Click OK.
v If no response history records exist for the entries you selected, you see a

confirmation message.
v If response history records exist for any of the entries you selected, you see

the Clear History Options window. Select one of the following options:
– Clear All Associated Contact and Response History Records: Both

contact history and response history are cleared for the entries you
specified.

– Clear Associated Response History Records Only: Only response history
is cleared for the entries you specified. Contact history records are not
cleared.

– Cancel: No contact history or response history records are cleared.
6. When the selected action is completed, a confirmation message indicates that

the specified records have been cleared.
7. Click OK to close the confirmation message.
8. Click OK to close the process configuration dialog.

About response tracking
In Campaign, the term "response tracking" refers to the process of determining
whether events or actions taken by individuals are in response to offers they have
been given. Response tracking also includes tracking the behavior of individuals in
hold-out control groups, to see whether they performed the desired action despite
not having been contacted.

Campaign captures the following information about responses to campaigns:
v who responded — the list of audience entities (such as individual customers or

households) whose behavior matched the response types being tracked.
v the actions they performed, and the date and time of these actions — for

example, a click-through on a Web site, a purchase, or purchase of a specific
item.

v which offer treatment they responded to — any Campaign-generated codes
(campaign, offer, cell or treatment code) as well as any offer attributes with
non-null values returned by the respondent are matched for response tracking.

v how their response is counted — determine how responses are credited to the
campaign based on matching Campaign-generated codes or non-null values for
offer attributes, whether respondents were in the original targeted group or a
control group, and whether the response was received before the expiration date.

Performing response tracking
You perform response tracking by creating a flowchart containing the Response
process, which takes input from an action table via a Select or an Extract process.
The action table is a file or table containing a record of all the actions or events
that are evaluated to see if they should be attributed as responses to any contact or
control treatments.
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You configure the Response process to process, evaluate, and output the IDs that
you consider as responses to your offer, based on matching some combination of
response codes and/or other standard or custom offer attributes from the action
table. Any Campaign-generated codes (campaign, offer, cell or treatment code) that
are mapped in the Response process are considered to be "response codes of
interest." Any other offer attributes, whether standard or custom, that are mapped
in the Response process are considered "response attributes of interest." For
example, you can use the "Relevant Products" field as an offer attribute to track
inferred responses. The response processing logic uses both response codes of
interest and response attributes of interest to determine direct and inferred
responses.

Running the Response process writes those responses to the response history
system table (UA_ResponseHistory, or its equivalent for each audience level). Like
contact history, there is one response history system table for each audience level
that you are tracking.

The data captured in the response history is then available for analysis using the
performance reports in Campaign.

Campaign automatically records the following data related to response tracking:
v Whether the response was direct (one or more Campaign-generated codes were

returned) or inferred (no response codes were returned)
v Whether the response was received before or after the expiration date of the

specific offer version
v Whether the respondent was in a target cell or a control cell from the campaign
v Whether the response was unique or a duplicate
v Best, fractional, and multiple attribution scores
v The response type (action) attributed to the response

Using multiple response tracking flowcharts
It is possible to have a single response tracking flowchart for all the campaigns in
your corporation. If a single action table is used, your system administrator will
typically have set up session flowcharts to write data into the action table for
processing.

However, your implementation of Campaign might use one or more action tables
for convenience, each related to a separate response tracking flowchart.

You might use multiple response tracking flowcharts when:
v You are tracking responses for different audience levels
v You have real-time vs. batch processing requirements
v You want to avoid duplicating large volumes of data
v You want to hard-code specific data for different situations
v You need custom response processing logic

You are tracking responses for different audience levels

(Required) You need one response tracking flowchart for each audience level for
which you receive and track responses. The Response process operates at the
audience level of the incoming cell, and automatically writes to the appropriate
reponse history table for that audience level. To track responses for two different
audience levels, for example, customer and household, you need two different
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Response processes, most likely in two separate response tracking flowcharts.

You have real-time vs. batch processing requirements

(Required) Most of your response tracking sessions will be batch flowcharts,
periodically processing events populated into an action table (for example, nightly
processing of customer purchases). The frequency of response tracking runs will
depend on the availability of the transaction data used to populate the action table.

For example, if you process responses from different channels (such as web vs.
direct mail), you might need separate response processing sessions because the
frequency of availability of incoming transaction data will be different for each
channel.

You want to avoid duplicating large volumes of data

(Optional) If you have large transaction volumes (such as millions of sales
transactions per day) that must be evaluated, you might want to build a response
tracking flowchart to map directly against the source data, rather than ETL (extract,
transform, load) it into an action table.

For example, you can build a response tracking flowchart in which an Extract
process pulls transactions directly from an e-commerce system’s purchase
transaction history table (based on a particular date range), and a Response process
that maps directly to columns in this table from this extract.

You want to hard-code specific data for different situations

(Optional) You might want to hard-code specific data (such as response types) for
different situations, such as different channels. For example, if you are interested
specifically in tracking a specific response type (such as "inquiry") that is specific to
a channel (such as "call center"), you can create a derived field to filter these
responses, and use it in a response processing flowchart to pull all inquiries from
the call center database. It might be more convenient to create the data necessary
for response tracking using derived fields, and pull the data directly from the
source, than to write the data to a single action table.

You need custom response processing logic

(Optional). If you need to write your own rules for attributing responses, you can
create a separate response tracking flowchart to implement custom
response-tracking logic. For example, if you need to identify responders to a "Buy
3 Get 1 Free" offer, you need to look at multiple transactions to determine whether
an individual qualifies as a responder. Upon finding qualifying individuals, you
can then input them into a Response process to record the responses using the
treatment code and appropriate response type.

Response tracking using multi-part offer codes
You can track responses using a derived field that consists of a multi-part offer
code (that is, an offer code that consists of two or more codes). All parts of the
offer code must be concatenated using the partition-wide offerCodeDelimiter
configuration property. The following example creates a derived field called
MultipleOfferCode consisting of two parts concatenated using the default delimiter
"-":
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MultipleOfferCode = string_concat(OfferCode1, string_concat(“-“,
OfferCode2))

When configuring the Response process to use the derived field as a Candidate
Action Field, you must match the derived field to the offer/treatment attribute of
each offer code in the multi-part code.

Date scope for response tracking
In addition to recording whether responses were made within the valid offer time
period (that is, after the effective date and on or before the expiration date),
response tracking also records whether the response was outside a valid date range
for all offers. Campaign tracks late responses for all offers based on a configurable
time period after an offer’s expiration date to provide data on how often your
offers are redeemed after their official end dates.

The date scope for response tracking in Campaign is set globally, and is applied to
all campaign offers. Your system administrator sets the number of days past the
offer expiration date that responses will be tracked.

This date setting automatically limits the possible treatment instances that can
match an event. The smaller the date scope, the more performance is improved
because fewer instances from the treatment table are returned for possible matches.

For details about setting the date scope, see "Setting the number of days after a
campaign ends to record responses" in the Campaign Adminstrator’s Guide.

Response tracking for controls
Control group responses are tracked simultaneously with offer responses, using the
Response process.

Control cell responses are handled in the same way as inferred responses, except
that any response codes are first discarded. For any responses from control cell
members, any response tracking codes are ignored and any attributes of interest
(for example, relevant products) are checked for matches against control treatment
instances. Campaign uses an internal, globally-unique treatment code that is
generated for all control treatments; however, control treatment codes are not given
out, as control treatments are always no-contact, hold-out controls.

It is possible for the same event to credit both target treatment instances and
control treatment instances. For example, if a particular customer is targeted with
an offer for 10% of any purchase in the women’s department, and that customer is
also a member of a hold-out control group monitoring for any purchase from the
store, if that customer makes a purchase using the coupon, that event would be
associated with both the target treatment instance (using the coupon’s treatment
code) and the control treatment instance. Control treatment instances are also
marked within the valid date range or after the expiration date, in the the same
manner as target treatment instances — this provides a valid control comparison
for late activity in the target cell.

Best or fractional attribution is not used for control cell responses — multiple
attribution is always used. In other words, if a respondent is in a control cell for an
offer and her action qualifies as an inferred response for multiple control
treatments, all of these matching control treatments are credited for the response.
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Response tracking for personalized offers
If you have used data-driven, personalized, or derived or parameterized offer
fields to generate different offer versions, for responses to these personalized offers
to be correctly attributed, your action table must contain fields representing the
parameterized offer attribute fields. When these fields are mapped in a Response
process as attributes of interest and populated, they can be used to match
responses back to the offer version or treatment instance. Responses with values
for these "attributes of interest" must exactly match the values recorded for that
individual in offer version history, for attribution to that treatment.

For example, if you had flight offers which were personalized with an origin
airport and a destination airport, then your action table should contain fields for
"Origin Airport" and "Destination Airport." Each flight purchase transaction would
contain these values, and response tracking would be able to match the specific
flight purchased by an individual to the offer version(s) that were promoted to him
or her. These fields also would be used to track inferred responses for members of
the control group, to see if they purchased any flights that would have been
promoted to them.

Response types
Response types are the specific actions that you are tracking, such as click-through,
inquiry, purchase, activation, use, and so on. Each response type is represented by
a unique response code. Response types and codes are defined globally in the
Campaign Response Type system table, and are available for all offers, although
not all response types are relevant for all offers. For example, you would not
expect to see a click-through response type for a direct mail offer.

When events are written to the action table, each event row can have only one
response type. If the response type field is empty (null) for an action, it will be
tracked as the default response type ("unknown").

If a single event needs to be associated with multiple response types, multiple
rows must be written to the action table, one for each response type. For example,
if a financial institution is tracking the purchase usage level of a new credit card
during the first month after activation with response types of "Purch100,"
"Purch500," and "Purch1000," a purchase of $500 might need to generate an event
with response types of both "Purch100" and "Purch500," because the purchase
meets both of these conditions.

If you need to detect complex sequences of separate transactions that will together
constitute a response event, you will need a separate monitoring session that looks
for the qualifying transactions and, when these are found, then submits an event to
the action table. For example, if a retailer’s promotion rewards customers who
purchase any three DVDs during the month of December, you can build a
flowchart to compute the number of DVD purchases for each customer, select the
customers who have made three or more purchases, and write these customers to
the action table with a special response type (such as "Purch3DVDs").

For more details about response types, see the Campaign Administrator’s Guide.

Response categories
Responses in Campaign fall into two categories:
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v Direct response — one or more Campaign-generated tracking codes sent out
with the offer were returned, and any returned attributes of interest must match.

v Inferred response — no tracking codes were returned, but at least one offer
attribute used for response tracking was returned and matched. Responses from
hold-out control groups are always inferred responses.

Direct responses
A response is considered to be a direct response if:
v The respondent returned at least one Campaign-generated code (campaign, cell,

offer, or treatment code) that exactly matches one or more of the possible target
treatment instances generated by Campaign.

AND
v Any "attributes of interest" (that is, any offer attribute, standard or custom, that

was mapped in the Response process for tracking) returned must have a value
exactly matching the value of attribute in the treatment.

For example, if treatment code is a response code of interest and "Response
Channel" is an attribute of interest, an incoming response with the values of
"XXX123" for treatment code and "retail store" for Response Channel will not be
considered a direct match for a treatment with the respective values of "XXX123"
and "Web."

A response with a null value for an attribute of interest cannot match a treatment
that has that offer attribute. For example, a response that is missing a value for
"interest rate" cannot match any offer created from an offer template that contains
interest rate as an offer attribute.

However, a response with a value for an attribute of interest that does not exist in
a treatment does not prevent a match. For example, if a Free Shipping offer was
created from an offer template without an "interest rate" offer attribute, and
"interest rate" is an attribute of interest, the value of the "interest rate" attribute for
an incoming response does not matter when Campaign considers possible matches
against treatments associated with the Free Shipping offer.

Response tracking considers whether the response was made within the valid offer
time period (that is, after the effective date and on or before the expiration date),
or whether the response was outside the valid date range. Campaign tracks late
responses for a configurable time period after an offer’s expiration date.

Response tracking also identifies whether a direct response was from a respondent
that was in the originally contacted group, that is, the target cell.

Note: If a direct response was not from the originally targeted group, then the
response is considered a "viral" response or a "pass-along," meaning that the
responder somehow obtained a valid response code although they did not
originally receive the offer.

It can be valuable to understand how many of your responses came from your
target group, especially if you are trying to cultivate high-value customers. These
values can be broken out in performance reports to see how many direct responses
came from the original target group and how many were viral responses.

Direct responses can be exact or inexact matches.
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Direct exact matches
A response is considered to be a direct exact match if Campaign can uniquely
identify a single target treatment instance to credit.

Note: It is a best practice to use Campaign-generated treatment codes for tracking,
because Campaign can always uniquely identify a treatment instance to credit if
the treatment code is returned.

For example, if you used the treatment codes generated from a contact flowchart
as coupon codes in an offer, and a treatment code is returned by a respondent in
one of the offer’s target cells, then the response is a direct exact match to that offer.

If multiple tracking codes or attributes of interest are received, all codes and
attribute values must match exactly for the treatment instance to be counted. In
other words, if a respondent provides an offer code, a treatment code, and an offer
attribute with a non-null value, all must exactly match the codes and offer attribute
values in the treatment.

Direct inexact matches
A response is considered to be a direct inexact match if Campaign cannot uniquely
identify a treatment instance to credit, but the returned tracking code(s) match
multiple possible target treatment instances.

To narrow down target treatment instances that will receive credit for this
response, if any target treatment instance contacted the responder, Campaign then
discards any treatment instances that did not contact the responder. If no target
treatment instances contacted the responder, all are kept, and all will receive credit
for a viral response.

For example, if a customer in the high-value segment received an offer from a
campaign which was given to both high and low-value customers and returned the
offer code, this would initially match two target treatment instances (one for the
high-value cell and one for the low-value cell). Applying this response tracking
rule, since the treatment instance for the high-value cell actually targeted this
responder but the treatment instance for the low-value cell did not, the latter is
discarded. Only the treatment instance associated with the high-value customer
group is credited for this response.

In addition, if the response date was within any of the remaining treatment
instances’ valid date range, any treatment instances not within their effective and
expiration dates are discarded.

For example, if a customer was contacted in both the January and February
instances of the same campaign, and the offer code was returned, it would match
two target treatment instances (one from January and one from February). If each
offer version expired at the end of the month in which it was issued, a response in
February would cause the January treatment instance to be discarded because it
had expired. Only the February treatment instance would be credited for this
response.

After response tracking rules are applied and all invalid target treatment instances
are discarded, Campaign uses different attribution methods to calculate the credit
to give to any remaining treatment instances.
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Inferred responses
A response is considered to be inferred when the following conditions are met:
v no Campaign-generated tracking codes (campaign, cell, offer, or treatment code)

are returned
v the responder belongs to either a target cell or a control cell
v at least one offer attribute used for response tracking was returned
v all returned offer attributes match.

A response with a null value for an attribute of interest cannot match a treatment
that has that offer attribute. For example, a response that is missing a value for
"interest rate" cannot match any offer created from an offer template that contains
interest rate as an offer attribute.

However, a response with a value for an attribute of interest that does not exist in
a treatment does not preclude a match. For example, if a Free Shipping offer was
created from an offer template without an "interest rate" offer attribute, and
"interest rate" is an attribute of interest, the value of the "interest rate" attribute for
an incoming response does not matter when Campaign considers possible matches
against treatments associated with the Free Shipping offer.

In addition, the respondent must have been contacted (that is, they must have been
in the target cell, or in a group that was contacted), for their response to be
counted as inferred.

For example, if a customer was sent a coupon for $1 off laundry detergent and that
customer purchased laundry detergent (even if they did not redeem the coupon),
Campaign infers a positive response to that target treatment instance.

Inferred responses from control groups
All responses from members of control groups (which are always hold-out controls
in Campaign ) are inferred responses. Matching inferred responses is the only
mechanism for crediting responses from holdout control group members.

Since members of a control group did not receive any communication, they cannot
have any tracking codes to return.

Response tracking monitors members of control groups to see if they take a
desired action without having received any offer. For example, a campaign might
target a group of customers who do not have checking accounts with a checking
account offer. Members of the control group are tracked to see if they open a
checking account within the same time period as the checking account offer.

All incoming events are evaluated to see if they are possible inferred responses for
control treatment instances. Any response codes are discarded and remaining
attributes of interest are evaluated against control treatment instances for possible
response credit.

Attribution methods
Campaign supports three methods by which responses are credited to offers:
v Best match
v Fractional match
v Multiple match
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All three of these response attribution methods are used simultaneously and
recorded as part of response history. You can choose to use one, a combination, or
all of these in the various performance reports to evaluate your campaign and offer
performance.

Response attribution is performed on target treatment instances that remain after
invalid responses are discarded (either because the treatment instance did not
contact the responder, or because the target instance is expired).

For example, a respondent in a target cell that was given three offers returns a cell
code; an exact treatment instance cannot be identified. Best match attribution
would choose one of the three offers to receive full credit; fractional match
attribution would give each of the three offers 1/3 credit each, and multiple match
attribution would give all three offers full credit for the response.

Best match
With best match attribution, only a single target treatment instance receives full
credit for a response; and any other matching treatment instances receive zero
credit. When multiple treatment instances match for a response, Campaign chooses
the treatment instance with the most recent contact date as the best match. If there
are multiple treatment instances with the same contact date and time, Campaign
credits one of them arbitrarily.

Note: In the case of multiple treatment instances with the same contact date and
time, the same instance will be credited each time, but you should not expect
Campaign to select a specific treatment instance.

Fractional match
With fractional match attribution, all n matching treatment instances get 1/n credit
for the response, so that the sum of all attributed scores sum is 1.

Multiple match
With multiple match attribution, all n matching treatment instances receive full
credit for the response. This can lead to over-crediting of treatments and should be
used with caution. Control groups are always tracked using multiple attribution:
every response from a member of a control group receives full credit.
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Chapter 9. Stored objects

If there are campaign components that you use frequently, you should try to
design and save them as stored objects. Reusing stored objects across flowcharts
and across campaigns can result in time savings and more consistency across
campaigns.

The types of stored objects in Campaign are:
v Derived fields
v User variables
v Custom macros
v Templates
v Stored Table Catalogs

About derived fields
Derived fields are variables that do not exist in a data source and are created from
one or more existing fields, even across different data sources. In many processes,
the configuration window includes a Derived Fields button that you can use to
create a new variable for querying, segmenting, sorting, calculating, or providing
output to a table.

You can make derived fields that you create explicitly available to a subsequent
process by enabling the Make Persistent option when you create it.

In general, derived fields available to a process are listed in the Derived Fields
folder. Derived fields are available only for the process in which they were created.
If you have not created any derived fields in a process, no Derived Fields folder
appears in the list.

To use a derived field in another non-subsequent process, store the derived field
expression in the Stored Derived Fields list. Inclusion in the Stored Derived Fields
list makes a derived field available for all processes and all flowcharts.

Creating derived fields
You create derived fields from the configuration windows for processes that
support derived fields.

Only fields from tables that are selected in the process configuration dialog can be
used in a derived field expression. If a desired table does not appear, make sure it
is selected as a source table.

Naming restrictions for derived fields
Derived field names have the following restrictions:
v They cannot be the same as either of the following types of names:

– A database keyword (such as INSERT, UPDATE, DELETE, or WHERE)
– A field in a mapped database table

v They cannot use the words Yes or No.
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If you do not follow these naming restrictions, database errors and disconnects
may result when these derived fields are called.

Note: Derived field names also have specific character restrictions. For details, see
“Special characters in IBM Unica Campaign object names,” on page 219

To create a derived field
1. From the configuration window of a process that supports derived fields, click

Derived Fields.
The Create Derived Field window appears.

2. In the Field Name field, enter a name for the new derived field.
All derived fields previously created in this process appear in the Field Name
drop-down list. To create a new derived field, enter a different name.

3. Select the Make Persistent checkbox if you want to store and pass on the
calculated values for this field.

4. Enter an expression for the derived field directly in the Expressions text box or
click Formula Helper to use the Query Helper. You can also use the fields
listed in the Fields available for expression list by selecting a field name and
then clicking <-Use to insert the field name into the Expression text box.
You can define a derived field to be a null value. Use NULL to return a null
value for a snapshot or NULL_STRING to return a null value with a string
datatype if you want the derived field to be used with a Campaign macro.
You can enter a string in a derived field as a constant. If you use a string, it
must be surrounded by double quotation marks. For example, "my string". No
quotation marks are required for numeric strings.

5. (Optional) Click Check Syntax to verify the syntax of the derived field
expression you have entered.
This will display either an error message (if there is a problem) or else indicate
Syntax check OK if the syntax is correct.

6. Click OK to save the new derived field and return to the process configuration
dialog.

To create a new derived field from an existing one
1. From the configuration window of a process that supports derived fields, click

Derived Fields.
The Create Derived Field window appears.

2. From the Field Name drop-down list, select the existing derived field from
which you want to create a new one.
The expression for the selected derived field appears in the Expression area.

3. Change the name of the existing derived field to the name you want for the
new derived field.

Important: You cannot use the words "Yes" or "No" as names for derived fields;
doing so results in database disconnects when these derived fields are called.

4. Edit the derived field expression as required.
5. Click OK to save the new derived field and return to the process configuration

dialog.

To use a custom macro to create a derived field
1. From a process that supports derived fields, click Derived Fields.

The Create Derived Field window appears.
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2. In the Create Derived Field window, click Formula Helper.
A list of custom macros appears in the Formula Helper.

3. Select a macro from the list by double-clicking it.
The macro’s declaration and description are displayed, and the macro itself is
inserted in the Formula Helper window.

4. Select the appropriate fields from the Fields available for expression list to
complete your expression.

5. Click OK to save the new derived field and return to the process configuration
dialog.

Storing derived fields
Derived fields are available only within the process in which it was created and
subsequent processes. For example, if you define a derived field named Pct_Usage
with the formula:

(Curr_bal / Credit_limit) * 100

in a process, Pct_Usage will not be available in any other process (except an
immediately following process if Make Persistent is enabled).

However, you can save the derived field definition in the same way that you
would save any other query. You can store the derived field definition in the
Stored Derived Fields list and give it a name (for example, Pct_of_limit_used).
Later, if you want to use the same derived field in another process in the same or a
different flowchart, you can select Pct_of_limit_used from the Stored Derived
Fields list and insert the stored derived expression, rather than reconstructing it
from scratch.

To store a derived field
1. In a process that supports derived fields, create the derived field that you want

to store.
2. Click Stored Derived Fields.

The Stored List window appears.
3. Select Save Current Expression to Stored List.
4. Click OK.
5. Use the Save Derived Field Expression window to specify where to store the

field, a security policy if applicable, and any notes about the derived field.
6. Click Save.

Note: If you want to store an already created derived field, select the derived
field from the Field Name drop-down list. When the derived field expression
appears in the Expression area, click Stored Expressions.

To use a stored derived field
1. In a process that supports derived fields click Derived Fields, or click Tools >

Stored Derived Fields to access the Stored Derived Fields Expressions window.
2. From the list of stored derived fields, select the one you want to use.
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To make a derived field persistent

When you make a derived field persistent, you instruct Campaign to store its
calculated values and make them available to subsequent processes. This saves
time and resources as Campaign does not have to recalculate these values
downstream in the flowchart.
1. From the configuration window of a process that supports derived fields, click

Derived Fields.
The Create Derived Field window appears.

2. Select the Make Persistent checkbox if you want to store and pass on the
calculated values for this field.

Example: Persistent derived field
You might have a Select process configured to choose IDs based on a constraint on
a derived field, connected to a Snapshot process to output the selected records that
include that derived field. If you mark the derived field to be persistent, the
calculated value is passed from the Select process to the Snapshot process.

Another use of persistent derived fields is with any aggregate-type derived field
(for example, AVG or GROUPBY). These aggregated fields are calculated based on
the multiple rows of data within the current cell, so the value of these aggregated
fields changes as the contents of the cell change. With persistent derived fields, you
can choose to keep the original calculated value, then carry that to other processes.
If you choose to recalculate the derived field instead, you get a calculated value
based on the remaining records in the current cell.

When a process takes multiple inputs, such as a Snapshot process working with
the input from two Select processes, all persistent derived fields are available to
the downstream process.

If a persistent derived field is not available across all incoming Select processes,
and it is included in the output for a Snapshot process, then the Snapshot process
displays a NULL value for that persistent derived field in all the output rows from
the Select processes that did not have that persistent derived field.

If a persistent derived field is not available across all incoming Select processes,
and you use it to define a Segment process, then the Segment process has empty
segments for the Select processes that did not have that persistent derived field.

The Segment process remains unconfigured if you try to define a segment with an
expression using more than one persistent derived field not available across all the
Select processes.

The following guidelines apply to persistent derived fields (PDFs):
v PDFs attach to an inbound cell (vector)
v PDFs are calculated before query execution
v Multiple PDFs are available in the following processes:

– Snapshot: If a PDF is not defined for a cell, its value = NULL. If a single ID is
greater than one cell, one row is output for each cell.

– Segment: PDFs are not available for segmentation by field when multiple
input cells are selected. PDFs must exist in all selected input cells for use in a
segment by query.
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v PDFs keep only a single value (selected at random) per ID value, regardless of
the number of times an ID value occurs in the data. Thus, when the output
includes no table fields (and includes an IBM Unica ID), there will be only one
record per ID value.
However, when you use a derived field based on a table field, the output
includes a table field indirectly. Thus, there will be a record for each instance of
an ID value. (In other words, if the ID value occurs seven times in the data,
there will be seven records output.)

Persistent derived fields only store a single value for each audience ID, which is
randomly selected from the available values. This means that when working with
unnormalized data, you must use a GROUPBY macro function to achieve the
desired behavior.

For example, say you want to find from the purchase transaction table, the highest
dollar amount in a single transaction a customer has made and save this as a
persistent derived field for downstream processing. You could write a derived field
(and then persist it as a persistent derived field) as follows:
Highest_purchase_amount = groupby(CID, maxof, Purch_Amt)

Against unnormalized purchase transaction data such as the following, this would
compute as follows:

CID DATE PURCH_AMT HIGHEST_PURCHASE_AMOUNT

A 1/1/2007 $200 $300

A 3/15/2007 $100 $300

A 4/30/2007 $300 $300

When the derived field is persisted, it choose (randomly) any value (which are all
$300) and persists the value $300 for customer A.

A second less obvious example might be to select a predictive model score from a
scoring table for a specific model X. Here the derived field might look like this:
ModelX_score = groupby(CID, maxof, if(Model = ’X’, 1, 0), Score)

And the data might look like:

CID MODEL SCORE MODELX_SCORE

A A 57 80

A B 72 80

A X 80 80

Persisting the derived field, ModelX_Score, gives the desired result of the score
value of 80. It is incorrect to create a derived field:
Bad_ModelX_score = if(Model = ’X’, Score, NULL)

This would result in the following:

CID MODEL SCORE BAD_MODELX_SCORE

A A 57 NULL

A B 72 NULL
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CID MODEL SCORE BAD_MODELX_SCORE

A X 80 80

Then when you persist the derived field Bad_ModelX_score, the persisted value
could be NULL or 80. If you are working with unnormalized data and the derived
field values are not all the same, persisting that derived field could result in any of
the values being returned. For example, defining Derived_field_Score = SCORE
and persisting it could result in the value 57, 72, or 80 for customer A. To ensure
desired behavior, you must use the GROUPBY macro over the customer ID and
guarantee the derived field value is the same for all data for that customer.

About user variables
Campaign supports user variables, which can be used during process configuration
when creating queries and expressions.

Guidelines for using user variables

The following guidelines apply to user variables:
v User variables are local to the flowchart in which they are defined and used, but

have global scope within that flowchart.
v User variables use the following syntax: UserVar.UserVarName
v User variables have Initial Values, which is the value assigned when a user

variable is initially defined in the User Variables dialog. The Initial Value is
only used to set the Current Value before executing a flowchart run. It is the
Current Value that Campaign uses during a flowchart run.

Note: If the Current Value for a user variable is not set and you execute a
process run or a branch run, Campaign will not be able to resolve the user
variable. Campaign only sets the Current Value of a user variable to the Initial
Value before a flowchart run.

v You can change the Current Value of a user variable in the Derived Field
window of a Select process.

v User variables can be set to constants or to expressions, such as UserVar.myVar
= Avg(UserTable.Age).

Note: If you use an expression that returns multiple values (such as
UserTable.Age+3, which will return one value for each record in the table), the
user variable is set to the first value returned.

v When using user variables within SQL statements, do not enclose user variables
in quotation marks, either single or double.

v If you pass object names to your database (for example, if you use a user
variable that contains a flowchart name), you must ensure that the object name
contains only characters supported by your particular database. Otherwise, you
will receive a database error.

v The values of user variables can be passed in on process execution.
v User variables are supported in outbound triggers.
v User variables are supported for use in custom macros.
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To create a user variable
1. From a flowchart in Edit mode, click the Options icon and select User

Variables.
The User Variables dialog appears.

2. In the Variable Name column, enter a name for the new user variable by
clicking the <Click here to add new item> hotspot.

3. In the Data Type column, select a data type from the drop-down list. If you do
not select a data type, the application selects None when you click OK.
The None data type may produce unpredictable results; to avoid this, specify
the correct data type.

4. In the Initial Value column, enter an initial (starting) value for the user
variable. You can also profile fields for available values by clicking the ellipsis
button that becomes available when you click inside the column.

5. In the Current Value column, enter a current value for the user variable. You
can also profile fields for available values by clicking the ellipsis button that
becomes available when you click inside the column.

6. Repeat these steps for each user variable that you want to create.
7. When you complete defining user variables, click OK.

The application stores the new user variables. You can access them later when
configuring processes.

After a flowchart run executes, the Current Value of each user variable is
displayed in the Current Value section for each user variable. If the current value
is different from the initial value, you can restore the initial value by clicking
Restore Defaults.

Note: If the Current Value of a user variable is redefined in a Select process,
resetting the Current Value to the Initial Value manually will have no effect on
the value of the user variable during a flowchart, branch, or process run.

About custom macros
A custom macro is a query that you create using either a IBM Unica Expression,
raw SQL, or raw SQL that includes a value. Custom macros also support variables,
which makes them far more powerful than the stored queries they are designed to
replace.

You can save a custom macro and use it in configuring processes in a flowchart,
and in defining derived fields.

Support for raw SQL improves performance, allowing complex transactions to be
carried out in the database rather than having the raw data filtered and
manipulated in the application server.

Campaign supports the following three types of custom macros, which in turn
support an unlimited number of variables:
v Custom macros that use a IBM Unica Expression
v Custom macros that use raw SQL
v Custom macros that use raw SQL and include a specified value

Important: Since non-technical users are able to use custom macros, when you
create a custom macro you should describe how it works very carefully, place
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similar kinds of macros in special folders, and so on, to reduce the possibility that
someone might use a custom macro incorrectly and retrieve data that they were
not expecting.

To create a custom macro
1. On a flowchart page in Edit mode, click the Options icon and select Custom

Macros.
The Custom Macros dialog appears, displaying existing custom macros.

2. Click New Item.
3. From the Save Under drop-down list, select the folder location to which you

want to save the custom macro.
4. In the Name field, enter a name and declaration for the custom macro so that

it can be referenced, using the following syntax:
MacroName(var1,var2,...)
Only the name of the custom macro (which must be unique) and the list of
variables need to be expressed.
The MacroName must be alphanumeric. You cannot use spaces in the
MacroName string, but you can use underscores (_).

Note: If a custom macro has the same name as a built-in macro, the custom
macro will take precedence. As a best practice, to avoid confusion, do not
name custom macros with operator names or names that are the same as
those of built-in macros in Campaign. The exception would be if you
specifically want the new custom macro to always be used, and the built-in
macro to be inaccessible.

Important: The variable names must match the variable names in the custom
macro definition in the Expression window, and they must be expressed as a
comma-separated list within parenthesis.

5. From the Security Policy drop-down list, select a security policy for the new
custom macro.

6. Optionally, use the Note field to enter any notes for the new custom macro,
providing a clear explanation of what the custom macro is designed to do and
what each variable represents.

7. From the Expression Type drop-down list, select the type of custom macro
you are creating.
v If you select Raw SQL Selecting ID List, you must also select a database

from the drop-down list in the Database field.
v If you select Raw SQL Selecting ID + Value, you must also select a

database from the drop-down list in the Database field and select the value
type of the field from the Value Type drop-down list. Ensure that the value
type you select here is correct. Otherwise, when you later attempt to profile
this query, you will get a "Mismatched Type" error.

v If you selected Text as the value type, specify the width of the value type in
bytes in the Width (# Bytes) field. You must obtain this width in bytes
information from the database. If you do not have access to the database or
are unable to obtain the information, enter 256, the maximum width.

8. Click inside the Expression field to open the Specify Selection Criteria
window.
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9. Create your query expression. You can use as many variables as you like.
Variable syntax is alphanumeric, and the variable must be enclosed in open
and closed angle brackets (<>). Operands (values and strings) and operators
might be variables.

Important: Do not use flowchart user variables in custom macro definitions,
since custom macros are global and flowchart user variables are not.
Example: Custom macro that uses raw SQL selecting an ID and a value

10. Click Save to save the custom macro.
The custom macro is then stored, and can be accessed by its name.

11. Click Close to exit the Custom Macros dialog.

Guidelines for using custom macros

Keep the following guidelines in mind when creating or using a custom macro:
v The name of a custom macro must be alphanumeric. You cannot use spaces in

the name string, but you can use underscores (_).
v If a data source has been configured with the property

ENABLE_SELECT_SORT_BY = TRUE, then you must write raw SQL custom
macros with an ORDER BY clause in order to sort the returned records by the
audience key fields of the audience level under which you are working.
Otherwise, if the sort order is not as expected, an error will be generated when
the custom macro is used in a derived field in a Snapshot process.

v If you do not compare a returned value from a custom macro, if the value is
numeric, non-zero values are treated as TRUE (and therefore IDs associated with
them are selected) and zero values are treated as FALSE. String values are
always treated as FALSE.

v When creating a custom macro that uses raw SQL, using a temp table can
greatly speed up the performance of the raw SQL by scoping the amount of data
it needs to work with.
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When a custom macro uses temp tables in its underlying logic, a temp table will
be forced up to the database so that the logic does not fail.
However, if a custom macro is used in a top level SELECT, then there is no
history for Campaign to use to force a temp table up to the database, and the
logic fails.
Thus, when creating a custom macro that uses raw SQL, you might need to
create two versions of the same custom macro – one that uses temp table tokens
and one that does not.
The custom macro without temp table tokens can be used at the top of a tree
(for example, in the first SELECT). The one with temp table tokens can be used
anywhere else in the tree when there might be a temp table to take advantage
of.

v Self-joins might occur when combining values returned from custom macros
when querying against unnormalized data, which is not likely to be the desired
behavior.
For example, if you a use a custom macro based on raw SQL that returns a
value and (in a Snapshot process, for example) you output the custom macro
and another field from the table that the custom macro is based on, Campaign
performs a self join on that table. If the table is non-normalized, you will end up
with a Cartesian product (that is, the number of records displayed is more than
you would expect).

v Custom macros are now automatically by reference, because the definition of the
custom macro is not copied into the current process.
At execution time, a custom macro is resolved by looking up its definition in the
UA_CustomMacros system table (where definitions are stored) and then
used/executed.

v Unlike stored queries, custom macro names must be unique, independent of the
folder path. In releases prior to 5.0, you could have a stored query named A, for
example, in both folder F1 and F2.
Campaign supports stored queries from earlier releases. However, references to
non-unique stored queries must use the old syntax:
storedquery(<query name>)

v When resolving user variables in custom macros, Campaign uses the current
value of the user variable when checking syntax. If the current value is left
blank, Campaign generates an error.

v The temp table token is provided as a performance optimization advanced
feature that scopes the amount of data pulled down from the database by the set
of audience IDs in the temp table available for use by the current process. This
temp table list of IDs might be a superset of the IDs in the current cell.
Therefore, aggregate functions performed over the temp table (for example,
average or sum) are not supported and might generate incorrect results.

v If you intend to use the custom macro across several different databases, you
might want to use a IBM Unica expression rather than raw SQL, since raw SQL
can be specific to a particular database.

v If a custom macro contains raw SQL and another custom macro, the custom
macro is resolved, executed and its value returned before the raw SQL is
executed.

v Campaign treats a comma as a parameter separator. If you are using commas as
literal characters in a parameter, enclose the text in open and close brackets ({}),
as in the following example:
TestCM( {STRING_CONCAT(UserVar.Test1, UserVar.Test2) } )
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v Campaign supports simple substitution for parameters in custom macros using
raw SQL code. For example, if you set up a Select process box on a flowchart
containing this query:
exec dbms_stats.gather_table_stats(tabname=> <temptable>,ownname=>
'autodcc')

Campaign would successfully substitute the actual temp table in place of the
<temptable> token. Note that the single quotes around the table name are
required.

The following tables show how Campaign treats custom macros in queries and
derived fields.

Custom macros in queries and derived fields (Select, Segment, and Audience
Processes)

Type of custom macro How it is used

Raw SQL: IDs Runs as a separate query. The ID list is merged with other
results.

If a custom macro contains other custom macros plus raw
SQL, the custom macros are resolved and executed and
then the raw SQL is executed.

Raw SQL: IDs + Value Expects that the returned value will be used in an
expression or as a comparison.

If the value is not used this way, Campaign treats a
non-zero value as TRUE for ID selection and a zero value
and string as FALSE.

IBM Unica Expression The expression is resolved and a syntax check is
performed. One query per table is supported, and the IDs
are match/merged.

In a Raw SQL Query (Select, Segment, and Audience Processes)

Type of custom macro How it is used

Raw SQL: IDs Custom macro is resolved and then the query is executed.

Raw SQL: IDs + Value Not supported.

IBM Unica Expression The expression is resolved, but no syntax check is
performed. If the expression is incorrect, it is detected by
the database server when executed.

To manage a custom macro

You can create a folder structure to organize your custom macros. You can then
move custom macros from one folder to another within this structure.
1. On a flowchart page in Edit mode, click the Options icon and select Custom

Macros.
The Custom Macros dialog appears.

2. Navigate through the Items List to select the macro you want to edit.
The Info area shows the detailed information for the selected macro.

3. Click Edit/Move to edit or move the selected macro.
The Edit/Move Custom Macros dialog opens.
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4. You can change the name of the macro, edit the note, change the
folder/location where the macro is stored, or click Edit to edit the expression.

5. Click Save to save your changes.
6. Click Close to exit the Custom Macros dialog.

About templates
A template is a group of selected and saved processes from flowcharts. Templates
allow you to design and configure one or more processes only once, and save them
in the Template Library. Templates save process configurations and table
mappings, and are available for any session or campaign.

To copy a template to the Template Library

You can add templates to the template library by copying them there.
1. In a flowchart in Edit mode, select the process(es) you want to save as a

template. Use Shift+Click and Ctrl+Click to select multiple processes.
2. Right-click on the process(es) you want to copy and select Copy to Template

Library.
The Save Template window appears.

3. Enter the name of the template in the Name field.
You cannot use spaces in the name string. Stored templates are identified by
names, which must be unique in the folder in which it is stored.

4. (Optional) Enter a free-form text description in the Note field.
5. (Optional) Select a folder where the template will be located. Select an existing

folder from the list, or select New Folder to create a new one. The currently
selected folder is shown after the Save Under field above the Item List. To
create a new folder, click New Folder. You can create an unlimited number of
folders (including nesting folders in a hierarchy) to organize and store your
templates.

6. Click Save.

To paste a template from the Template Library

You can paste a template from the Template Library into a flowchart you are
building.
1. On a flowchart page in Edit mode, click the Options icon and select Stored

Templates.
The Stored Templates dialog appears.

2. Select a template from the Items list.
3. Click Paste Template.

The selected template is pasted onto the flowchart workspace.

Note: The inserted processes might appear on top of other process already in the
flowchart. All inserted processes are initially selected to make them easy to move
as a group.

Templates can be accessed by any other session or campaign through the Template
Library. If a template is pasted into a flowchart that has different table mappings,
the subsequent mapping is augmented but not replaced by the new mapping,
unless the table name(s) are the same.
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To manage a template

You can create new folders, edit, move, and remove stored templates through this
command.
1. On a flowchart page in Edit mode, click the Options icon and select Stored

Templates.
The Stored Templates dialog appears.

2. From the Items List, select the template that you want to edit or move.
3. Click Edit/Move.

The Edit/Move Stored Templates dialog opens.
4. In the Save Under field, specify the folder/location to which you want to move

the template.
5. You can also change the name of the stored template, or edit the note

associated with it.
6. Click Save to save your changes.
7. Click Close to exit the Stored Templates window.

About stored table catalogs
A table catalog is a collection of mapped user tables. Table catalogs store all the
user table mapping meta data information for re-use across flowcharts. Table
catalogs are stored by default in a proprietary binary format using a .cat
extension.

For information on creating and working with table catalogs, see the Campaign
Administrator’s Guide

To access stored table catalogs

From a flowchart in page in Edit mode, click the Options icon and select Stored
Table Catalogs.

The Stored Table Catalog dialog appears.

Note: If you have administrator permissions, you can also access stored catalogs
from the Campaign Settings page. For more information, see the Campaign
Administrator's Guide.

To edit a table catalog
1. On a flowchart page in Edit mode, click the Options icon and select Stored

Table Catalogs.
The Stored Table Catalogs dialog appears.

2. Select the desired table catalog in the Items List.
The Info area shows the detailed information for the selected table catalog,
including the table catalog name and file path.

3. Click Edit/Move.
4. You can change the name of the stored table catalog, edit the table catalog

description, or change the folder/location where the table catalog is stored.
5. Click Save.
6. On the Stored Table Catalogs window, click Close.
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To remove a table catalog

Important: You should remove table catalogs only using the Campaign interface. If
you remove tables or otherwise change table catalogs directly in the file system,
Campaign cannot guarantee data integrity in your system.
1. On a flowchart page in Edit mode, click the Options icon and select Stored

Table Catalogs.
The Stored Table Catalogs window appears.

2. Select the desired table catalog in the Items List.
The Info area shows the detailed information for the selected table catalog,
including the table catalog name and file path.

3. Click Remove.
You see a confirmation message asking you to confirm removal of the selected
table catalog.

4. Click OK.
5. On the Stored Table Catalogs window, click Close.
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Chapter 10. Sessions

Like campaigns, sessions are comprised of individual flowcharts. However,
sessions allow you to create persistent data constructs (such as strategic segments,
stored dimension hierarchies, and cubes) that are available globally to all
campaigns. You can use sessions to create flowcharts that:
v Transform data required across campaigns;
v Produce PredictiveInsight input files;
v Contain strategic segments.

Note: When you are designing flowcharts, be careful not to create cyclical
dependencies among your processes. For example, your flowchart has a Select
process that provides input to a CreateSeg process. If you choose as input in your
Select process a segment that will be created by the same CreateSeg process that
the Select process provides output to, you will have created a cyclical dependency.
This situation will result in an error when you try to run the process.

Working with sessions
You can perform the following tasks with sessions:
v “To create a session”
v “About organizing sessions” on page 188
v “To view a session” on page 186
v “To edit a session's Summary details” on page 186
v “To edit a session flowchart” on page 186
v “About copying sessions” on page 187
v “About running sessions” on page 187
v “To move a session” on page 187
v “To delete a session” on page 187

Note: Working with sessions requires the appropriate permissions. For information
on permissions, see the Campaign Administrator's Guide.

To create a session
1. Select Campaign > Sessions.

The All Sessions page displays the folder structure used to organize your
company’s sessions. If you have previously opened a subfolder within the All
Sessions page, that subfolder will be displayed instead.

2. Navigate through the folder structure until you are displaying the contents of
the folder where you want to add your session.

3. Click the Add a Session icon.
The New Session page appears.

4. Enter a name, security policy and description for the session.

Note: Session names have specific character restrictions. For details, see
“Special characters in IBM Unica Campaign object names,” on page 219.

5. Click Save Changes.
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Note: You can also click Save and Add Flowchart to immediately start creating
your session’s flowcharts.

To view a session
1. Select Campaign > Sessions.

The All Sessions page appears.
2. Click the name of the session you want to view, to open the session’s Summary

tab.
OR

3. Click the View a tab icon next to the name of the session you want to view.
The Summary and the names of any flowcharts in the session appear in a
context-menu.

4. Select the session tab you want to view.
The session opens to the tab you selected.

To edit a session's Summary details
1. Select Campaign > Sessions.

The All Sessions page appears.
2. Click the name of the session whose summary details you want to edit.

The session opens to its Summary tab.
3. Click the Edit Summary icon.
4. Make your desired edits on the Summary tab.

Note: Session names have specific character restrictions. For details, see
“Special characters in IBM Unica Campaign object names,” on page 219.

5. When you have finished making your changes, click Save Changes.
Your changes are saved and the session closes.

To edit a session flowchart
1. Select Campaign > Sessions.

The All Sessions page appears.
2. Click the Edit a tab icon next to the name of the session whose flowchart(s)

you want to edit.
3. From the context-menu, click the name of the flowchart you want to edit.

The flowchart page appears in Read Only mode.
4. Click the Edit icon to open the flowchart in Edit mode.
5. Make the desired changes to the flowchart.
6. When you have finished making your changes, click Save or Save and Exit.

To edit a session flowchart's properties
1. Open the flowchart for editing.
2. Click Properties in the Flowchart toolbar.

The Edit Flowchart Properties page appears.
3. Modify the flowchart name or description.

Note: Flowchart names have specific character restrictions. See “Special
characters in IBM Unica Campaign object names,” on page 219.
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4. Click Save Changes.
The modified flowchart details are saved.

About copying sessions
You do not copy sessions, but rather the flowcharts within sessions.

About running sessions
To run a session, you need to run each of its flowcharts.

To move a session

You can move sessions from folder to folder for organizational purposes.

Note: If someone is editing a flowchart in the session you plan to move, that
entire flowchart might be lost when you move the session. You must make sure
that none of the flowcharts in the session are open for editing when you move the
session.
1. Select Campaign > Sessions.

The All Sessions page appears.
2. Open the folder that contains the session you want to move.
3. Select the checkbox next to the session you want to move. You can select

multiple sessions to move to the same location at one time.
4. Click the Move icon.

The Move Items To window appears.
5. Click the folder where you want to move the session.

Navigate through the list by clicking the + sign next to a folder to open it.
6. Click Accept this Location.

Note: You can also double-click a folder to select and accept the location in one
step.
The session is moved into the destination folder.

About deleting sessions
When you delete a session, the session and all flowchart files are deleted. If there
are portions of your session you want to store for reuse, you can save them as a
stored object. For more information, see “About derived fields” on page 171.

Important: If you delete a session that has associated contact or response history
records, all corresponding contact and response history records will be deleted. Do
not delete the session if you need to retain the associated contact and response
history.

To delete a session
1. Select Campaign > Sessions.

The All Sessions page appears.
2. Open the folder that contains the session you want to delete.

Navigate through the folder structure by clicking a folder name to open it,
clicking All Sessions to return to the All Sessions page, or clicking Parent
Folder to open the folder that contains the currently open folder.
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3. Select the checkbox next to the session you want to delete. You can select
multiple sessions to delete at one time.

4. Click the Delete Selected icon.

Note: If you attempt to delete a session that has associated contact or response
history records, a warning message indicates that all corresponding contact and
response history records will be deleted. If you need to retain the
corresponding contact and response history, click Cancel.

5. Click OK on the confirmation window.
The session is deleted.

About organizing sessions
You can organize your sessions by creating a folder or series of folders. You can
then move sessions from one folder to another within the folder structure you have
created.

You can add, move, and delete folders to organize your sessions. You can also edit
a folder’s name and description.

To add a session folder
1. Select Campaign > Sessions.

The All Sessions page appears.
2. Click the folder where you want to add a subfolder and click Add a Subfolder,

or simply click Add a Subfolder to add a folder at the top level.
The Add a Subfolder page appears.

3. Enter a name, the security policy, and description for the folder.

Note: Folder names have specific character restrictions. For details, see “Special
characters in IBM Unica Campaign object names,” on page 219.

4. Click Save Changes.

You are returned to the All Sessions page. The new folder or subfolder you created
is displayed.

To edit a session folder's name and description
1. Select Campaign > Sessions.

The All Sessions page appears.
2. Click the folder you want to rename.
3. Click the Rename icon.

The Rename a Subfolder page appears.
4. Edit the name and description of the folder.

Note: Folder names have specific character restrictions. For details, see “Special
characters in IBM Unica Campaign object names,” on page 219.

5. Click Save Changes.
You are returned to the All Sessions page. The folder or subfolder is renamed.
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To move a session folder

Important: If someone is editing a flowchart in the session you plan to move,
flowchart results or the entire flowchart might be lost when you move the session.
Please be sure that none of the flowcharts in the session are open for editing when
you move the session.
1. Select Campaign > Sessions.

The All Sessions page appears.
2. Click the folder containing the subfolder you want to move.
3. Select the checkbox next to the folder you want to move. You can select

multiple folders to move to the same location at one time.
4. Click the Move icon.

The Move Items To window appears.
5. Click the folder where you want to move the subfolder.

Navigate through the list by clicking the + sign next to a folder to open it.
6. Click Accept this Location.

Note: You can also double-click a folder to select and accept the location in one
step.

The subfolder and all its contents are moved into the destination folder.

To delete a session folder

You must move or delete the contents of a folder before you can delete it.

Note: If you have the permissions required to delete a folder, Campaign also
allows you to delete any of the subfolders in that folder.
1. Select Campaign > Sessions.

The All Sessions page appears.
2. Open the folder that contains the subfolder you want to delete.
3. Select the checkbox next to the folder you want to delete. You can select

multiple folders to delete at one time.
4. Click the Delete Selected icon.
5. Click OK on the confirmation window.

The folder and all its empty subfolders are deleted.

All Sessions page icons

The All Sessions page uses the following icons.

The icons, left to right, are described in the following table.

Note: Many of the icons in the Campaign interface are associated with features
that require permissions. For more information, see the Marketing Platform
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Administrator's Guide. The following Add a Session and Add a Subfolder icons do
not appear without the appropriate permissions.

Icon Name Description

Add a Session Click to add a new session.

Add a Subfolder Click to add a new session subfolder.

Print this Item Select one or more sessions by clicking the checkbox next
to each session, then click this icon to print the selected
sessions.

Move Select one or more sessions by clicking the checkbox next
to each session, then click this icon to specify a location to
move the selected sessions.

Delete Selected Select one or more sessions by clicking the checkbox next
to each item, then click this icon to delete the selected
sessions.

About strategic segments
A strategic segment is a globally persistent list of IDs. Strategic segments are
simply segments that are created, typically by Campaign administrators, using the
Create Seg process in a session flowchart, so that they are available for use
globally, in all campaigns.

Campaign supports multiple strategic segments; the ID list that is created for each
strategic segment and audience level is stored in the Campaign system tables. You
can associate an unlimited number of strategic segments with a campaign.

Strategic segments are often used in cubes. A cube can be created from any list of
IDs, but it is more powerful if it is based on a strategic segment, since cubes based
on strategic segments are global and can be analyzed by the various segment
reports.

Strategic segments can be used as global suppression segments. A global
suppression segment defines the list of IDs that are automatically excluded from
cells in flowcharts for a particular audience level.

Strategic segments can optionally specify one or more IBM Unica data sources in
which that strategic segment will be cached (that is, stored in the database so that
uploading the strategic segment IDs is not required for each flowchart using the
strategic segment). This can provide significant performance improvements in
using strategic segments.

Cached strategic segments are stored in temp tables, which are assigned the
TempTablePrefix configuration parameter.

Note: Working with stratetic segments requires the appropriate permissions. For
information on permissions, see the Campaign Administrator's Guide.

Improving performance of strategic segments
By default, the Create Seg process creates a segment bin file on the application
server, which can take a long time to complete for a large strategic segment. When
Campaign updates the binary file, it drops and then inserts the rows again into a
cached table; the entire file is rewritten for sorting. For extremely large strategic
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segments (for example, 400 million IDs), it takes a long time to rewrite the entire
file, even when the vast majority of the IDs have not changed.

To improve performance, you can use the doNotCreateServerBinFile property on
the Configuration page to specify that strategic segments create a temp table in the
data source instead of a bin file on the application server. When this property is set
to TRUE, at least one data source must be specified in the Create Seg process
configuration.

In addition, performance optimizations such as creating indices and generating
statistics, which cannot be applied to cached segment tables, can be used with
segment temp tables. The PostSegmentTableCreateRunScript,
SegmentTablePostExecutionSQL, and SuffixOnSegmentTableCreation properties on
the Configuration page support these performance optimizations.

For details about properties on the Configuration page, see the Campaign
Administrator's Guide.

Prerequisites for creating strategic segments
Before you create a strategic segment, you should do the following:
v Determine how your strategic segments will be organized, the folder hierarchy

and naming conventions you will use.
v Determine exactly what strategic segments are important to you.
v Determine the logic behind your strategic segments.
v Identify the relationship between different strategic segments.
v Identify the audience levels appropriate to your strategic segments.
v Determine how often the strategic segments should be refreshed.
v Determine what level of detail is defined in each strategic segment. For example,

should a segment include all suppressions?
v Determine if you want to keep historical strategic segments in an archive folder.
v Consider the size of the strategic segments you want to create and their

potential impact on performance. See “Improving performance of strategic
segments” on page 190.

To create a strategic segment

Note: Working with strategic segments requires the appropriate permissions. For
information on permissions, see the Campaign Administrator's Guide.

Strategic segments are created and made available for selection only when the
CreateSeg process has run successfully in production mode. Configuring the
CreateSeg process is not sufficient. Running the process in test mode does not
create a strategic segment or update an existing one.
1. Create a session, or open an existing session for editing.

Note: Segment names have specific character restrictions. For details, see
“Special characters in IBM Unica Campaign object names,” on page 219.

2. Build a flowchart whose final output process is the CreateSeg process.
3. Click Save and Return when you have finished creating your flowchart.

The flowchart is saved. The strategic segments are listed on the All Segments
page and are available for use in all campaigns.
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Example: Session flowchart creating strategic segments
In a flowchart in the Sessions area of Campaign, add two Select processes, one to
select all records from a particular field in a mapped table in your datamart, and
the other to select all records from the same datamart that have been classified as
opt-outs and thus need to be removed from the total list of IDs.

Next, use a Merge process whose input consists of the output cells of the two
Select processes to eliminate the OptOut IDs and produce an output cell of eligible
IDs.

Then, add a Segment process to which the eligible IDs from the Merge process are
passed, where they are divided into three discrete groups of IDs.

Finally, add a Create Seg process to output the three segments as a globally
persistent list of audience IDs.

Run the flowchart in production mode to create the strategic segment and make it
available for use in multiple campaigns.

To view a segment from the All Segments page
1. Select Campaign > Segments.

The All Segments page appears.
2. Click the name of the session you want to view.

The Summary page displays the segment’s summary information.

Table 18. Summary information for segments

Element Description

Description The description of the segment provided in the Create Seg
process

Source Flowchart The name of the flowchart where the segment was defined

Audience Level The audience level for the segment

Current Count The number of IDs in this segment and the date that this
segment was last run

Used in the Following
Campaign(s)

A list of all the campaigns that use the segment, with links
to those campaigns

To view a strategic segment from the Campaign summary
page

1. Go to the summary page of any campaign that uses the segment you want to
view.

2. In the Relevant Segments list, click the name of the segment.
The segment’s summary page appears.

To edit a segment's Summary details
1. Select Campaign > Segments.

The All Segments page appears.
2. Click the name of the segment whose summary details you want to edit.

The segment opens to its Summary tab.
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3. Make your desired edits to the name or description of the segment.

Note: Segment names have specific character restrictions. For details, see
“Special characters in IBM Unica Campaign object names,” on page 219.

4. When you have finished making your changes, click Save Changes.
Your changes are saved and the segment closes.

To edit a strategic segment's source flowchart
1. Select Camaign > Segments.

The All Segments page appears.
2. Click the name of the segment whose flowchart you want to edit.

The segment’s Summary page appears.
3. Under Source Flowchart, click the link to the flowchart.

The flowchart page opens in Read Only mode.
4. Click Edit to open the flowchart in Edit mode.
5. Make the desired changes to the flowchart.
6. When you have finished making your changes, click Save or Save and Exit.

Important: The existing strategic segment is not updated until you re-run the
updated flowchart in production mode.

All Segments page icons

The All Segments page uses the following icons

The icons, left to right, are described in the following table.

Table 19. Icons on the All Segments page

Icon Name Description

Add a Subfolder Click to add a new segment subfolder.

Advanced Search Click to open the Advanced Search Options dialog, where
you can specify attributes and values to search for offers.

Print Select one or more segments by clicking the checkbox next
to each segment, then click this icon to print the selected
segments.

Move Select one or more segments by clicking the checkbox next
to each segment, then click this icon to specify a new
location for the selected segments.

Delete Selected Select one or more segments by clicking the checkbox next
to each segment, then click this icon to delete the selected
segments.

Running strategic segments
You should re-generate strategic segments if the contents of your datamart have
changed. To re-generate a strategic segment, you run the flowchart in which that
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segment was created, in production mode. The Enable Output setting in Test Run
mode has no effect; strategic segments are output only in production mode.

Note: When a Create Seg process is re-run in production mode, the existing
strategic segment created by that process is deleted. This means that any users of
the existing strategic segment (including global suppressions) might see an
“invalid segment” error if the new Create Seg process run fails to complete
successfully, or while it is still running.

Organizing strategic segments
You can organize your strategic segments by creating a folder or series of folders.
You can then move strategic segments from one folder to another within the folder
structure you have created.

Note: The folder in which a strategic segment resides specifies the security policy
applying to the strategic segment, determining who can access, edit, or delete it.

To add a segment folder

You can add, move, and delete folders to organize your segments. You can also
edit a folder’s name and description.
1. Select Campaign > Segments.

The All Segments page appears.
2. Click the folder where you want to add the subfolder.
3. Click the Add a Subfolder icon.

The Add a Subfolder page appears.
4. Enter a name, the security policy, and description for the folder.

Note: Folder names have specific character restrictions. For details, see “Special
characters in IBM Unica Campaign object names,” on page 219.

5. Click Save Changes.
You are returned to the All Segments page. The new folder or subfolder you
created is displayed.

To edit a segment folder's name and description
1. Select Campaign > Segments.

The All Segments page appears.
2. Click the folder you want to rename.
3. Click Rename.

The Rename a Subfolder page appears.
4. Edit the name and description of the folder.

Note: Folder names have specific character restrictions. For details, see “Special
characters in IBM Unica Campaign object names,” on page 219.

5. Click Save Changes.
You are returned to the All Segments page. The folder or subfolder is renamed.

To move a segment folder

Important: If someone is editing the source flowchart for any segment you plan to
move, that entire flowchart might be lost when you move the segment. Make sure
none of the source flowcharts are open for editing when you move the subfolder.
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1. Select Campaign > Segments.
The All Segments page appears.

2. Open the folder that contains the subfolder you want to move.
Navigate through the folder structure by clicking a folder name to open it,
clicking All Segments to return to the All Segments page, or clicking a folder
name to open folders in the tree.

3. Select the checkbox next to the folder you want to move. You can select
multiple folders to move to the same location at one time.

4. Click the Move icon.
The Move Items To window appears.

5. Click the folder where you want to move the subfolder.
Navigate through the list by clicking the + sign next to a folder to open it.

6. Click Accept this Location.

Note: You can also double-click a folder to select and accept the location in one
step.
The subfolder and all its contents are moved into the destination folder.

To delete a segment folder

You must move or delete the contents of a folder before you can delete it.

Note: If you have the permissions required to delete a folder, Campaign also
allows you to delete any of the subfolders in that folder.
1. Select Campaign > Segments.

The All Segments page appears.
2. Open the folder that contains the subfolder you want to delete.

Navigate through the folder structure by clicking a folder name to open it,
clicking All Segments to return to the All Segments page, or clicking a folder
name to open folders in the tree.

3. Select the checkbox next to the folder you want to delete. You can select
multiple folders to delete at one time.

4. Click the Delete Selected icon.
5. Click OK on the confirmation window.

The folder and all its empty subfolders are deleted.

To move a segment

You can move strategic segments from folder to folder for organizational purposes.

Important: If a source flowchart for the segment you plan to move is open for
editing, the entire flowchart may be lost when you move the segment. Make sure
that none of the source flowcharts are open for editing before you move the
subfolder.
1. Select Campaign > Segments.

The All Segments page appears.
2. Open the folder that contains the segment you want to move.
3. Click the checkbox next to the segment you want to move. You can select

multiple segments to move to the same location at one time.
4. Click the Move icon.
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The Move Items To window appears.
5. Click the folder where you want to move the segment.

Navigate through the list by clicking the + sign next to a folder to open it.
6. Click Accept this Location.

Note: You can also double-click a folder to select and accept the location in one
step.
The segment is moved into the destination folder.

Deleting strategic segments
Strategic segments can be deleted in the following ways:
v By deleting the strategic segment itself from its folder location on the All

Segments page. Strategic segments that you delete by this method will be
re-created if the Create Seg processes that generated them originally are re-run
in production mode. For details, see “To delete a segment.”

v By deleting the Create Seg process that created the strategic segment. The
strategic segment is deleted only when the flowchart is saved. Strategic
segments deleted in this way cannot be recovered. For details, read about
deleting processes in flowcharts.

v By deleting the flowchart containing the Create Seg process that created the
strategic segment. Strategic segments deleted in this way cannot be recovered.
For details, read about deleting flowcharts.

To delete a segment

Use the following procedure to delete a strategic segment directly from the All
Segments page.

Note: Strategic segments that you delete by this method will be re-created if the
Create Seg processes that generated them originally are re-run in production mode.
1. Select Campaign > Segments.

The All Segments page appears.
2. Open the folder that contains the segment you want to delete.
3. Select the checkbox next to the segment you want to delete. You can select

multiple segments to delete at one time.
4. Click the Delete Selected icon.
5. Click OK on the confirmation window.

The segment is deleted.

Note: If there are still active flowcharts that contain the segment, the segment
can be re-created when those flowcharts are run. If a flowchart containing the
segment was open for editing when you deleted the segment, it will also be
re-created.

About global suppressions and global suppression segments
Use the global suppression feature to specify a list of IDs (in a single audience
level) that are automatically excluded from all cells in flowcharts in Campaign.
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You do this by creating this list of unique IDs as a strategic segment, then by
specifying that segment as a global suppression segment for a particular audience
level. Only one global suppression segment can be configured for each audience
level.

Note: Specifying and managing global suppression segments requires the
appropriate permissions and is usually performed by your Campaign
administrator. For details, see the IBM Unica Campaign Administrator’s Guide.

Applying global suppressions
If a global suppression segment has been defined for an audience level, all
top-level Select, Extract, or Audience processes associated with that audience level
automatically exclude the IDs in the global suppression segment from their output
cells (unless the global suppression is explicitly disabled for a specific flowchart).
By default, flowcharts have global suppression enabled so that no action needs to
be taken for any configured global suppression to be applied.

An exception to the default of global suppression being enabled is the flowchart
containing the CreateSeg process that created the global strategic segment itself. In
this case, the global suppression is always disabled (only for the audience level for
which the global suppression segment is being created).

Note: Also note that performing Test Query in Select, Extract or Audience
processes does not take into account any global suppressions.

Switching audiences with global suppressions

If you are switching from Audience 1 to Audience 2 in a flowchart, and have one
global suppression defined for each of these audience levels, the global
suppression segment for Audience 1 is applied to the input table, and the global
suppression segment for Audience 2 is applied to the output table.

Disabling global suppressions
You can disable global suppressions for individual flowcharts only if you have the
appropriate permissions. If you do not have the appropriate permissions, you
cannot change the setting and must run the flowchart with the existing setting.

An administrator might grant global suppression override permissions to specific
users so that they can design and execute special campaigns that are allowed to
contact normally suppressed IDs, for example, IDs in a universal holdout group.

To disable global suppressions for a flowchart
1. Open the flowchart for editing.
2. Click the Admin icon and select Advanced Settings.
3. In the Advanced Settings window, check the Disable Global Suppressions for

this Flowchart checkbox.
4. Click OK.

About dimension hierarchies
A dimension hierarchy is a set of SQL selection queries that can be applied to any
list of IDs. Like strategic segments, dimension hierarchies can be made available
globally in a Select process or used as the basis for constructing cubes.
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Among the most commonly specified dimensions are time, geography, product,
department, and distribution channel. However, you can create any kind of
dimension that best relates to your business or campaign.

As the building blocks of cubes, dimensions become the basis for a variety of
reports (total sales across all products at increasing aggregation levels, cross-tabular
analysis of expenses versus sales by geography, and so on). Dimensions are not
limited to a single cube; they can be used in many cubes.

A dimension hierarchy is made up of various levels, which in turn are comprised of
dimension elements, or elements for short.

Campaign supports dimensions that are comprised of an infinite number of levels
and elements, as well as:
v Data points built as input to customer analytic reporting and visual selection
v Roll ups into unlimited number of categories to support drill-down capability.

(Dimensions must roll up cleanly across boundaries, so elements must be
mutually exclusive and not overlap.)

Examples: Dimension hierarchies
The following two examples illustrate a basic dimension hierarchy that would be
created in your datamart and then mapped into Campaign.

Example: Age Dimension Hierarchy

Lowest level: (21–25), (26–30), (31–35), (36–45), (45–59), (60+)

Rollups: Young (18–35), Middle (35–59), Older (60+)

Example: Income Dimension Hierarchy

Lowest level: >$100,000, $80,000–$100,000, $60,000–$80,000, $40,000–$60,000

Rollups: High (> $100,000), Middle ($60,000–$100,000), Low (< $60,000) (> $100,000),
($60,000–$100,000), (< $60,000)

Creating dimension hierarchies
To use dimensions in Campaign, you must do the following:
v Define and create a hierarchical dimension in a table or delimited flat file in

your data mart
v Map this hierarchical dimension table or flat file to a dimension in Campaign

Note: A hierarchical dimension is created in the data mart either by the Campaign
system administrator or by members of your IBM Unica consulting team, and is an
operation external to Campaign. Also note that the lowest level of the hierarchical
dimension must use either raw SQL or a pureIBM Unica Expression (no custom
macros, strategic segments, or derived fields) to define the individual elements.

When this hierarchical dimension is then mapped into Campaign, Campaign
executes this code to perform the various roll-ups.
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To map a hierarchical dimension to a Campaign dimension

Note: The following instructions assume that a hierarchical dimension already
exists in your data mart.

Note: Since in almost all cases dimensions will be used to create cubes, you may
want to create dimensions from a flowchart in the Sessions area of the application.
1. Access the Dimension Hierarchies window from one of the following places:

v In a flowchart in Edit mode, click the Admin icon and select Dimension
Hierarchies.

v On the Administrative Settings page, select Manage Dimension Hierarchies.
The Dimension Hierarchies window appears.

2. Click New Dimension.
The Edit Dimension window appears.

3. Enter the following information about the dimension you are creating:
v Dimension Name
v Description
v The number of levels in the dimension (in most cases, this should correspond

to the levels in the hierarchical dimension in the data mart to which you are
mapping this dimension).

v If you are using this dimension as the basis for a cube, ensure that the
Elements are Mutually Exclusive check box is checked (Campaign checks
this option by default). Otherwise, you will receive an error when you use
this dimension to create a cube, since the values in elements cannot overlap
in a cube.

4. Click Map Table.
The Edit Table Definition window appears.

5. Select one of the following options:
v Map to Existing File.
v Map to Existing Table in Selected Database.
Proceed with the steps for mapping a table. For details, see the Campaign
Administrator's Guide.

Note: When mapping tables for dimension hierarchies, the field names
“Level1_Name,” “Level2_Name,” etc. must exist in the table for mapping to
succeed.
When you have finished mapping the table for the dimension, the Edit
Dimension window appears with the dimension information for the new
dimension.

6. Click OK.
The Dimensions Hierarchies window appears with the newly mapped
dimension visible.

7. To store a dimension hierarchy so that it is available for future use and does
not need to be recreated, click Save on the Dimension Hierarchies window.

To update a dimension hierarchy

Campaign does not support automatic updates of dimension hierarchies. If the
underlying data changes, you must update the dimension hierarchies manually.
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Note: Cubes are comprised of dimensions which are based on strategic segments,
therefore you must update dimensions whenever strategic segments are updated.
1. Access the Dimension Hierarchies window from one of the following places:

v In a flowchart in Edit mode, click the Admin icon and select Dimension
Hierarchies.

v On the Administrative Settings page, select Manage Dimension Hierarchies.
The Dimension Hierarchies window appears.

2. Click Update All.

Note: To update individual dimensions, select the dimensions, then click
Update.

To load a stored dimension hierarchy
1. Access the Dimension Hierarchies window from one of the following places:

v In a flowchart in Edit mode, click the Admin icon and select Dimension
Hierarchies.

v On the Administrative Settings page, select Manage Dimension Hierarchies.
The Dimension Hierarchies window appears.

2. Highlight the dimension hierarchies that you want to load and click Load.

About cubes
A cube is the simultaneous segmentation of a list of IDs (most often a strategic
segment) by the queries provided by a number of dimension hierarchies. After the
cube is created, you can view segment cross-tab reports that drill into two
dimensions of the cube at any given time.

Before you can create a cube, you must perform the following preliminary tasks:
v Create a strategic segment
v Create dimensions that are based on the strategic segment
v The following guidelines apply to cubes:
v Cube metrics can be defined as any Campaign expression with the following

restrictions:
– You can specify an unlimited number of additional NUMERIC metrics and

Campaign will calculate min, max, sum, average for them. Selected metrics
can be derived fields or persistent derived fields.

– The aggregation function on cell count (min, max, avg, % of total no, and so
on) is calculated automatically.

– The aggregation function on an attribute value (for example, avg(age) )
automatically calculates min, max, sum, and average.

– Expressions that contain multiple attribute values (for example, (attribute1 +
attribute2) ) are supported in derived fields.

– The Cube process supports derived fields and persistent derived fields.
– Groupby expressions (for example, (groupby_where (ID, balance, avg,

balance, (trxn_date > reference_date))) ) are supported in derived fields.
– Expressions involving user variables (defined in same flowchart as cube

process AND exposed to Distributed Marketing) are supported in derived
and persistent derived fields. (For more information about Distributed
Marketing, see the Distributed Marketing User’s Guide.)
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– Expressions that use raw SQL are supported in a derived field that uses a raw
SQL custom macro

– Expressions that use a custom macro are supported in a derived field.
v Although cubes are composed of up to three dimensions, metrics can be

displayed for only two dimensions at a time. The undisplayed third dimension
is still computed and stored on the server, but is not used in visual
selection/reporting for that particular report.

v Cubes can be built on cells as well as segments (which, for example, can be
created at the transaction level). However, if a cube is built on a cell, the cube is
available only in that flowchart. For that reason, you may want to base cubes on
strategic segments.

v Unless your tables are normalized, defining dimensions with a many-to-many
relationship with the audience level could produce unexpected results. The cube
algorithm used by Campaign relies on normalized tables. Before you select and
build a cube, normalize data by rolling it up (to the customer level through a
data prep session for example).

Note: If you build a cube on non-normalized dimensions, the sum counts will
be wrong in the crosstab reports, owing to the way that Campaign processes the
dimension IDs. If you must use non-normalized dimensions, build cubes with
only two dimensions and use transactions as the lowest level metric of the
nonnormalized dimensions, rather than customer IDs, since the transaction sum
will be correct.

v When creating a cube dimension, you must give the dimension a name,
audience level, and a table to correspond to the dimension. Later, when working
in a session or a campaign flowchart, you map this dimension the same as if
you were mapping a database table.

v Cubes should be built when users are not accessing them, typically after
business hours and on weekends.
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Chapter 11. Reports

The following types of reports are available for Campaign:
v Standard reports: Included with Campaign. Access these reports from the

Campaign Analytics page.
v Example reports in the Campaign Reports Pac: Available if Campaign is

integrated with IBM Cognos®. Access these reports from the Campaign Analytics
page or the Analysis tab for a specific object, such as a campaign or offer.

v Example reports for related products: Available if Campaign is integrated with
IBM Cognos and you installed report packs for the Campaign-related products,
including eMessage, Interact, or Distributed Marketing. Access these reports
from the Analytics page for each product and from the Analysis tab for a
specific object, such as a campaign or offer. For more information, see the
documentation for those products.

v Flowchart cell reports, which provide information about cells in a particular
flowchart in a session or campaign. Access cell reports by using the Reports icon
when you view a flowchart in Edit mode.

Report types
Campaign supports three general types of reports:
v System-wide reports — reports across multiple objects within Campaign. These

reports are accessed from the Campaign Analytics page, which is launched from
the Analysis link on the main navigation pane. For example, from the folders on
the Campaign Analytics page, you can access the Calendar of Campaigns report,
which displays all campaigns in the system in a calendar format.

v Object-specific reports — reports pertaining to a specific object (a campaign or
offer). These reports are accessed through an object’s Analysis tab. For example,
from a campaign’s Analysis tab, you can access the Campaign Performance
Summary by Offer report, which provides a summary of campaign and offer
performance with offers grouped by the corresponding campaigns.

v Flowchart cell reports — reports that provide a variety of information relating
to the cells in a particular flowchart in a session or campaign. Cell reports can be
accessed by clicking the Reports icon when you view a flowchart in Edit mode.

Note: Access to an object’s flowcharts, Analysis tab, and Campaign Analytics page
depends on your permissions.

Campaign list portlets

This section describes the standard Campaign portlets that are available for use on
dashboards even if the Campaign reports package is not installed.

Report Description

My Custom
Bookmarks

A list of links to websites or files created by the user viewing the
report.

My Recent
Campaigns

A list of the most recent campaigns created by the user viewing the
report.
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Report Description

My Recent Sessions A list of the most recent sessions created by the user viewing the
report.

Campaign Monitor
Portlet

A list of the campaigns that have run or are currently running that
were created by the user viewing the report.

Campaign IBM Cognos report portlets

This section describes the dashboard portlets that are available in the Campaign
reports package.

Report Description

Campaign Return on
Investment
Comparison

An IBM Cognos report comparing, at a high level, the ROI of
campaigns created or updated by the user viewing the report.

Campaign Response
Rate Comparison

An IBM Cognos report comparing the response rates of one or
more campaigns created or updated by the user viewing the report.

Campaign Revenue
Comparison by Offer

An IBM Cognos report comparing the revenue received to date per
campaign containing offers created or updated by the user viewing
the report.

Offer Responses for
Last 7 Days

An IBM Cognos report comparing the number of responses that
were received over the last 7 days based on each offer created or
updated by the user viewing the report.

Offer Response Rate
Comparison

An IBM Cognos report comparing the response rate by offer
created or updated by the user viewing the report.

Offer Response
Breakout

An IBM Cognos report showing the various active offers created or
updated by the user viewing the report, broken out by status.

Working with reports
The following sections provide information about using reports in Campaign.
v “Accessing and viewing reports”
v “Report controls” on page 205
v “The Reports toolbar” on page 206
v “To send a report by email” on page 206
v “Viewing reports in various formats” on page 206
v “Re-running reports” on page 207

Accessing and viewing reports
Access to reports is dependent on your access permissions to an object or function.
For example, if you do not have permissions to edit flowcharts, you will not be
able to access the cell reports for flowcharts.

Reports are accessible from these sections of Campaign:
v The Campaign Analytics link in the Analytics menu — this link opens the

Campaign Analytics page, which displays folders for all available reports in
Campaign. Click the link for a folder to view subfolders or lists of reports you
can run. Reports are listed with a modified date and time.
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v The Analysis tab of an object — displays links to reports for this campaign,
offer, or segment. You select the type of report to view from the Report Type
drop-down list at the top right of the page.

v A flowchart page in Edit mode — The Reports link at the top of the page opens
cell reports for the flowchart. Access to cell reports and the ability to export cell
reports are dependent on your access permissions.

To view reports from the Campaign Analytics page
1. Select Analytics > Campaign Analytics.

The Campaign Analytics page appears, displaying folders for the available
reports in Campaign.

2. Click the folder containing the reports you want to view. You see a page
displaying the folder contents, including subfolders, if any.

3. Click the link for the report you want to view. If the report allows filtering, the
Report Parameter window opens.

4. Select one or more objects on which to filter the report. Note that only the
specific objects to which you have access will appear for selection. For reports
allowing multiple object selection, select multiple objects by holding down the
Ctrl key while selecting.

5. When you have finished selecting objects for the report, click Generate the
Report. The report displays in the same window.

To view reports from a campaign's Analysis tab
1. Select the campaign on which you want to report. You see the Campaign

Summary page.
2. Click the Analysis tab. You see the Report Type drop-down list at the top right

of the page.
3. Select the type of report you want to view from the drop-down list. The report

displays in the same window.

To view cell reports from a flowchart

Access to cell reports is dependent on your permissions. For example, if you do
not have permissions to edit or review (edit without save) flowcharts, you will not
be able to access the cell reports for a flowchart. In addition, you must have
explicit access to view cell reports, or to export cell reports. For details, see the
Campaign Administrator’s Guide for descriptions of the cell reports-related
permissions for the system-defined Administrative Role.
1. In a flowchart in Edit mode, click the Reports icon. The Cell Specific Reports

window opens. By default, the Cell List report is displayed. You see the Report
to View drop-down list at the top right.

2. Select the type of report you want to view from the drop-down list. The report
displays in the same window.

3. (Optional) You can click Options select a view setting, or click Print or Export
to print or export the current cell report.

Report controls
When you generate a report for viewing, the following controls and information
are available:
v Report generation time — displayed at the bottom right of the report page.
v Report generation date — displayed at the bottom left of the report page.
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v Top/Bottom control — click these links to display the top or bottom of the
report. Only displayed if the current report spans more than one page.

v Page up/Page down control — click these links to display the previous or next
page of the report. Only displayed if the current report spans more than one
page.

The Reports toolbar

Note: The Reports toolbar is displayed only for reports generated by Cognos. It is
not available for the calendar or segment reports, or for the cell reports within
flowcharts.

When a report is generated, you see the Reports toolbar, from which you can
perform the following tasks:
v Keep this version: Send the report by email
v Drill Down/Drill Up: Used for reports that support dimensional drilling.
v Related links: Used for reports that support dimensional drilling.
v View format: The default viewing format for reports is HTML. You can choose

other viewing formats from the drop-down list. The viewing format icon
changes depending on the currently selected view option.

To send a report by email

This option requires that your SMTP server be set up to work with Cognos. If this
feature is not available, please see your reports administrator.

If you acquired your Cognos license with your IBM Unica products, the option to
include a link to the report is not supported. To use this feature, you must
purchase a full license for Cognos.
1. After the report has finished running, click Keep this version in the Reports

toolbar and select Email Report from the drop-down list. You see the Set the
email options page, where you specify the recipients of the email, and optional
message text.

2. To send the report as an attachment in the email message, select the Attach the
report checkbox and clear the Include a link to the report checkbox.

3. Click OK. The request is sent to your email server.

Viewing reports in various formats

Note: Not all reports can be viewed in all formats. For example, reports that use
multiple queries cannot be viewed in CSV or XML formats.

The report viewer allows you to view the report in these formats:
v HTML
v PDF
v Excel
v CSV
v XML
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To view a report in HTML format

HTML is the default view for reports. If you are viewing a report in another
format, you can switch back to HTML by clicking the View format icon on the
Reports toolbar and selecting View in HTML Format from the drop-down list.
After the page refreshes, you can use the Report controls to navigate through the
report, if it spans more than one page.

To view a report in PDF format

After generating a report, click the View format icon on the Reports toolbar and
select View in PDF Format from the drop-down list. The page refreshes, and the
report displays in PDF format. You can save or print the report using the PDF
reader controls.

To view a report in Excel format

After generating a report, click the View format icon on the Reports toolbar, then
use the View in Excel Options. When prompted, specify whether to open or save
the file:
v To view the report without saving it, click Open. The report displays as a single

page in Excel format.
v To save the report, click Save and follow the prompts.

To view a report in CSV (comma-separated value) format

After generating a report, click the View format icon on the Reports toolbar, click
View in Excel Options and select View in CSV Format from the drop-down list. A
new window opens. You see a window asking whether you want to open or save
the file.
v To view the report without saving it, click Open. The report displays as a single

page in a spreadsheet format.
v To save the report, click Save. The Save As window opens. Navigate to the

location where you want to save the file, and enter a name in the File name
field. (By default, the file is saved as an .xls file.) Click Save. When the file has
finished saving, you see the Download complete window.

To view a report in XML format

After generating a report, click the View format icon on the Reports toolbar and
select View in XML Format from the drop-down list. The page refreshes and the
report is displayed as XML in the same window.

Re-running reports
Reports are generated against the data source so that they reflect the latest data. If
you believe that the data has changed since the report you want to view was last
run and want to view an up-to-date version, you can re-run the report.

List of reports in Campaign
This section describes the reports available in Campaign, grouped in the following
categories:

Standard reports:

v “Flowchart cell reports” on page 208
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v “Segment Crosstab reports” on page 213
v “Calendar of Campaigns” on page 213

Reports provided in the Campaign Reports Pack (optional):
v “Campaign and offer listings reports” on page 213
v “Performance reports” on page 214

For more information on installation and configuration of IBM Unica reporting, see
the installation guide and the IBM Unica Marketing Platform Administrator's Guide.

For detailed information about the data items, queries and expressions used in
each report, see the IBM Unica Campaign Report Specifications document.

Flowchart cell reports
Cell reports provide a variety of information relating to the cells in a particular
flowchart in a session or campaign. All cell reports can be accessed from the
Reports menu when you view a flowchart in Edit mode.

Campaign supports the following types of cell reports:
v “Cell List report”
v “Cell Variable Profile report” on page 209
v “Cell Variable Crosstab report” on page 210
v “Cell Content report” on page 211
v “Cell Waterfall report” on page 211

To print and export cell reports

You can print any cell report or export it to an Excel spreadsheet by clicking on the
Print or Export button at the top of the Cell Specific Reports page.

Cell List report
Cell List reports provide information about all the cells used in the current
flowchart. The information is a result of the cell outputs from all processes run on
the flowchart.

To generate a Cell List report:

1. Open an existing flowchart in Edit mode, or create a new flowchart.
2. Click the Reports icon.

The Cell Specific Reports window appears, with the Cell List report displayed
by default. Each cell in the flowchart displays on one row in the report.
The report shows data from the last run of the flowchart. The status column
indicates the type of flowchart run that was executed: test run or production
run.

3. (Optional) To toggle the display between Tree View and Table View, click
Options. You see the Report Options window, where you can select one of the
following options:
v Tree View — view the flowchart cells in a tree view which simulates a folder

hierarchy. The levels in this view represent ths levels in the flowchart. Higher
level folders can be expanded or collapsed to show or hide the items below.

v Table View — view the flowchart cells in a table format. This is the default
option.
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Cell Variable Profile report
The Cell Variable Profile report displays the data associated with one variable of a
specified cell. For example, the following figure shows the Gold.out cell (for those
clients with gold credit cards) of the Multi-channel Retention campaign. The
Age-Range variable is displayed to show the age range of those who belong to the
Gold.out cell.

Cell Variable Profile report

To generate a Cell Variable Profile report:

1. Open an existing flowchart in Edit mode, or create a new flowchart
2. Click the Reportsicon. The Cell Specific Reports window appears, with the Cell

List report displayed by default. Each cell in the flowchart displays on one row
in the report.

3. Select Cell Variable Profile from the Report to View drop-down list.
4. Select the cell you want to profile from the Cell to Profile drop-down list.
5. Select a field on which to profile the selected cell, from the Field drop-down

list.
6. Campaign generates a cell variable profile based on the cell and field you

selected.
7. (Optional) To modify the report display, click Options. You see the Report

Options window, where you can select from the following options:
v Number of Bins — Enter the number of bins you want to report to display.

The field values along the horizontal axis are organized into bins. If the
number you specify is less than the number of different field values, some
fields will be joined in one bin. The default is 25.

v Profile By Meta Type — Click to profile by metadata. For more information
on profiling by metadata, see Profiling by meta type. This option is enabled
by default.

v View Table — View the report in a table format. Each bin is represented as a
row, with the count for each bin as a column.

Chapter 11. Reports 209



v View Plot — View the report as a graph. This is the default option. When
you view a two- or three-dimensional report, you can right-click on the
report to access more display options.

v Show 2nd Cell — If more than one cell is available for profiling, select this
option to view a second cell in the report. When you select this option, you
see a drop-down list from which you select an additional cell to profile. The
two cells are then displayed side by side in graphical format.

Cell Variable Crosstab report
The Cell Variable Crosstab report displays details for a cell profiled by two fields
simultaneously. The report divides each selected field into a number of bins, and
the size of the box at each intersection represents the relative number of customer
IDs that have the selected attributes. For example, in the following figure, two
records from the Gold.out cell are profiled: funds (Indiv._Total_Funds) by name
(First_Name). Another example might be age by amount purchased.

Note: The process from which the cell is generated must be fully configured and
must run successfully in order to profile the cell.

Cell Variable Crosstab report

To generate a Cell Variable Crosstab report:

1. Open an existing flowchart in Edit mode, or create a new flowchart.
2. Click the Reports icon. The Cell Specific Reports window appears, with the

Cell List report displayed by default. Each cell in the flowchart displays on one
row in the report.

3. Select Cell Variable Crosstab from the Report to View drop-down list.
4. Select a cell from the Cell drop-down list.
5. Select fields (variables) to profile from the Field 1 and Field 2 drop-down lists.

Campaign generates the report based on your selections.
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6. (Optional) To modify the report display, click Options. You see the Report
Options window, where you can select from the following options:
v Number of Bins — Change the number of bins displayed. The field values

along the horizontal axis are organized into bins. If the number you specify
is less than the number of different field values, some fields will be joined in
one bin. The default is 10.

v Profile By Meta Type — Click to profile by metadata. For more information
on profiling by metadata, see Profiling by meta type. This option is enabled
by default.

v View Table — Select to view the report as a table.
v View 2-D Plot — elect to view the report as a 2-D plot graph (the default).

When viewing a two or three dimensional report, you can right click on the
report to access an array of display options.

v View 3-D Plot — Select to view the report as a 3-D plot graph. When
viewing a two or three dimensional report, you can right click on the report
to access an array of display options.

v Cell 1 Display — Select the way the cell information is displayed in the
X-axis. For certain numeric fields, you can select fields to operate on from the
Value Field drop-down menu.

v Value Field — (For both Cell 1 Display and Cell 2 Display). Add a variable
to the existing variable being profiled. This second variable will appear as a
box within the box that represents the first variable.

Cell Content report
The Cell Content report displays details of the records within a cell. You can
display values from any table sources defined at the current audience level. This
report is useful for verifying the results of runs.

To generate a Cell Content report:

1. Open an existing flowchart in Edit mode, or create a new flowchart.
2. Click Reports icon. The Cell Specific Reports window appears, with the Cell

List report displayed by default. Each cell in the flowchart displays on one row
in the report.

3. Select Cell Content from the Report to View drop-down list.
4. Select a cell from the Cell To View pull-down menu.
5. (Optional) To modify the report display, click Options. You see the Report

Options window, where you can select from the following options:
v Max. number of rows to view — Change the maximum number of rows that

the report displays. The default is 100.
v Fields to View — Select fields to view in the report by selecting fields in the

Available Fields area and adding them to the Fields to View area.
v Skip Records with Duplicate IDs — Choose to skip records with duplicate

fields. This is useful if you are using non-normalized tables. This option is
disabled by default.

Cell Waterfall report
The Cell Waterfall report shows the falloff of audience members as cells are input
and output through the various processes in a flowchart. This report identifies
processes which have reduced output volume and the details of the reduction by
percentage and quantity. Use Cell Waterfall reports to refine target counts by
viewing the falloff incurred by each successive criteria.
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In the following example, the report profiles the Gold.out cell from the Gold
process in the Multi-Channel Retention Campaign flowchart.

The IDs in the Gold.out cell are passed to the Merge process named Eligible. The
output cell of the Merge process, Eligible.out, adds 7683 IDs to Gold.out, which
then is merged with the Planinum.out cell, resulting in an increase rather than a
decrease in the number of IDs. Because of the Opt Outs process, some IDs are
extracted from the merged result of Gold.out and Platinum.out, resulting in a
number less than the sums of the two cells. Next, the Eligible.out cell is passed to
a Segment process called Value Tiers, where Eligible.out is parsed into several
different contact channels.

The Cell Waterfall report based on this flowchart is shown in the following figure.

The Totals row in the Cell Waterfall report shows that 10,705 IDs were removed
from the Gold.out cell. The report also displays the number IDs remaining, as well
as the percentage of original Gold.out IDs remaining.

Cell Waterfall report for Multi-Channel Retention Campaign flowchart
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Segment Crosstab reports
Segment crosstab reports are accessed from the Analysis section of Campaign, and
consist of the following individual reports:
v “Segment Crosstab Analysis”
v “Segment Profile Analysis”

Segment Crosstab Analysis
The Segment Crosstab Analysis report calculates detailed information about any
two dimensions in a cube, as defined in a Cube process, and displays the results in
tabular format. This report allows you to drill into cells and create a Select process
that can then be used in a campaign or session flowchart.

Only strategic segments or cells that are part of a cube are available to be analyzed
in the Segment Crosstab Analysis report.

Segment Profile Analysis
The Segment Profile Analysis report calculates and displays the count for a
strategic segment’s dimensions. The information is displayed in both tabular and
graphical views. Only strategic segments that are part of a cube are available to be
analyzed in the Segment Profile Analysis report.

Calendar of Campaigns
The Calendar of Campaigns report allows you to view the campaign start and end
dates on a calendar.

Campaign and offer listings reports
Campaign and offer listings reports are available only with the installation of IBM
Unica reporting and the Campaign reports pack. For information on installing and
configuring IBM Unica reporting, see the installation guide and the IBM Unica
Campaign Administrator's Guide.
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Campaign and offer listings reports are accessed from the Analysis section of
Campaign, and consist of the following individual reports:
v “Campaign Summary”
v “Offer Campaign Listings”

Campaign Summary
The Campaign Summary report provides an overview of all campaigns that have
been created. It lists the campaign code, creation date, start and end dates, last run
date, initiative and objective of each campaign.

Offer Campaign Listings
The Offer Campaign Listings report lists campaigns grouped by offers. It lists the
campaign code, initiative, start and end dates and last run date.

Performance reports
Performance reports are available only with the installation of IBM Unica reporting
and the Campaign reports pack. For information on installing and configuring
reporting, see the installation documentation and the IBM Unica Marketing Platform
Administrator's Guide.

For examples of output from performance reports, see the IBM Unica Campaign
Report Specifications document.

Performance reports are accessed from the Analysis section of Campaign, and
consist of the following reports:
v ““What If” Offer Financial Summary”
v “Campaign Detailed Offer Response Breakout” on page 215
v “Campaign Financial Summary by Offer (Actual)” on page 215
v “Campaign Offer Performance by Month” on page 215
v “Campaign Performance Comparison” on page 215
v “Campaign Performance Comparison (with Revenue)” on page 215
v “Campaign Performance Comparison by Initiative” on page 215
v “Campaign Performance Summary by Cell” on page 215
v “Campaign Performance Summary by Cell (with Revenue)” on page 215
v “Campaign Performance Summary by Cell and Initiative” on page 216
v “Campaign Performance Summary by Cell and Offer” on page 216
v “Campaign Performance Summary by Cell and Offer (with Revenue)” on page

216
v “Campaign Performance Summary by Offer” on page 216
v “Campaign Performance Summary by Offer (with Revenue)” on page 216
v “Offer Performance by Day” on page 216
v “Offer Performance Comparison” on page 216
v “Offer Performance Metrics” on page 216
v “Offer Performance Summary by Campaign” on page 217

“What If” Offer Financial Summary
The “What If” Offer Financial Summary report calculates the hypothetical financial
performance of an offer based on your input. You specify parameters for
evaluating different response rate scenarios. The report calculates financial
performance for six scenarios, incrementing upward based on your specified
response rate and the response rate increment. For example, if you specify a
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response rate of 2% and a response rate increment of 0.25%, the report will return
performance data for six scenarios with response rates ranging from 2% to 3.25%.

You can optionally change parameters in the “what-if” report, such as cost per
contact, offer fulfillment fixed cost and revenue per response.

Campaign Detailed Offer Response Breakout
The Campaign Detailed Offer Response Breakout report provides campaign
performance data for different response types. It lists all offers associated with a
campaign and the number of responses for each response type.

Campaign Financial Summary by Offer (Actual)
The Campaign Financial Summary by Offer (Actual) report provides financial data
for offers within campaigns. It includes data such as contact costs, gross revenue,
net profit, and ROI.

Campaign Offer Performance by Month
The Campaign Offer Performance by Month report shows campaign performance
for a specified month with performance data for each offer within the campaign. It
lists the number of offers given, number of response transactions, and response
rate for the specified month.

Campaign Performance Comparison
The Campaign Performance Comparison report compares the financial
performance of campaigns. It includes data such as response transactions and
response rate, number of unique responders and responder rate. It also includes lift
over control group information.

Campaign Performance Comparison (with Revenue)
The Campaign Performance Comparison (with Revenue) report compares the
financial performance of selected campaigns. It includes data such as response
transactions, response rate, number of unique responders, responder rate and
actual revenue. It also includes optional lift over control group information.

Campaign Performance Comparison by Initiative
The Campaign Performance Comparison by Initiative report compares the financial
performance of selected campaigns grouped by their initiatives. It includes data
such as response transactions and response rate, number of unique responders and
responder rate. It also includes optional lift over control group information.

Campaign Performance Summary by Cell
The Campaign Performance Summary by Cell report provides performance data
for campaigns with cells grouped by the corresponding campaigns. It includes data
such as the number of offers given, number of response transactions, response rate,
number of unique responders and responder rate. It also includes lift over control
group information.

Campaign Performance Summary by Cell (with Revenue)
The Campaign Performance Summary by Cell (with Revenue) report provides
performance data for selected campaigns with cells grouped by the corresponding
campaigns. It includes data such as number of offers given, number of response
transactions, response rate, number of unique responders, responder rate and
actual revenue. It also includes optional lift over control group information.

Note: This report requires the additionally tracked field Revenue in the response
history table.
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Campaign Performance Summary by Cell and Initiative
The Campaign Performance Summary by Cell and Initiative report provides
performance data for selected campaigns with cells grouped by the corresponding
campaigns and initiatives. It includes data such as number of offers given, number
of response transactions, response rate, number of unique responders and
responder rate. It also includes optional lift over control group information.

Campaign Performance Summary by Cell and Offer
The Campaign Performance Summary by Cell and Offer report provides a way to
see campaign performance by both offer and cell in the same report. Each
campaign is listed, along with each cell and the associated offer names. For each
combination of cell and offer, the report shows the number of offers given, number
of response transactions, response rate, number of unique recipients and
responders and responder rate. It also includes lift over control group information.

Campaign Performance Summary by Cell and Offer (with
Revenue)
The Campaign Performance Summary by Cell and Offer (with Revenue) report
provides a way to see campaign performance by both offer and cell in the same
report, along with revenue information. Each campaign is listed, along with each
cell and the associated offer names. For each combination of cell and offer, the
report shows the number of offers given, number of response transactions,
response rate, number of unique recipients and responders and responder rate,
plus revenue. It also includes lift over control group information.

Note: This report requires the additionally tracked field Revenue in the response
history table.

Campaign Performance Summary by Offer
The Campaign Performance Summary by Offer report provides a summary of
campaign and offer performance with selected offers grouped by the
corresponding campaigns. It includes data such as number of offers given, number
of response transactions, response rate, number of unique responders, and
responder rate. It also includes lift over control group information.

Campaign Performance Summary by Offer (with Revenue)
The Campaign Performance Summary by Offer (with Revenue) report provides a
summary of offer performance for selected campaigns. It includes data such as
number of offers given, number of response transactions, response rate, number of
unique responders, responder rate and actual revenue. It also includes optional lift
over control group information.

Offer Performance by Day
The Offer Performance by Day report shows offer performance for a specified date
or date range. It lists the number of offers given, number of response transactions,
and the response rate during the specified date or date range.

Offer Performance Comparison
The Offer Performance Comparison report compares the performance of selected
offers. It includes data such as the number of offers given, number of response
transactions, response rate, number of unique responders, and responder rate. It
also includes lift over control group information.

Offer Performance Metrics
The Offer Performance Metrics report compares the performance of selected offers
based on various response attributions, such as Best Match, Fractional Match and
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Multiple Match. It also includes optional lift over control group information and
percentage differences between various attribution rates.

Offer Performance Summary by Campaign
The Offer Performance Summary by Campaign report provides a summary of the
performance of selected offers by campaign. It includes data such as number of
offers given, number of response transactions, response rate, number of unique
responders, and responder rate. It also includes lift over control group information.
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Appendix. Special characters in IBM Unica Campaign object
names

Names of objects in Campaign can have specific requirements. Some special
characters are not supported in any Campaign object names. In addition, some
objects have specific naming restrictions.

Note: If you pass object names to your database (for example, if you use a user
variable that contains a flowchart name), you must ensure that the object name
contains only characters supported by your particular database. Otherwise, you
will receive a database error.

Special characters not supported

Do not use any of the characters listed in the following table in the names of these
objects:
v campaigns
v flowcharts
v folders
v offers
v offer lists
v segments
v sessions

Table 20. Special characters not supported

Character Description

% Percent

* Asterisk

? Question mark

| Pipe (vertical bar)

: Colon

, Comma

< Less than symbol

> Greater than symbol

& Ampersand

\ Backward slash

/ Forward slash

“ Double quotation mark

Objects with no naming restrictions

The following objects in Campaign have no restrictions for characters used in their
names:
v audience levels (audience level field names have naming restrictions)
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v custom attribute display names (custom attribute internal names have naming
restrictions)

v offer templates

Objects with specific naming restrictions

The following objects in Campaign have specific restrictions on their names:
v Custom attribute internal names (custom attribute display names have no naming

restrictions)
v Audience level field names (audience level names have no naming restrictions)
v Cells
v Derived fields
v User table and field names

For these objects, names must:
v Contain only alphabetic or numeric characters, or the underscore (_) character
v Start with an alphabetic character

For non-Latin-based languages, Campaign supports all the characters that are
supported by the string encoding configured.

Note: Derived field names have additional restrictions. For details, see “Naming
restrictions for derived fields” on page 171.
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Contacting IBM Unica technical support

If you encounter a problem that you cannot resolve by consulting the
documentation, your company’s designated support contact can log a call with
IBM Unica technical support. Use the information in this section to ensure that
your problem is resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your IBM
Unica administrator for information.

Information to gather

Before you contact IBM Unica technical support, gather the following information:
v A brief description of the nature of your issue.
v Detailed error messages you see when the issue occurs.
v Detailed steps to reproduce the issue.
v Related log files, session files, configuration files, and data files.
v Information about your product and system environment, which you can obtain

as described in "System information."

System information

When you call IBM Unica technical support, you might be asked to provide
information about your environment.

If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your installed IBM
Unica applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, you can obtain the version number of any IBM Unica application by
viewing the version.txt file located under the installation directory for each
application.

Contact information for IBM Unica technical support

For ways to contact IBM Unica technical support, see the IBM Unica Product
Technical Support website: (http://www.unica.com/about/product-technical-
support.htm).
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information about the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
170 Tracer Lane
Waltham, MA 02451
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
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been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.
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